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0 CE CONFORMANCE STATEMENT 
 
IMAGE Information Systems Ltd. does not accept liability for the illegal or improper use of the described 
software (see the End User License Agreement). 
 
iQ-VIEW is certified as a medical device for image processing, diagnosis, archiving and communication 
according to Council Directive 93/42/EEC concerning medical devices and according to FDA 510(k). 
Nevertheless, diagnosis can only be made using special high-resolution displays. 
 

 

Copyright © 2003-2012 IMAGE Information Systems Ltd. 
All rights reserved. 

 
All patient names used in this manual are completely fictitious. 
 
The contents of this manual are the property of IMAGE Information Systems Ltd. and may not be reproduced 
by any method, electronic or photographic, without the express written permission of the copyright holder. 
 
Throughout this manual trademark names are used. Rather than put in a trademark symbol at every 
occurrence of the trademark name, we state that we are using the names only in an editorial fashion and to 
the benefit of the trademark owner with no intention of infringing upon the trademark. 
 
We assume no responsibility for inaccurate information or descriptions of third-party products.  
 
We are dedicated to improving and enhancing the software of our medical imaging and communication 
system. Consequently, the information in this manual is subject to change without notice. Current information 
about product improvements can be found on the iQ-VIEW homepage: http://www.image-
systems.biz/products/iq-system-pacs/iq-view.html or IMAGE Information Systems homepage www.image-
systems.biz. 
 
Further inquiries can be addressed to: info@image-systems.biz.  
 
Andreas Knopke, MD  Arpad Bischof, MD  Mike Thomas Jensen 
May 2012 
 

http://www.image-systems.biz/products/iq-system-pacs/iq-view.html�
http://www.image-systems.biz/products/iq-system-pacs/iq-view.html�
http://www.image-systems.biz/�
http://www.image-systems.biz/�
mailto:info@image-systems.biz�
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1 INTRODUCTION 
 
iQ-VIEW is a DICOM 3.0 compliant software application for viewing and processing medical image data. With 
the help of this software, data from every DICOM 3.0 compliant modality can be queried, retrieved and 
imported, even from sources like email, CDs and DVDs.  
 
Each type of medical image data can then be viewed and processed with iQ-VIEW. Different studies can be 
compared, measurements can be made and all commonly used image processing functions (windowing, 
zoom/pan, rotation/flipping, color remapping, etc.) are available. Presentation States (PR) are used to display 
the images and the changes made in them. Furthermore, with iQ-VIEW PRO it is possible to store these 
Presentation States and send them via DICOM, e.g. to a PACS system for archiving. Medical findings are 
documented using structured reporting. 
 
The iQ-3D module is used for 3D image processing. The iQ-STITCH module is included in the iQ-VIEW installation 
package for image stitching. Interfaces to further post-processing modules are integrated (iQ-NUC, 
OrthoView™).  
 
Images can be printed on Windows® printers or via DICOM Print, burned onto CDs or DVDs, exported to 
memory sticks and iQ-ROBOT or sent via DICOM or email. They can also be exported to other image formats 
(JPEG, BMP, TIFF) and video files (AVI).  
 
iQ-VIEW works over any type of network and is suitable for use in telemedicine or teleradiology. A flexible 
TWAIN driver makes it possible to connect cameras, scanners and CR readers and to capture images from 
those devices for viewing and storing. Images can also be imported from the iQ-CR ACE scanner.  
 
In addition, iQ-VIEW PRO includes a DICOM Modality Worklist client and a DirectShow® interface (iQ-CAPTURE). 
Using IMAGE DISPLAYS PRO in combination with iQ-GRAFIX makes it possible to view radiological images in true 
12 bit gray-scale mode. 
 
iQ-VIEW is certified as a medical device according to ISO 13485 in countries of the European Union and 
countries with contracts to this system, as well as according to FDA 510(k). It includes service and support by 
an international company and its world-wide reseller and distributor network. 
 
 
1.1 SYSTEM REQUIREMENTS  
 
1.1.1 MINIMUM SYSTEM REQUIREMENTS 
 
Minimum system requirements are: 
 
 CPU Intel® Pentium® Dual Core 
 3 GB main memory 
 80 GB hard disk drive (HDD) or solid state drive (SSD) 
 Network connection with 100 Mbit/s 
 Graphics card, resolution of ≥ 1024x768, True Color mode (24 bit) or at least 8 bit gray output, any nVidia or 

ATI graphics card with ≥ 256 MB RAM 
 Analog color or grayscale monitor, ≥ 17” for demonstration, high-resolution monitor for diagnostic purposes 
 Windows XP Professional, 32 bit; Windows 7 Professional, 32 or 64 bit 
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 Adobe Acrobat Reader, min. version 6.0 
 CD/DVD writer for the creation of patient media 
 
 
1.1.2 RECOMMENDED SYSTEM REQUIREMENTS 
 
For iQ-VIEW recommended hardware requirements are: 
 
 CPU Intel® Core™ i5 
 4 GB main memory  
 ≥ 500 GB S-ATA II hard disk drive (HDD) 
 Network connection of at least 100 Mbit/s 
 Graphics card, resolution of 1280x1024 or more, True Color mode (24 bit) or at least 8 bit gray output, any 

nVidia or ATI graphics card with ≥ 1 GB RAM (e.g. iQ-GRAFIX) 
 1x digital color or grayscale display with ≥ 19” for workflow tasks + 1 or 2 IMAGE DISPLAYS BASIC as 

diagnostic displays 
 Windows 7 Professional (or higher editions), 64 bit  
 Adobe Acrobat Reader, version 9.0 
 CD/DVD writer for the creation of patient media 
 Mouse with scroll wheel 
 PostScript printer 
 DELL hardware 
 
For iQ-VIEW PRO recommended hardware requirements are: 
 
 CPU Intel® Core™ i7 
 8 GB main memory  
 ≥ 500 GB S-ATA II hard disk drive (HDD) 
 Network connection of 1 Gbit/s 
 Graphics card, resolution of 1280x1024 or more, True Color mode (24 bit) or at least 8 bit gray output, any 

nVidia or ATI graphics card with ≥ 1 GB RAM and ≥ 256 bit memory bandwidth (e.g. iQ-GRAFIX PRO) 
 1x digital color display ≥ 19” for workflow tasks + 2x IMAGE DISPLAYS PRO or PREMIUM as diagnostic displays 
 Windows 7 Professional (or higher editions), 64 bit 
 Adobe Acrobat Reader, version 9.0 
 CD/DVD writer for the creation of patient media 
 Mouse with scroll wheel 
 PostScript printer 
 DELL hardware 
 
 
1.1.3 SPECIFIC SYSTEM REQUIREMENTS FOR UNICODE LANGUAGES 
 
Specific system requirements for use with Unicode languages (Japanese, Russian, etc.) include: 
 
 For a correct display of patient and study information in the study list and in text overlays as well as for 

using native language characters in “Modify” (information on DICOM level), the original DICOM data has 
to be correctly encoded with the appropriate DICOM character set (e.g. for Japanese DICOM sets 
encoding in the DICOM character sets ISO 2022 IR 13, ISO 2022 IR 87 and/or ISO 2022 IR 159). 
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NOTE:  
For a complete list of all specific character sets generally supported by iQ-VIEW (i.e. DICOM objects already 

encoded with a specific character set), please consult the iQ-VIEW DICOM Conformance Statement. 
Nevertheless, the adherence to the above-mentioned system requirements still remains. 

 
The user should be a local administrator on the computer to guarantee that iQ-VIEW can be used to its fullest 
extent and no missing rights (writing, reading, etc.) are impeding its use (e. g. for CD/DVD burning).  
 
Furthermore, we recommend the use of up-to-date anti-virus software on the computer where iQ-VIEW is run. 
The virus definitions must be updated regularly (they should not be older than two weeks). 
 

NOTE:  
Due to known issues / incompatibilities (e.g. regarding the blocking of system files and ports), we do not 

recommend using AntiVir as an anti-virus software. 

 
To keep the power supply voltage constant, we recommend the use of an uninterruptible power supply (UPS). 
The use of such a device prevents data loss and data inconsistencies that can be produced from fluctuations 
in the power supply voltage. 
 
To avoid incompatibility problems, we recommend installing iQ-VIEW as the only DICOM viewing software on 
the system. The simultaneous operation of other viewing software on the same system may lead to disruptions 
in operation or malfunctions in either software. 
 

WARNING 1: 
Due to a fair number of internal and external dependencies, the support of DICOM encapsulated PDF (as an 

SOP class) is still limited in this software version. The manufacturer cannot guarantee the full functioning of 
DICOM encapsulated PDF objects throughout the application and, therefore, does not assume liability for any 

incorrect behavior. 

 

WARNING 2: 
Please note that iQ-VIEW is a 32 bit application. It can therefore not allocate more than 2 GB RAM to process 
DICOM images. This may lead to limitations in processing huge multi-frame objects. The following effects are 

possible:  
– It might become impossible to decompress images received via DICOM or imported via “Filesystem”. This will 

result in failures to store these images in the local imagebox. 
– Uncompressed or successfully decompressed images will be stored in the local imagebox but the viewer 

may no longer be able to handle this data. This will result in a corrupted image display and issues while trying 
to process this data (e.g. browsing through the series, zooming, windowing, etc.). 

 
To keep the effects on iQ-VIEW and on the opportunity to read these objects as low as possible, we 

recommend the following actions: 
– If you set up an iQ-VIEW workstation in an environment where such huge multi-frame data volumes are 

possible, please use a 64 bit Windows 7 operating system and more than 4 GB RAM. 
– Be sure to limit the number of other processes and applications running at the same time as iQ-VIEW, so that 

the full 2 GB RAM can really be allocated to the processing of these objects. 
– Be careful to use image compression. Best use uncompressed data to avoid memory overrun during an 

image decompression process. 



 

 

 

 iQ-VIEW 2 8 0 User Manual INT EN – 002R 11 

– If a study contains several such huge multi-frame objects in different series, you may load them individually 
(one after the other) into the viewer. This will keep the required RAM at a limit. 
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2 INSTALLATION AND LICENSING 
 
For detailed information regarding the installation, licensing and activation of the software please refer to the 
iQ-VIEW Administration Guide. The guide is part of the installation package and can be accessed by: 
 
 Clicking [Start]  [All Programs]  [iQ-VIEW]  [Administration]  “Administration Guide” 
 Opening Windows Explorer, selecting the iQ-VIEW installation folder (by default: C:\Program Files\iQ-

VIEW\) and opening “Administration Guide.pdf” 
 
Please note that Adobe Acrobat Reader or another PDF reader must be installed on the system. 
 

WARNING: 
No special training is necessary to be able to install iQ-VIEW, although general computer literacy is required. 

The configuration settings, however, should be made by a system administrator with technical know-how and 
experience concerning in-house procedures and processes for the organization. 
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3 CONFIGURATION 
 
For instructions concerning the configuration and set-up of the application as well as hints regarding trouble-
shooting problems, please refer to the iQ-VIEW Administration Guide. The guide is part of the installation 
package and can be accessed by: 
 
 Clicking [Start]  [All Programs]  [iQ-VIEW]  [Administration]  “Administration Guide” 
 Opening Windows Explorer, selecting the iQ-VIEW installation folder (by default: C:\Program Files\iQ-

VIEW\) and opening “Administration Guide.pdf” 
 
Please note that Adobe Acrobat Reader or another PDF reader must be installed on the system. 
 
The Administration Guide covers the following topics, among others: 
 
 Initial configuration  
 Configuration of the Server Admin Tool (concerning the iQ-VIEW DICOM server) 
 Configuration of local iQ-VIEW settings 
 DICOM configuration – setting up connections to remote archives, DICOM printers/imagers and DICOM 

Modality Worklists  
 Changing the directory of iQ-VIEW’s local imagebox and database file 
 Display configuration – setting up iQ-VIEW to work across several displays 
 Controlling iQ-VIEW from a HIS/RIS 
 TWAIN configuration 
 Windows and DICOM print configuration 
 Setting up and changing the overlay font size and text and button scaling 
 Changing and amending overlay information of images 
 Customizing the Study Browser 
 Process and log information 
 Automatic routing with iQ-VIEW 
 Configuration of the internal iQ-VIEW DICOM email client 
 Creation of patient CDs according to the DRG CD certificate 
 Connecting other modules to iQ-VIEW 
 Description of all possible iQ-VIEW configuration parameters 
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4 USE OF THE SOFTWARE APPLICATION 
 
4.1 STUDY BROWSER  
 

 
iQ-VIEW main application (Study Browser) 

 
 
4.1.1 CONFIGURATION SETTINGS  
 

 

Opens the iQ-VIEW user manual for consultation.  
 

 

NOTE:  
Acrobat Reader or another PDF reader must be installed on the system to open and view the iQ-VIEW user 

manual, which is available as a PDF file directly in the iQ-VIEW installation folder (manual.pdf). 

 

 

Gives information about the iQ-VIEW software version installed as well as contact information for 
questions or bug reports. Clicking the window opens a support email form for contacting the 
reseller for bug reports, technical advice, etc.   
 
Right-clicking the “Info” button shows the current certificate as well as the number of days the 
software will run using this certificate. 
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NOTE:  
Please note that a standard email client (Outlook, Outlook Express, etc.) must be installed and configured to 

automatically open an email form. 

 

 

Opens the “Local settings” window to: 
 
 View and change the local DICOM settings of iQ-VIEW 
 Access the server administration (Server Admin Tool) 
 Check and reset the current license, if necessary 
 Access the database regeneration tool 

 

 

Opens the “DICOM settings”  dialog for the configuration of remote DICOM archives, DICOM print 
nodes and the DICOM Modality Worklist parameters. 

 

NOTE:  
For detailed information about the “Local settings”, the configurations of “DICOM settings” as well as the iQ-
VIEW server administration please refer to the respective chapters of the iQ-VIEW Administration Guide. This 

document is available as a PDF file in: [Start]  [All Programs]  [iQ-VIEW]  [Administration]  
“Administration Guide” and needs the Acrobat Reader or another PDF reader to be viewed.  

 
 
4.1.2 SERVER AND HARD DISC STATUS  
 

 

 

In the bottom right corner of the Study Browser, the iQ-VIEW “Server Status” is shown with either a 
blue light (= server is running) or a red light (= server is stopped). This allows the user to check the 
server status without opening the Server Admin Tool. Double-clicking the status display opens the 
Server Admin Tool so the server can be started, stopped or configured. For more details, please 
consult the iQ-VIEW Administration Guide. 

 

 

 

 

The “Disc Status” gives graphical information about the available hard disk space of the hard 
drive where the iQ-VIEW imagebox (i.e. the DICOM images) is stored. As more hard disk space is 
occupied, the number of colored boxes will increase and the color will change from green to 
yellow to red. 

 

NOTE:  
Displaying the hard disk status also works for network paths, for example, if the imagebox (image folders) of iQ-

VIEW was moved to a network drive. 

 
 
4.1.3 STUDY TABLE  
 
When opening iQ-VIEW for the first time, only the Study Table will be opened. The other panels “Patient List” 
and “Preview Icons” are closed and may be opened if desired. See below for further information on the use of 
the “Patient List” and “Preview Icons” panel. When restarted, iQ-VIEW will always remember the previous 
settings and display any tables that were open when the application was last shut down. 
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NOTE: 
 The local database of iQ-VIEW is currently limited to 10,000 studies. As a result, the study browser will only 

display a maximum of 10,000 studies. However, storing too many studies locally is not recommended as this 
may limit the application’s performance. Please use a central PACS to archive study data and to distribute the 

studies as necessary across the medical network. 

 
 
4.1.3.1 STUDY TABLE COLORS 
 

 When the first column of the study table is shaded light-blue, it is in a local mode – studies showing 
are stored in the local “Database” or in the “Filesystem” (import from local directory). 

 

 When the first column of the study table is shaded light-orange, it is in “Network” mode where 
studies can be queried and retrieved from a connected remote archive. 

 
 
4.1.3.2 NAVIGATING THE STUDY TABLE 
 
The study table gives information about a study on three levels: 
 
 Study level = gives the most important information provided at the study level, such as patient name, 

patient ID, accession number, study description, referring physician, etc. 
 Series level = provides information about the available series in a study, e.g. series description, modality 

information, etc. 
 Image level = allows access to a preview of each image in a series, including the possibility to use window 

leveling, but also gives information about the number of frames in case of multi-frame images (e.g. US). 
 
To see the next level underneath a study, click the “+” box on the far left side. This will open the study to show 
the various series, including any relevant information. By clicking on the “+” to the left of a series, the image 
level will open, revealing a table of all available images in that series.  
 

 
Clicking the arrow button beside an image will open the chosen image in a preview window. 
Center/window changes are possible using either the left or center mouse button. 

 
 
4.1.3.3 SORTING STUDIES IN THE STUDY TABLE 
 
By clicking the respective entry in the table header, the available studies can be sorted by patient name, 
modality, patient ID, study date, etc. – in both ascending and descending order. The sorting direction is noted 
in the column heading by an up or down arrow and is reversed when the heading is clicked another time. 
 

 

Right-click the table header in the study table and select “Reset sort settings” from the 
sub-menu to reset any sorting and return to the original sort order. Studies are shown in 
the order of the day in which they are received by iQ-VIEW (by date only, not specific 
time). 
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4.1.3.4 SELECTING STUDIES AND SERIES 
 
The selection of studies in the study table follows the usual Windows® logic of using [CTRL] and [SHIFT] for 
selecting. Making selections at the series level requires alternative methods: 
 
 Select an individual study either by clicking anywhere in the study entry or by clicking the checkbox in the 

first column.  
 Multiple studies can be selected together by either using [CTRL] to mark the studies separately or using 

[SHIFT] to mark all studies between the first item selected and the last one. Alternatively, the checkboxes of 
the desired studies can be selected in the first column. 

 Select an individual series by clicking the “+” next to the study in which the series belongs and mark the 
checkbox in front of the desired series entry.  

 To select multiple series of one study, simply mark the checkboxes of all required series after displaying 
them by clicking the “+” next to the appropriate study containing the series. 

 Using the same method, individual series from different studies can be selected. 
 

 

Right-click the table header in the study table to open a sub-menu where all studies 
available on the medium can be selected or unselected at once. 

 

NOTE: 
Selected studies and series are marked orange when in “Database” mode or blue when in “Network” mode. 

In addition the checkbox of each study / series in the first column will be checked.  
For best practices, data should be selected either on the study level or the series level only. When mixing study 
and series levels, selecting them by using the checkbox (instead of clicking the line) will be helpful to insure the 

entire selection can be loaded into the viewer or exported to a medium or email. 

 
 
4.1.3.5 LOADING STUDIES AND SERIES INTO THE VIEWER 
 
If only one study or one series is selected from the study list (either “Network”, “Database” or “Filesystem” 
table), one of the following options can be used: 
 
 Double-click the study / series to load it into the viewer 
 Select the study / series and then click the “View” button 
 

 

If more than one study or series (or combination of studies and series) is selected, click the “View” 
button to load the entire selection into the viewer. Double-clicking a selection will only load the 
study/series under the mouse pointer. 

 
Optionally, another entry may show up in the right-click pop-up menu: 
 

 

 

“Open selection in secondary viewer”: This menu entry is only 
available in case iQ-MAMMO is installed on the system and 
was connected to iQ-VIEW. Please also see section 4.1.8 View 
and in the Administration Guide.  
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Also, this entry is only available in the study list under the “Database” tab. This means, only locally stored 
studies can be loaded into the secondary viewer. Studies retrieved from a remote archive will always be 
loaded into the iQ-VIEW viewer. 
 
Depending on whether the iQ-VIEW viewer or the iQ-MAMMO viewer was configured as primary viewer, the 
secondary viewer shows the icon of either iQ-VIEW or iQ-MAMMO. Selected studies will be loaded into the 
respective viewer when clicking the menu entry. 
 
 
4.1.3.6 CHANGING THE STATUS OF LOCALLY AVAILABLE STUDIES 
 
The status of the studies available in the local iQ-VIEW imagebox can be changed by using the options found 
when the study is right-clicked:  
 

 
 

 

Locally available studies can be marked as read to show that the study has been processed. 
When marked, the status icon in the study table changes accordingly.  

 

NOTE: 
Studies can also be marked as read directly in the viewer. A “Mark study as read” button is available for the 

configurable bottom toolbar. If activated, the status of the currently displayed study is changed and a yellow 
frame is shown around the button. The status is also updated in the study browser. To unmark the study, click 

the button a second time. Also refer to section 4.2.17 Marking studies as read. 

 

 

If a local study was marked as read, it can be unmarked by selecting “Mark as unread” in the sub-
menu. The status icon in the study table will be removed to indicate the reset status. 

 

 

To protect studies from automatically being deleted according to the rules defined in an 
activated “Overflow Management” (see iQ-VIEW Administration Guide), they can be locked by 
choosing “Lock selected studies”. The status icon in the study table will change accordingly. 
However, this procedure will not

 

 protect a study from being deleted if “Clear local imagebox” is 
selected in the “Local settings” dialog or the study is deleted manually.  

 

The locked status of a study can be removed by clicking “Unlock selected studies”. The status icon 
in the study table will disappear to indicate the reset status. 
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NOTE: 
Status indicators will be deleted if the iQ-VIEW database is regenerated. In addition, status information is only 

available locally at the station and cannot be shared across the network, e.g. with other iQ-VIEW stations. 

 
 
4.1.3.7 DELETING DATA FROM THE LOCAL IMAGEBOX 
 
If an individual study, several studies, a series or several series need to be deleted from the study table, start by 
selecting the data as described in section 4.1.3.4. Selecting studies and series. 
 

 

After selecting the studies / series, right-click the study table and select “Delete selection from 
local imagebox” in the sub-menu to delete the selected data. 

 
To delete an individual image, right-click the image’s entry in the study list and select “Delete selection from 
local imagebox” from the sub-menu.  
 

 
 
A security question will appear to confirm the deletion process. 
 

NOTE: 
Deletion will clear the registered entries from the iQ-VIEW database file and the images from the imagebox. 

The images will be deleted completely and will not be moved into the trash can to be recovered later. 
Therefore, only affirm the security question if the deletion is truly desired. 

 
Click the “Local settings” button and select “Delete local imagebox” to clear the entire study list and delete 
all images currently available in the local imagebox. This action will delete the entire content of the imagebox 
including the images and the entries in the database file. A security question requires the user to confirm this 
action. For further information, please consult the iQ-VIEW Administration Guide. 
 
 
4.1.4 PATIENT LIST 
 
The Patient list displays a list of all patients found locally (when using the “Database” table) or remotely (when 
using the “Network” table). Using the list, all studies of a patient can be located quickly by selecting the 
patient’s name. The table can be opened and closed using the switch in the upper left corner of the panel 

 (horizontal when the list is open and vertical when closed).  
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If the patient list table is open when iQ-VIEW is shut down, it will automatically open when the application is 
restarted. 
 
Like the study table, the patient list can be sorted in ascending and descending order according to the 
available columns: 
 
 
4.1.4.1 SORTING PATIENTS IN THE PATIENT LIST 
 
Like the study table, the patient list can be sorted both ascending and descending according to the available 
columns: 
 
 Patient name 
 Patient ID 
 Date of birth 
 
This makes it easier to find a particular patient. 
 

 

Right-click the table header in the study table and select “Reset sort settings” from 
the sub-menu to reset any sorting and return to the original sort order.  

 
 
4.1.4.2 SEARCHING LOCALLY FOR AVAILABLE STUDIES OF A PATIENT 
 
Clicking a patient in the patient list automatically starts a search for all studies of the patient in the local 
imagebox. The studies can then be selected to be processed. 
 
 
4.1.4.3 SEARCHING REMOTELY FOR AVAILABLE STUDIES OF A PATIENT 
 
Running a query on remote DICOM archives with an open patient list shows the results in the patient list. 
Clicking a patient in the list will display all studies of that patient from the active remote archives (those 
selected), giving the user a fast way to search for previous studies of a patient. These studies can then be 
selected to be processed. 
 
 
4.1.4.4 LOADING STUDIES OF A PATIENT INTO THE VIEWER 
 
By double-clicking a patient in the patient list, all available studies of this patient are loaded into the viewer. 
 

 

Alternatively, right-clicking the table header in the study list opens a sub-menu 
where all studies for the patient can be selected or unselected.  
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Individual selection of studies and / or series is also possible from the study table as described in chapter 4.1.3 
Study table, section 4.1.3.4 Selecting studies and series. 
 
 
4.1.5 PREVIEW ICONS PANEL  
 
The Preview Icons panel can be opened and closed using the switch  in the upper left corner of the 
panel (vertical when the panel is open and horizontal when the panel is closed).  
 
In both the “Database” and the “Filesystem” mode the preview icons panel shows the preview images of the 
currently selected study or series:  
 
 If a study is marked, previews of all series of that study are shown (one thumbnail for each series). 
 On the series level, more than one series can be selected and the images of these series are displayed as 

preview thumbnails. 
 

NOTE: 
In the “Network” mode this option is not available since images are not yet available locally. For that reason 
the preview icons panel will automatically close and cannot be opened when switching to the “Network” 

mode. 

 
 
4.1.6 QUERY PANEL 
 

WARNING:  
When receiving medical image data, it is important to know if compression has been used. If images were 

lossy compressed information will be shown in the text overlay of the image when opened in the viewer. The 
DICOM header data also indicates the form and rate of compression.  

These images may no longer have diagnostic quality! 

 
The “Query” panel has four tabs for querying DICOM images locally or remotely on a connected DICOM 
archive: “Network”, “Database”, “Filesystem”, or “Email”. The opened tab denotes the current selection. In 
addition, the table color indicates if the images are stored locally (blue/gray table) or remotely (orange/gray 
table).  
 

   
 
The “Database” and “Filesystem” modes search for images that are locally available. “Database” mode 
displays studies stored in the local iQ-VIEW imagebox and “Filesystem” mode shows those in a directory or on 
portable media. The results of a scan in the file system (e.g. reading from a CD) are displayed in the 
“Filesystem” table. At that moment, the data is not yet imported into the imagebox. Once the studies or series 
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have been opened in the viewer, they are then stored locally in the imagebox. See section 4.1.8 View for 
more information on opening studies in the viewer. 
 
On the other hand, “Network” mode is used for DICOM communication between the iQ-VIEW server and a 
connected remote archive. Select the remote archive to query by checking the box in front of the name of 
the archive. After querying all selected DICOM nodes, the results are displayed in the study table. From there, 
studies or series can be selected and loaded into the viewer. As with the “Filesystem” mode, only when 
images are loaded into the viewer, they are stored locally in the iQ-VIEW imagebox. 
 
With “Email” mode, emails sent from another iQ-VIEW station that have DICOM images attached can be 
loaded into the current station. When the attachments are retrieved, the image data is displayed in the 
“Filesystem” table. From there, studies or series can be selected and loaded into the viewer. As with the 
“Filesystem” and “Network” modes, once images are loaded into the viewer, they are stored locally in the iQ-
VIEW imagebox. 
 
By default, iQ-VIEW imports DICOM images uncompressed, even if they are compressed when received. This is 
true when importing via a DICOM “Network” where images are queried or retrieved from another station, as 
well as when importing via the “Filesystem” (including “Email” mode). Compressed images will be 
uncompressed before being stored in the local iQ-VIEW database. 
 

WARNING:  
Heavily compressed images can take up a lot of hard disk space in the iQ-VIEW imagebox when 

uncompressed. The hard disk status in the lower part of the Study Browser indicates the available space. 

 

NOTE:  
Compressed images can be imported via the “Filesystem” and via DICOM network (iQ-VIEW DICOM server). 
For details, please consult the iQ-VIEW Administration Guide. Since it cannot be guaranteed that iQ-VIEW will 
be able to display the compressed images, depending on the transfer syntax, it is always recommended that 

the default decompression is used.  

 
 
4.1.6.1 SEARCHING THE LOCAL iQ-VIEW IMAGEBOX 
 
To search for a study in the local database, select the “Database” tab. All available studies will appear 
automatically with the results being displayed in the study table or patient list, if opened.  
 
Search filters can also be used to query the “Database” table. For detailed information, see section 4.1.7 
Search filter. 
 
 
4.1.6.2 QUERYING AND IMPORTING FROM PACS OR OTHER DICOM ARCHIVES 
 
To query for studies from a PACS server or any other DICOM archive, open the “Network” tab, select the 
archive’s alias (logical name) from the list in the query panel (multi-select is possible) and click the “Search” 
button to start a search on the selected archive(s). 
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WARNING: 
A query without set search filters can take a while, depending on the volume of data stored on the searched 

archive. Therefore, it is recommended that search filters be used to narrow down the search. 

 
The results of the query will be displayed in the study table or, if opened, the patient list. At this point, no 
images have been imported into iQ-VIEW’s imagebox. The actual import process will begin when a study is 
selected and loaded into the viewer. If the application is set to only retrieve images but not show them, the 
“View” button will turn into a “Retrieve” button and the selected studies will be retrieved without displaying 
them in the viewer. 
 

NOTE:  
iQ-VIEW will send a C-MOVE request to the queried server. Make sure that the queried archive “knows” iQ-

VIEW’s network properties (AE Title, Host/IP and Port). For detailed information on how to configure the 
connection to a remote DICOM node, please consult the iQ-VIEW Administration Guide. 

 
Retrieving images from a remote archive:  
 
 When a study from a remote archive is selected for loading, iQ-VIEW will check to see if the study is 

already available in the local imagebox. If it is, the study will be loaded directly from the local imagebox. 
As a result, the images will load faster than from a remote archive. 

 If only one series of a study is selected for loading, iQ-VIEW will load it from the remote archive and will not 
check for local availability. 

 If all series of a study are selected, iQ-VIEW will check locally for availability as if the entire study is selected. 
 

NOTE:  
iQ-VIEW will not be able to determine if a local study contains all series that the same study on the remote 

archive contains. If a new series or more DICOM objects are added to the remote archive AFTER the study is 
loaded into the local imagebox, iQ-VIEW will load the study that does not include the newly added series / 

objects from the local imagebox. To load the updated study, delete the local study by selecting it, right-
clicking the study table and selecting “Delete selection in local imagebox.” The study can then be imported 

from the remote archive. 
To always reload studies from the remote archive, even if they are available locally, a specific parameter 

needs to be set in the iQ-VIEW configuration. Please consult the iQ-VIEW Administration Guide for instructions.  

 
 
4.1.6.3 IMPORT FROM REMOVABLE MEDIA OR HARD DISC DIRECTORIES 
 
To import DICOM images into the local imagebox from a hard disc, another computer in a network, (patient) 
CD/DVD or memory stick, select the “Filesystem” tab in the query panel. 
 
On the left side of the study browser, a Windows® Explorer window will be opened where the folder of the 
DICOM files to import can be selected. Use the “+” markers or double-click a folder to navigate the folder 
structure. 
 
There are two ways to access the available functions: 
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Select the desired folder in the tree structure, then use the buttons in the upper part of the tree-view panel: 
 

 
Click the “Refresh folder” button to refresh the content of the currently selected folder including all 
subfolders. 

 

 
Click the “Scan folder” button to start scanning the selected folder. 

 
Right-clicking a folder not only selects the folder, but also opens a menu with the available options: 
 
 “Refresh folder”: Refreshes the contents of the currently selected folder including all subfolders.  
 “Scan folder”: Starts scanning the selected folder and its subfolders. 
 

NOTE: 
By default, subfolders in the selected folder are included in the scanning. 

 
After selecting “Scan folder”, the application will scan the selected folder and all subfolders for valid DICOM 
files while sorting them into series and studies. It will display any studies found in the “Filesystem” study table.  
 
At this point, no images have been imported into iQ-VIEW’s imagebox. The actual import process will begin 
when a study is selected and loaded into the viewer. If the application is set to only retrieve images but not 
show them, the “View” button will turn into a “Retrieve” button and the selected studies will be retrieved 
without displaying them in the viewer. 
 
If the study is not DICOM compliant, it will be marked red in the resulting study list and a warning will be shown 
when trying to import these studies. Some DICOM files fail the DICOM compliance test but could, nevertheless, 
be shown and transferred. The recommendation is to import only files that are fully compliant with the DICOM 
3.0 standard, in case they may be sent to an archive later.  
 

NOTE:  
The filter options (see below) do not work for a file search! As a result, filters will automatically be cleared when 

switching to “Filesystem” mode. 

 
 
4.1.6.4 IMPORT FROM DICOM EMAIL 
 
With iQ-VIEW, DICOM images can be imported that were sent in a DICOM email from another iQ-VIEW station. 
Emails can be retrieved and DICOM email attachments imported using the email import function integrated 
into iQ-VIEW (“Email” tab). 
 
At first, the studies/series contained in the email attachments will be listed in the “Filesystem” table. At this 
point, no images have been imported into iQ-VIEW’s imagebox. The actual import process will begin when a 
study is selected and loaded into the viewer. If the application is set to only retrieve images but not show 
them, the “View” button will turn into a “Retrieve” button and the selected studies will be retrieved without 
displaying them in the viewer.  
 
 The standard way to import images from emails is to use an “Email” query. An email account must be set 

up first as described in the iQ-VIEW Administration Guide. Afterwards, the emails can be retrieved. Multi-
part emails will automatically be rejoined by iQ-VIEW. 
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For encrypted emails a password will be requested. If an incorrect password is supplied, a warning 
message will display noting that the decryption process has failed. iQ-VIEW will close the “Email” tab and 
return to the “Filesystem”.  

 
 In the case of single-part emails, a standard email client can be used to open any emails received. Save 

the attached DICOM data from the emails into a local directory. Afterwards, these files can be imported 
into iQ-VIEW’s local imagebox via “Filesystem”.  

 

NOTE: 
If a study was sent in multi-part emails due to limitations of the attachment size, it is only possible to extract and 
merge the image archives belonging together using iQ-VIEW. It is not possible to store them in a local directory 

and put them together by importing the individual packages via the “Filesystem”.   

 
For encrypted emails, a password will also be required when importing the images from a directory using 
“Filesystem”. If an incorrect password is supplied, the decryption process will lead to unreadable files. To 
retry the decryption of these files, they must be deleted first and the images copied from the email 
attachments into the directory again. 

 

NOTE: 
If emails are received that were not sent by iQ-VIEW but by another application, the attachments may be 

saved locally on the computer and the data imported via “Filesystem”. 

 

WARNING:  
If lossy compressed images are sent from one iQ-VIEW to another, an appropriate marker will be added to the 

DICOM header of each image and the text overlay in the receiving iQ-VIEW will indicate the lossy 
compression. If DICOM emails are received with lossy compressed images from other stations, there is no 

guarantee that the source station will provide information about the lossy compression. If this information is 
missing, it will be difficult to identify these images as lossy at a later date since the receiving iQ-VIEW station 
can only read the existing DICOM header information. Be aware that a lossy transmission may influence the 

image quality and that the images may no longer be usable for diagnostic purposes! 

 
To be able to receive and load DICOM emails with image attachments, an email account must first be 
configured to store the emails. For detailed information on how to set up an email account within iQ-VIEW, 
please consult the iQ-VIEW Administration Guide.  
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To query and import iQ-VIEW DICOM emails, open the “Email”  tab in the query panel: 
 

 
Email query dialog 

 

 

Connect to the POP3 incoming mail server and retrieve the email header from the configured 
account. 

 

NOTE:  
Emails will not be stored within iQ-VIEW after the “Email” dialog is closed. However, emails will remain on the 

mail server and can be retrieved again later unless they are deleted from the mail server. 
DICOM attachments can use a large amount of storage capacity. Make sure that the mailing server has 

enough storage capacity or clean out the account regularly. 

 
Double-click the email headers provided in the message table to load the email from the mail server and 
open it in the lower part of the dialog. 
 

NOTE: 
If a DICOM email was sent as multi-part messages (e.g. to divide a larger study into several packages), when 

one email is selected in the list, iQ-VIEW will automatically select all other emails belonging to the same DICOM 
email. They will all be loaded together in order to unite them again into one package. 

 
Any message text sent with the email is displayed in the message window.  
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The attachments are shown on the right and can be loaded directly into the “Filesystem” by 
clicking the import button. 

 
 
1. Other email function buttons 
 

 

“Disconnect from server without purging”: Disconnects the application from the mail server but 
leaves the message headers in the window. 

 

 

“Retrieve current message”: Retrieves the selected email and opens it in the lower part of the 
window. Double-clicking the message will also retrieve it. 

 

 

“Mark current message for deletion”: Marks an email for deletion. 

 

 

“Setup POP3 / SMTP”: Opens the configuration dialog to set up the POP3 incoming mail server and 
SMTP outgoing mail server settings of the email account. 

 
 
2. Menu bar functions 
 
“Exit”: Closes the “Email” query dialog and returns to the “Filesystem” table. 
 
“Message functions”: 
 
 “Connect/get headers”: Connects to the mail server and downloads the message headers 
 “Retrieve current message”: Retrieves the selected email and opens it in the lower part. Double-clicking 

the message will also retrieve it. 
 “Mark for deletion”: Marks an email for deletion  
 “Select all for deletion”: Selects all emails for deletion 
 “Purge marked”: Deletes all selected emails from the server 
 “Disconnect from server”: Disconnects the application from the mail server 
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“Setup”: This menu opens the configuration dialog to set up the POP3 incoming mail server and SMTP outgoing 
mail server settings of the email account.  
 
 
4.1.7 SEARCH FILTER 
 
4.1.7.1 USING SEARCH FILTERS 
 
Using the search filters you can narrow down the search for intended studies. This can save a lot of time when 
querying a PACS with a high volume of stored data. 
 
Using search filters will narrow down a search for intended studies. This can save a lot of time when querying a 
PACS with a high volume of stored data. 
 
Several search filters are available and can also be used in combination: 
 
 Time (period) filters 

- “Today” = searches for studies performed today 
- “Yesterday” = searches for studies performed yesterday 
- “From” / “To” = searches for studies within a defined time period 

 Patient information filters 
- “Patient ID” = searches for a patient ID 
- “Patient name” = searches for the name of a patient 
- “Date of birth” = searches for the patient’s date of birth 

 Study information filters 
- “Accession number” = searches for the accession number of a study 
- “Study description” = searches for the study description 
- “Referring physician” = searches for the referring physician’s name 

 Modality filters = filters the requested studies for specific modalities 
 Status filters = filters locally available studies (“Database”) according to their status (e.g. “read”, “locked”)  
 
After inputting criteria for the filters, click “Search” to start the query for matching studies. 
 
 
1. Functionality of the modality filter 
 
When querying a server, iQ-VIEW searches for studies matching the specific modalities selected in the 
“Modality filter.” However, not all servers support querying for this information (because it is defined in DICOM 
as optional). For compatibility reasons, iQ-VIEW will locally filter the entries set up in the “Modality filter” again 
after the query results are retrieved from the server. The study list will, in any case, only be populated with 
results matching the queried modalities. 
 

NOTE: 
The same is true for the query fields “Study description” and “Referring physician”. 

 
The modality filters set in the search filter panel of the study browser are saved when the application is closed. 
Therefore, they are immediately available when the application is started the next time. 
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2. Search fields as drag targets 
 
The search fields also function as drag targets. This means that a study in the study table can be dragged into 
the filter fields to search for other studies containing the same criteria (e.g. “Patient ID”, “Patient name” or 
“Accession no”).  
 
The respective parameter is then added to the search field automatically and does not have to be filled in 
manually. This saves time and avoids typing errors. 
 
 
3. Searching with wildcards 
 
Wildcards can be used when performing a query with search criteria. Various options are available. 
 

NOTE: 
No wildcard searches are available for the time (period), modality and status filters. 

 
For patient IDs and accession numbers: 
 
 When entering a value without a wildcard, only results that exactly match the value will be displayed, e.g. 

“1”  all studies with patient ID = “1”. 
 When entering a value with the wildcard “*” at the end, all results starting with the value will be displayed, 

e.g. “1*”  studies with patient ID = “123”, “123456” or “121212”. 
 When entering a value with the wildcard “*” at the beginning, all results ending with the value will be 

displayed, e.g. “*1”  studies with patient ID = “321”, “654321” or “212341”. 
 When entering a value with wildcards “*”at both the beginning and end, all results containing the value 

will be displayed, e.g. “*1*”  studies with patient ID = “123”, “321”, “23132”, “21313121”. 
 
For text fields (patient name, referring physician, study description): 
 
 When searching for patient names, referring physicians and study descriptions a wildcard is already 

automatically assumed after the entered value, e.g. “New” for patient name  all studies starting with 
“New” in patient name, such as “Newman”, will appear. 

 When searching for names (patient name or referring physician), wildcards always refer only to a segment 
and not to the complete name, e.g.: 
- A search for all patients with first name “John”  filter = “*,John” or “*^John” 
- A search for all patients with first and last names starting with “J”  filter = “J*,J*” or “J*^J*” 

 Other search options include: 
- “newman,s” or “newman,s*”  finds all studies with last name “Newman” and first name starting with 

“S” 
- “n,sandra” or “n*,sandra”  finds all studies with first name “Sandra” and last name starting with “N” 
- “n,s” or “n*,s*”  finds all studies where the last name starts with “N” and the first name starts with “s” 
- “*n,*s”  finds all studies where the last name ends with “N” and the first name ends with “S” 
- “*n*,*s*”  finds all studies where there is an “N” somewhere in the last name and an “S” is somewhere 

in the first name 
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NOTE: 
It is also possible to use “?” as a wildcard instead of “*”. It must, however, be supported by the queried 

archive. 

 
 
4. Clearing search filters 
 
To clear individual search filters but leave others, the search value must be deleted from the respective field or 
the filter deactivated (in case of “From” / “To”, “Date of birth”, “Modality”). 
 
To delete all search filters made in the search panel, click the “Clear entries” button. All search filters will then 
be removed. 
 
 
4.1.7.2 SEARCHING FOR STUDIES FROM DIFFERENT PATIENTS 
 
A search for studies of more than one patient can be performed without losing the previous search results. This 
function is available for searching in the local iQ-VIEW imagebox as well as for queries to a remote archive. 
 
To search for two or more patients: 
 
 Enter the search criteria for the first patient into the “Search panel” and click the “Search” button to 

display the results. 
 Next, enter the search criteria for the next patient. Make sure to clear all filters entered for the first patient 

that do not apply to the second. 
 Hold the [CTRL] key down while clicking on the “Search” button. The available studies for the second 

patient will be added to those of the first. 
 Use the same method to continue searching for even more patients. 
 
 
4.1.8 VIEW 
 

 

To load a single study or series into the viewer, select the study / series and click the “View” button 
or double-click the study / series. To load multiple studies or series into the viewer, select them in 
the study list and click the “View” button. For more information on how to select studies, see 
section 4.1.3.4 Selecting studies and series. 

 
For detailed information on how to use the viewer application as well as a description of all available features 
and processing functions, see chapter 4.2 Viewer. 
 
Under certain circumstances, the default “View” button accessing the iQ-VIEW viewer may be replaced by 
another button. This will happen in the following instances: 
 

 

“Retrieve”: If the option “Just retrieve images (don’t show)” was activated in the “Local settings”, 
the “Retrieve” button will be displayed when switching to the “Network” tab. Retrieved images will 
not directly be loaded into the viewer but will only be stored in the local imagebox. They are 
made available under the “Database” tab. 
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“Load in”: If the option “Just retrieve images (don’t show)” was activated in the “Local settings”, 
the “Load in” button will be displayed when switching to the “Filesystem” tab. Imported images will 
not directly be loaded into the viewer but will only be stored in the local imagebox. They are 
made available under the “Database” tab. 

 

 

“View”: If the iQ-MAMMO module was installed on the system and connected to iQ-VIEW, then this 
button will be displayed in case the mammography viewer was also configured to be the default 
(primary) viewer. This button is only available on the “Database” tab. Locally available studies will 
be loaded into the iQ-MAMMO viewer on clicking the button. See the Administration Guide for 
further information. 

 
 
4.1.9 MODIFY 
 
The “Modify” function can be used if data with incorrect demographic information is received or to adapt 
foreign patient data to the local patient registration (HIS/RIS). 
 

 

This function is only available for studies / series loaded into the local imagebox. Selecting a study 
or a series in the table and clicking the “Modify” button brings up the “Modify DICOM header 
data” dialog where DICOM tags for this study / series can be modified. The respective data will 
then be edited in all images of that study / series. 

 

NOTE: 
It is only possible to select ONE study or ONE series for DICOM header modification. 

 

 
With the “Anonymize” button, the main identifying patient information can be anonymized 
automatically. An anonymization will affect DICOM attributes in the following way: 

 
 The patient name and the patient ID will receive an anonymized but unique identifier. 
 The patient’s date of birth and the study date will be changed to January 1, but the correct year will be 

kept for diagnostic reference. 
 The accession number will be modified in the same way as the patient ID with a unique identifier. 
 The referring physician’s name will be anonymized in the same way as the patient name. 
 
Information such as the patient’s sex, the study description and the study instance UID are maintained. 
 

NOTE: 
The anonymization function is only available on the study level. As a result, it is grayed-out when a series is 

selected for DICOM header modification. 
Also note that iQ-VIEW will only anonymize the information listed above. Any other values written into the 

DICOM header of the images will remain untouched. 
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4.1.9.1 MODIFYING HEADER DATA ON THE STUDY LEVEL 
 

 
Modify header data on the study level 

 
The value of each displayed DICOM tag can be changed. Some of the tags can be left empty if their values 
are unknown (e.g. date of birth), while others are mandatory and must be filled (e.g. patient ID, study instance 
UID). 
 
It is always recommended that a patient name is used to insure proper recognition of the study when 
searching with filters and to avoid conflicts when sending the study to other DICOM stations, e.g. PACS. For this 
reason, when nothing is entered, iQ-VIEW will automatically apply an anonymized patient name and/or 
patient ID into the appropriate DICOM tag field. 
 

WARNING:  
A unique patient ID must always be used for each patient. While one patient may have more than one 

patient ID, one specific patient ID should never be applied to more than one patient. Otherwise, data from 
several patients may be merged. Duplicate use of the same patient ID may cause data to be stored in the 

wrong patient folders in other systems. 
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4.1.9.2 MODIFYING HEADER DATA ON THE SERIES LEVEL 
 

 
Modify header data on the series level 

 
The value of each displayed DICOM tag can be changed. Some of the tags can be left empty if their values 
are unknown, while others are mandatory and must be filled (e.g. series instance UID). 
 
Entering series descriptions can help making orientation within a study easier (especially with many series) and 
allows the set up and use of specific Hanging Protocols. 
 
 
4.1.9.3 MODIFYING HEADER DATA WITH THE HELP OF DICOM MODALITY WORKLIST 
 
This feature is only available in the iQ-VIEW PRO version where the DICOM Modality Worklist client is integrated. 
 

 
Selecting the DICOM Modality Worklist button will open the worklist dialog form. This function is 
only available on the study level as the worklist provides information on that level only. After 
querying for the correct patient (using search filters, if necessary), select the patient and click 
“Accept” to transfer the data into the “Modify” window. 

 
For information on how to use the DICOM Modality Worklist, please refer to chapter 4.4 DICOM Modality 
Worklist. Detailed instructions for the configuration of the DICOM Modality Worklist can be found in the iQ-VIEW 
Administration Guide. 
 
 
4.1.10 TRANSFER 
 

 

In order to send images from the local imagebox (blue/gray table) to a connected DICOM 
archive, select the study, studies or series to send and click the “Transfer” button. A sub-menu 
where all available target stations are listed will pop up. Select the correct station and the transfer 
starts immediately. 
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In “Network” mode, a study can be “moved” from one remote archive to another DICOM node without 
having to import the study into the local iQ-VIEW imagebox first. Just query for the study / studies on the source 
station, select it / them and click the “Transfer” button. Select the target station in the pop-up menu to start 
the sending process. 
 

NOTE:  
iQ-VIEW will send a C-MOVE request to the queried server. To be certain there is a functioning communication 
between the source and the target station, make sure that the queried archive “knows” the C-MOVE target’s 
network properties (AET, Host/IP and Port). Most commercial C-MOVE targets also need a proper DICOM node 

configuration with the queried server as a communication partner. 

 
After they are imported into the “Import” dialog, DICOM images created out of JPEG, BMP, TIFF and RAW 
images as well as DICOM objects created out of PDF files (PRO version only!) can be transferred directly to a 
connected archive. For details, see chapter 4.1.12 Import, section 4.1.12.3. Creation of DICOM studies.  
 
DICOM objects, such as Structured Reports (SR), Secondary Capture images (OT) or Presentation States (PR), 
can be sent directly from the viewer to a connected archive. For more information on how to send DICOM 
objects from the viewer, please refer to the appropriate sections in the chapter 4.2 Viewer.  
 
 
4.1.11 EXPORT 
 
4.1.11.1 SENDING IMAGES BY DICOM EMAIL 
 

 

To send images via DICOM email, select the intended study, studies or series, left-click the “Export” 
button and then select “Send by email”. 

 

 
 

NOTE:  
Before sending images via DICOM email, the appropriate settings must be configured. Configure a 

POP3/SMTP email account for the internal iQ-VIEW email client or use the standard Windows® email client. If 
necessary, set the security and compression settings and create an email address book. For detailed 

information on how to configure an email account and choose the appropriate settings, consult the iQ-VIEW 
Administration Guide. 
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The email send form opens:  
 

 
Send email dialog 

 
Enter all necessary information before sending the email:  
 
 “To”: Enter the recipient’s email address manually, select an email address already stored in the address 

book from the drop-down menu or click “Select” to add or change email addresses. 
 “Subject”: Enter the subject of the email. 
 “Text”: Enter the email text to send with the image data to the recipient. 
 
“Image attachment” settings:  
 
 This field displays the currently selected settings for the image attachments and lets the user decide what 

type of images to send:  
- “Encryption”: Determines whether the images will be encrypted with a password. Click “Change” to 

change the current settings. If the “JPEG / non-DICOM” option (see below) is enabled, the JPEG, HTM 
and/or PDF files created out of the DICOM objects will not be encrypted. Encryption of image files is 
not absolutely necessary due to the fact that these files, by default, do not contain any patient 
information (no text overlay). However, please note that report objects (e.g. SR, PDF, scanned-in 
documents) cannot be encrypted either and usually contain patient-sensitive data. 
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- “Compression”: Shows what kind of compression (different levels of JPEG or JPEG 2000 compression) 
will be used for the images. Click “Change” to change the current settings. ZIP compression can also 
be used, but can only be checked in the “Compression” settings dialog. 

- “Anonymization”: Determines whether the images will be anonymized before being sent. Click 
“Change” to change the current settings. If the “JPEG / non-DICOM” option is enabled (see below) 
the JPEG files created out of the DICOM files will not have to be anonymized because, by default, the 
text overlay is not included and the images do not contain any patient information. Please note that 
report objects (e.g. SR, PDF, scanned-in documents) cannot be anonymized. 

 

WARNING: 
Be careful when sending DICOM objects, such as Structured Reports or DICOM PDF files, since these cannot 

be anonymized in the way that DICOM images are. It is recommended that this type of data be sent as 
DICOM objects including encryption (disable “JPEG / non-DICOM” option). Only this combination will ensure a 

secure transmission. 

 

NOTE:  
The security and compression settings do not have to be set every time an email is sent. Before using the email 

option for the first time, select the appropriate options and change them only if necessary later. The email 
manager also doesn’t have to be updated. A new email address can be typed in manually. 

 
- “Type”: Choose to send the images/reports as DICOM (as they are stored in the imagebox) or as 

JPEGs (created out of the DICOM images) and other non-DICOM files (e.g. for SR or DICOM PDF). 
 

NOTE:  
JPEG images can only be created out of DICOM objects that contain pixel data, i.e. DICOM images. Because 
they contain only structured information (SR, PR) or are simply DICOM encapsulated text formats (PDF) and do 

not contain pixel data, other DICOM objects, such as Structured Reports, Presentation States or DICOM PDF, 
cannot be converted into JPEG images. If the “JPEG / non-DICOM” option is enabled, an HTM version of the 

SR is attached. A DICOM PDF will be converted back to PDF and PR files are ignored. 

 
“Settings” for sending:  
 
 “Attachment size limit”: Limit the size of the attachments by increasing or decreasing the number of 

Megabytes (default = 10 MB). If the data volume is larger than the attachment limitation allows, the study 
selected will be divided into several packages that will be sent out in separate emails. With iQ-VIEW, the 
recipient will be able to automatically reassemble the divided email packages into one. 

 “Email client”:  
- “Windows default”: DICOM emails may be sent directly via the standard email client (e.g. Outlook, 

Outlook Express) by selecting “Windows default”. It is not necessary to set up the mail server as iQ-VIEW 
will use the settings from the standard email client. 

- “Internal”: iQ-VIEW also has its own integrated email client. Select “Internal” to use this email client. Be 
sure to configure the POP3/SMTP settings of the mail server.  

 “Server”: Under “Set up”, enter the configuration of the POP3 and SMTP settings to use for the internal iQ-
VIEW email client. Check the iQ-VIEW Administration Guide for instructions on how to configure an email 
account.  
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NOTE:  
If using the Windows® default email client, iQ-VIEW must be authorized by your standard mail client to allow 
access. The emails must be sent in HTML format (not “text only”) as this may lead to corrupted attachments. 

 
After all necessary information is entered, click “Accept” to start the sending process. iQ-VIEW will compress, 
encrypt and anonymize the selected data according to the chosen settings and will divide the data into 
several packages, if necessary (= multi-part emails): 
 
 When using the “Internal” iQ-VIEW email client, the email(s) will be sent immediately and the progress bar 

will display its progress. The sending dialog will close automatically when the process is complete. 
 When using the “Windows default” email client, iQ-VIEW will open the standard email program (e.g. 

Outlook or Outlook Express). A ready-to-send email will be created. In case of a multi-part email, iQ-VIEW 
will open as many email forms as necessary to send all parts of the package. Verify that everything is 
correct and click “Send”.  

 
During the process of sending an email, no other activities should be performed.  
 
For information on email reception, see chapter 4.1.6 Query panel, section 4.1.6.4. Import from DICOM email. 
 
 
4.1.11.2 COPY TO DIRECTORY 
 
The “Copy to directory” function allows a study, series or image to be copied to a specific directory from the 
local imagebox. Select the desired item to copy, click the “Export” button and choose “Copy to directory”. 
The directory of the local imagebox will open in a specific Windows Explorer window that shows only the 
directory of that particular study or series.  
 

 
 

NOTE: 
Only one study or series should be marked for copying. If you mark more than one study / series, only the one 

at the top will be displayed in the opened Windows® Explorer window.  

 
Select the folders and files to copy, then right-click the selected folders (or individual files) and choose “copy”. 
Open the regular Windows® Explorer of your system, browse to the target directory and select “paste”. The 
folders and files will be copied into the target directory. 
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4.1.11.3 EXPORTING IMAGES TO PORTABLE MEDIA 
 
With iQ-VIEW, DICOM studies or series can be exported by: 
 
 Burning patient CDs and DVDs (CD-R/RW or DVD-R/RW) on local burning drives  
 Creating projects with DICOM data on memory sticks 
 Transferring projects with DICOM data to iQ-ROBOT to burn and label patient CDs/DVDs  
 

 

To export images onto portable media, select the intended study, studies or series in the study 
table, click the “Export” button and then select “Export to medium”. The “Medium creator” dialog 
opens. 

 

 
 

NOTE:  
Studies and/or series not available locally, i.e. have been queried from a remote station (e.g. PACS), can also 

be exported. Select the studies / series to export and select “Export to medium”. The studies / series will be 
downloaded automatically into the local imagebox. 

 
 
1. Study grid 
 
In the upper part of the “Medium creator” dialog is a grid that lists and identifies all studies / series that have 
been selected to be exported. 
 
For each entry the patient name, patient ID, study date and UID are listed. In addition, their size and the 
number of objects included in the study / series are shown.  
 
Verify that the correct selections were made here. Every item listed will be exported. 
 

NOTE: 
If an incorrect selection is made, close the “Medium creator” dialog and make a new selection in the study list 

of the Study Browser. 
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Medium creator dialog 

 
 
2. Medium options 
 
Other options for exporting DICOM data to the medium include: 
 
 “Include JPEG images”: Choose this option to add JPEG images of all DICOM images onto the medium. 

This option is useful for users who work with computers that are not running a Windows operating system 
(e.g. Linux, MAC) and are not able to start the iQ-LITE viewer.  

 

NOTE: 
Please note that it will not be possible to create JPEG files out of DICOM objects that are not images, such as 

Structured Reports, Presentation States or DICOM PDFs. While the PR are ignored completely in the web 



 

 

 

 iQ-VIEW 2 8 0 User Manual INT EN – 002R 40 

content, the SR and the DICOM PDFs will be provided as an HTM page or PDF file respectively and can, 
therefore, be viewed in the web browser. 

 
Creating and exporting additional JPEG images makes it possible to view the patient studies even if a 
DICOM viewer is not used, e.g. in an image viewing/processing application. These images may be viewed 
in a web browser. A webpage is automatically created and added to the medium. Open the 
“INDEX.HTM” file to view the available studies.  

 

NOTE:  
Without this option enabled, the iQ-LITE study browser on the medium will not be able to display the thumbnail 

images in the preview icons panel since this feature makes use of the additional JPEG images. 

 
 
 “Include iQ-LITE viewer”: When this option is selected, the created media will also contain a copy of the 

iQ-LITE viewer that includes most of the features of the iQ-VIEW viewer, including multi-monitor capability 
and comparison of series. An individual iQ-LITE user manual is added to the medium for perusal.  

 

NOTE:  
A copy of the file “Institution.bmp”, available by default in the iQ-VIEW installation folder, is exported onto the 
medium as “BANNER.JPG”. Personalized institution information, such as an institution logo, can be displayed in 
the iQ-LITE viewer and website header by creating an Institution.bmp file with a resolution of 1024x75 pixels and 

copying it into the iQ-VIEW installation folder. 

 
 “Check medium after creation”: Select this option to test if the burning process was completed 

successfully or if any errors occurred. During this check the content on the medium will be compared to 
the study / series selected. If there is a discrepancy, an error message will be shown. Further details can 
then be found in the iQ-VIEW log files (see section 4.1.13 Jobs (Process Manager)). 

 
 “Finalize medium”: By default, CDs/DVDs burned by iQ-VIEW are created as multi-session media. Therefore, 

it is possible to add more data later. CDs can be finalized by activating this option. A finalization of DVDs is 
currently not possible. 

 

NOTE:  
This option is not available when image projects are transferred directly to iQ-ROBOT or when a project is 

created. 

 
 
3. Status information 
 
The “Medium creator” dialog also shows information about the selected local CD / DVD burning drive, the 
medium type used for burning, the space the project will need on the medium, as well as the available free 
space. 
 

NOTE: 
If an image project is transferred directly to iQ-ROBOT or a project is created (e.g. on memory stick) and no CD 

or DVD was inserted into a local burning drive, only the “needed” space will be given as status information. 
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If there is already data stored on the medium, the occupied space is shown in blue while the space that the 
project will need is marked in green: 
 

 
 

 

If the automatic CD / DVD recognition in the burning dialog does not work (status bar shows “No 
CD” or a message is displayed that the available space is not sufficient even though the medium 
is empty), a medium can be manually loaded into the CD or DVD burner using the CD button. 

 
 
4. Burning patient CDs/DVDs on local drives 
 
iQ-VIEW has an internal CD/DVD burning library integrated in it for burning CD-R/RW or DVD-R/RW disks on a 
local burning drive: 
 
 Select the study, studies or series to be exported. 
 Put the medium into the CD/DVD drive. 
 Click the “Export” button and then select “Export to medium”. 
 Be sure to wait until the medium was fully loaded and the status information is updated. 
 Select the appropriate options (e.g. iQ-LITE viewer, JPEG images). 
 Select the “CD/DVD writer” in which the blank CD/DVD was inserted. 
 Adjust the burning “speed”, if necessary. 
 

 

After having made the appropriate settings, click the “Burn with local burning drive” button to start 
burning the data onto the medium. 

 

NOTE:  
If the “Burn with local burning drive” button is grayed out and it is impossible to select the local burning drive, 

the operating system is probably Windows XP and the user probably does not have sufficient rights on the 
computer to access the burning devices. In that case, please install the “Nero Burn Rights” tool on the 

computer while being logged in as Administrator. This tool can be downloaded from the internet for free 
(http://www.nero.com/enu/support-nero6-tools-utilities.html). Afterwards, patient CDs/DVDs should be allowed 

to burn with iQ-VIEW as a restricted user.  

 
 
5. Creating projects  
 
A project can be created to put DICOM data on a memory stick or burn it at a later time with another, third-
party burning software (e.g. Nero) instead of burning a CD or DVD directly: 
 
 Select the study, studies or series to be exported. 
 Click the “Export” button and then select “Export to medium”. 
 Select the appropriate options (e.g. iQ-LITE viewer, JPEG images). 
 Choose a “Project folder” in which the project will be created. By default, the project’s content will be 

copied to the sub-folder “CD-Projects” in the iQ-VIEW installation directory. 
 

http://www.nero.com/enu/support-nero6-tools-utilities.html�
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Click the “Create project” button. A dialog will appear asking for the desired project folder name. 
This name can be freely chosen. A folder of this name will then be created in the directory path 
given for the placement of projects. After the project creation is finished, this folder will contain all 
necessary files and image data of that project. 

 

NOTE:  
If no project folder name is selected and the entry field is kept empty, iQ-VIEW will place all files and image 
data of that project directly into the designated directory path. For example, if the home directory of a USB 

drive is designated as the directory path, e.g. “F:\”, the project is directly stored there. This makes it possible to 
use the auto-run function for iQ-LITE directly from the memory stick, if the system allows for this.  

 
 
6. Transferring projects to iQ-ROBOT 
 
If an iQ-ROBOT server (version 1.0.1 or higher) is running on a system in the network and is connected to the iQ-
VIEW station, iQ-VIEW will be able to transfer projects directly to the robot server: 
 
 Select the study, studies or series to be exported. 
 Click the “Export” button and then select “Export to medium”. 
 Select the appropriate options (e.g. iQ-LITE viewer, JPEG images). 
 

 

Click the “iQ-ROBOT” button. When using it for the first time, the interface must be configured. 
Afterwards, when clicking the button, a temporary folder will be created in the “Project folder” 
directory path. After the project creation is finished, the entire content and labeling information is 
automatically transferred to the iQ-ROBOT server to be printed and labeled on the robot device. 

 

NOTE: 
For information on how to configure the interface to the iQ-ROBOT server, please consult the iQ-VIEW 

Administration Guide. 

 
 
7. Creating multi-session media 
 
With iQ-VIEW it is possible to create multi-session media. 
 
If the “Finalize disc” option was not activated when the first session was exported onto the medium, another 
session with new data can be added at a later time. 
 
The multi-session option is also available for project creation.  
 
Before starting the burning or project creation process, iQ-VIEW will check to see if the inserted medium or the 
project under the stated project folder name already contains studies and prompt the user to decide whether 
the new data should be appended or not.  
 
If confirmed, iQ-VIEW will append the new studies to the medium / project. If not confirmed, iQ-VIEW will abort 
the medium / project creation. 
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NOTE: 
The multi-session function is not available when pushing projects directly to an iQ-ROBOT server. 

 
 
8. DICOMDIR file 
 
The media / projects created with iQ-VIEW will always contain a DICOMDIR file that registers all studies, series 
and images exported onto the media. This file is used as a database when displaying the data in the iQ-LITE 
viewer (if added to the medium). It can also be used to speed up the process of importing images on the 
medium to another workstation or PACS. 
 
 
9. Transferring iQ-VIEW user settings to iQ-LITE 
 
If the option to put the LITE viewer onto the medium is checked, specific settings made by the iQ-VIEW user in 
the iQ-VIEW application are automatically transferred to iQ-LITE. 
 
For example, the selected language of the iQ-VIEW user interface is also used for iQ-LITE – a medium created 
with an Italian iQ-VIEW will also result in an Italian iQ-LITE user interface. Copies of the “Windows.txt” file and the 
“OverlayMapping.script” are transferred to the medium as well. As a result, any window leveling presets made 
in iQ-VIEW, as well as the text overlay configuration, will be available in iQ-LITE. 
 
In addition, a header image can be added to a medium with the institution’s information included (e.g. logo, 
contact information). This will be displayed both in the iQ-LITE application and on top of the website 
information (if HTM content is included on the medium). See the iQ-VIEW Administration Guide for instructions 
on how to create a customized “Institution.bmp” (iQ-LITE logo). 
 

NOTE: 
Using a specific configuration file, certain functions and display options may be prompted in the iQ-LITE 

software. For information on how to create this file (called Lite.ini) and the available parameters, consult the 
iQ-LITE Administration Guide, which is available for download in the Download Center of the manufacturer’s 

website www.image-systems.biz.  

 
 
4.1.12 IMPORT 
 

 

Using the “Import” dialog, JPEG, BMP, TIFF and RAW image files can be imported from different 
sources (a directory, TWAIN source, iQ-CAPTURE or iQ-CR ACE). They can then be matched with 
patient and study data and converted into DICOM images.  

 
In iQ-VIEW PRO, PDF files can be imported to be converted into DICOM encapsulated PDF objects. 
 
After opening the “Import” dialog, select the source of the non-DICOM images. All image files opened in the 
“Import” dialog are displayed in the preview bar and can be dragged into the larger preview window where 
various modifications can be applied such as windowing, flipping / rotating, filtering and adding position 
markers and text information. PDF documents will be displayed in the preview bar and preview window but 

http://www.image-systems.biz/�
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they cannot be post-processed using the processing functions of the “Import” dialog since they are not image 
files.  
 
The patient and study information can be added either manually or with the help of a DICOM Modality 
Worklist (PRO version only!) before the images are converted to DICOM and stored in the local iQ-VIEW 
imagebox. 
 

 
Import dialog 

 
 
4.1.12.1 STRUCTURE AND FUNCTIONS OF THE “IMPORT” DIALOG 
 

 

Clicking the “Close import dialog” button will close the “Import” dialog and return to the Study 
Browser.  

 
 
1. Preview bar and preview window 
 
All images selected from a directory or opened from a source in the “Import” dialog are displayed in the 
preview bar in the upper part of the “Import” dialog:  
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If there are more images imported than can be displayed, a scrollbar will appear to allow for browsing 
through the available images. 
 
From the preview bar the images can be dragged (by drag & drop) into the larger preview window or be 
deleted, if not needed. 
 

 

The “Delete” button offers two options:  
 
 Click the “Delete” button to delete all images displayed in the preview bar. 
 Click an individual image in the preview bar, drag it to the recycle bin and drop it there. Only 

this image will be deleted. 
 
In the larger preview window the last imported image will always be shown. To switch to another image, click it 
in the preview bar and drag it into the preview window. 
 

 
“Import” dialog: preview window 

 
An image in the preview window can be processed using the available tools in the toolbar. 
 
 
2. Image processing tools 
 
The “Import” dialog offers several tools for image manipulation. 
 
A multi-function button offers the following options: 
 

 

“Windowing”: An image displayed in the preview can be windowed using the left mouse button. 
The regular mouse pointer turns into the windowing symbol. If another function is also currently 
active, it is possible to window an image using the center mouse button. 
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“Shutter”: A shutter can be drawn around an image in the preview window. The regular mouse 
pointer turns into a crosshairs symbol. Select a specific area of an image (only rectangular) with 
the shutter and the rest of the image will be blackened out. The blackened-out areas are not 
deleted from the image; they are only hidden. In the viewer, it is then possible to deactivate the 
shutter to make the entire image visible again. 

 

NOTE: 
Only one shutter can be drawn per image. This shutter form is then written into the appropriate sequence of 

the DICOM header of this image and can be read by all applications that support the display of shutter 
sequences. 

 

 

“Add text information”: This function can be used to add text information concerning individual 
images, e.g. “aggravated exposure conditions”. The information will be stored as a fixed bitmap 
overlay in the DICOM file. 

 

NOTE: 
Keep in mind that later it will not be possible to deactivate the display of this text information in the viewer. 

Therefore, you may want to position the annotation in a way that it does not affect the viewing of the image 
itself. 

 
Click the “Add text information” button, then click the image in the position where the text should start. The 
overlay dialog box opens: 
 

 
 
There you can enter the text of the annotation. 
 

 
Using the “+” button, the annotation can be added to the list in the drop-down menu for easy selection 
later. 

 

 
Using the “-” button, deletes the currently displayed annotation from the drop-down list. 

 
Select the font size of the annotation in relation to the image width. The default setting is 5 % of the image 
width. 
 
Click “Accept” to add the annotation to the image or “Cancel” to close the overlay dialog box without 
adding the annotation. 
 



 

 

 

 iQ-VIEW 2 8 0 User Manual INT EN – 002R 47 

 

“Set filter”: Allows different forms of image manipulation: sharpen, edge enhance, soften, soften 
(less), low pass, high pass, blur and invert. All changes (incl. window changes, flipping or rotation 
and text annotations) can be reset by selecting “Set back to origin”. 

 

 

“Flip vertically”: The image is flipped vertically. 
 

 

 

“Flip horizontally”: The image is flipped horizontally. 
 

 

 

“Rotate clockwise”: The image is rotated 90° clockwise with every click. 
 

 

 

“Rotate counter-clockwise”: The image is rotated 90° counter-clockwise with every click. 
 

 

 

“One step back”: All changes made in the image are set back one at a time. This function can be 
used if only the last changes need to be reset and not all modifications made in the image. 

 
 
3. Adding position markers 
 
Marker information can be added to the image to indicate where the top, bottom, left and right are. This can 
not only simplify the orientation in an image but may even be diagnostically relevant. 
 

 

The “Marker” button can be used to add orientation indicators 
to the images. Clicking the “Marker” button directly above the 
upper left corner of the preview window will activate the “H” 
and “L” markers surrounding the preview window. These 
indicators will remain in the correct position even if an image is 
flipped or rotated. Possible markers are: 
 
 L = left 
 H = head 
 

   and    
 

 
Position markers can be set globally or individually for each image: 
 
 To set markers globally, select one image, click the “Marker” button to activate the function and then 

select the correct marker by checking the appropriate checkbox: “H” (top or bottom) and “L” (left or 
right). All other images will have the markers at the same position. 
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 To set markers individually, select one image, click the “Marker” button to activate this function and check 
the appropriate checkboxes. All other images will have the same settings. Then select the images where 
the orientation is different and adjust the position markers accordingly. 

 
 
4. Filling in DICOM information 
 
On top of the “DICOM” entry panel, there are two buttons used for the following functions: 
 

 
“DICOM Modality Worklist”: Will open the DICOM Modality Worklist dialog (only available in iQ-
VIEW PRO). A DICOM Modality Worklist must be configured before it is used. Queries can be run 
to find the appropriate patient in the Worklist. Once found, select the patient corresponding to 
the new study and click the “Accept” button. The information will be loaded into the 
appropriate DICOM fields in the “Import” dialog.  

 

NOTE:  
Using a BDT/GDT file filled with all necessary patient and study parameters it is also possible to run a request 
from your HIS/RIS to iQ-VIEW directly opening the “Import” dialog and automatically populating the DICOM 
fields with the information provided in the BDT/GDT file. For detailed information on how to use this feature, 

please consult the iQ-VIEW Administration Guide.  

 

 
“Clear entries”: Will clear all entries from the patient/study mask. The institutional information, 
however, will be maintained (“Performing physician”, “Performing radiographer” and 
“Institution”).   

 
In the “DICOM” field, information can be entered about the study, series and images that will be created. 
Available parameters are: 
 

 

 “Last name”: Enter the patient’s last name. 
 “First name”: Enter the patient’s first name. 
 “Patient ID”: Enter the patient ID used for that 

particular patient. 
 “Sex”: Select the appropriate sex from the drop-

down list (O=other, M=male, F=female). 
 “Date of birth”: Enter the patient’s date of birth either manually or with the help of the drop-down 

calendar. 
 

 

 “Accession number”: Enter the accession number 
allocated for the case to which the study 
belongs. 

 “Study date”: Enter the date on which the study 
was created either manually or with the help of 
the drop-down calendar. 

 “Referring physician”: Enter the name of the referring physician. 
 “Modality”: Select the appropriate modality from the drop-down list. 
 “Study description”: Enter the study description to explain the content of the study. This entry will be written 

into the DICOM header of all images. 
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WARNING: 
The list of values that iQ-VIEW provides as “Modality” markers has been compiled according to the DICOM 

Standard. These are the markers that are defined by the DICOM Standard and should be used in all 
applications compliant to this standard. iQ-VIEW, as a certified medical device, needs to comply with the 

requirements set by this standard. Therefore, only DICOM compliant modality markers should be used (e.g. not 
“RM” instead of “MR” as often used in Spanish). If incompliant modality markers are used, this can lead to 

issues when communicating with other DICOM stations, when searching for studies from specific modalities or 
when using modality-specific hanging protocols. 

 

 

 “View”: Gives information about the path of the 
x-rays through the body. It defines the exact 
position that the patient was in when the images 
were taken, how the patient was positioned in 
front of the plate and from where the x-rays 
entered the body.  

Examples include: PA, AP, LR, RL, etc. This information will then be stored in the DICOM attribute 
"ViewPosition (0018,5101)". The view position can be set for each image individually. 

 “Laterality”: This is used to describe the patient’s position and indicate the side of the patient’s body that 
was placed against the detector plate. 

 “Body part examined”: Select the examined body part from the drop-down list. This entry will be used for 
all images. 

 “kVP”: Enter the value of kilovolt peak for radiographic images. 
 “mA”: Enter the value of milli-Ampere seconds for radiographic images. 
 “Dose”: Enter the dose value for radiographic images. As different measurement units are still in use, 

selections include: deziGray (dGy), milliGray (mGy), Sievert (Sv), Röntgen (rad) or Rem (rem). The last 
selected measurement unit will be remembered at the next opening of the “Import” dialog. 

 “Image description”: Enter a description for the individual images. Drag the desired image to into the 
preview window and enter the description into the “Image description” field. Then select the next image 
and change the text to the next description. 

 

WARNING: 
The lists of terms and values that iQ-VIEW provides for “View”, “Laterality” and “Body part examined” have 
been compiled according to the DICOM Standard. These are the terms and values that are defined by the 
DICOM Standard and should be used in all applications compliant to this standard. iQ-VIEW, as a certified 

medical device, needs to comply with the requirements set by this standard. Therefore, the terms and values 
should not be altered (e.g. translated into other languages). 

Not adhering to the DICOM standard can, under certain circumstances, lead to incompatibilities, e.g. when 
communicating with other devices. It can also lead to inconsistent data, which may be problematic on some 

DICOM stations, e.g. when a workstation uses the view position, laterality and/or body part examined 
attributes to apply hanging protocols. Using incorrect terms could result in the hanging protocols not being 

used.  

 

 

 “Performing physician”: Enter the name of the 
performing physician. 

 “Performing radiographer”: Enter the name of the 
performing radiographer. 

 “Institution”: Enter the name of the institution 
(hospital, clinic or practice). 
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Using the “+” button, the entry can be added to the list in the drop-down menu for easy selection later. 

 

 
Using the “-” button, deletes the currently displayed entry from the drop-down list. 

 
The last entries (if stored) will be remembered and displayed again when the “Import” dialog is opened the 
next time. 
 

NOTE: 
It is recommended that as much patient and study information is filled in as possible as this will make it easier to 
recognize the study later and to search for it using search filters. A missing patient name or patient ID will make 

it hard or even impossible to recognize a study. 

 
After filling in all necessary patient and study information, select whether all images imported into the “Import” 
dialog should belong to: 
 
 Different studies, i.e. a new study will be created for each image 
 The same study but different series, i.e. one study will be created, but each image will be stored in its own 

series 
 The same series, i.e. one study will be created with one series containing all images (default setting) 
 
 
4.1.12.2 AVAILABLE IMPORT SOURCES 
 
Non-DICOM images can be imported from different sources into the “Import” dialog and converted into 
DICOM images: 
 
 
1. Importing JPEG, BMP, TIFF and RAW images from a directory 
 

 

The “Open file” button is used to import JPEG, BMP, TIFF or RAW images that are stored on a hard 
disk or on portable media. A Windows Explorer window opens where the user can navigate to the 
drive or folder in which the images for importing are stored. 

 
One or several images can be selected. Multi-select images by holding down the [SHIFT] or [CTRL] key. After 
making a selection, click “Open” and the images will be copied into the “Import” dialog. 
 
If more images need to be imported from other folders, click the “Open file” button again, browse to the 
correct directory and make a selection. The new images will be added to the ones imported the first time. 
 
Possible image formats are: 
 
 JPEG images 
 BMP (bitmap) images 
 TIFF images 
 RAW images 
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Since raw images do not provide specific parameters necessary for correctly displaying the images, these 
parameters must be provided by the user. When iQ-VIEW realizes that a grayscale RAW image will be 
imported, a dialog is opened where the following parameters must be specified: 
 
 “Columns”: The width of the raw image must be given in pixels. 
 “Rows”: The height of the raw image must be given in pixels. 
 “Pixel representation”: Select whether this image is an 8 bit, 12 bit or 16 bit grayscale image. 
 “Inverse”: Select this checkbox if the image must be inverted while importing. 
 
Click “Accept” to import the raw image into the “Import” dialog or “Cancel” to terminate the importing 
process. 
 

 
 

NOTE: 
Images can be displayed correctly in the “Import” dialog and later as a DICOM image only if the parameters 
are correct. Therefore, make sure that the appropriate parameters are handy when importing RAW images. 

 
 
2. Importing PDF files from a directory 
 
This function is only available in iQ-VIEW PRO and requires that Acrobat Reader or another PDF reader be 
installed on the system to open and view PDF and DICOM PDF files. 
 

 

The “Open file” button can also be used to import PDF files from a directory. A Windows Explorer 
window opens where the user can navigate to the drive or folder in which the PDF files for 
importing are stored. 

 
PDF files will be converted into DICOM-encapsulated PDF files making it possible to attach reports to an image 
study and transfer them at the DICOM level. The reports can be stored in the local iQ-VIEW imagebox as well 
as in an archive. 
 

NOTE: 
An archive must support the SOP class for DICOM encapsulated PDF to be able to store this data correctly. 
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3. Importing images from TWAIN sources 
 
iQ-VIEW has an integrated TWAIN interface for connecting scanners (e.g. Vidar scanners), cameras, CR 
reading systems or other TWAIN compatible devices and import images from them. For detailed information 
on how to configure the TWAIN interface and connect to a source, please refer to the iQ-VIEW Administration 
Guide. 
 

 

“TWAIN source”: Click this button to choose a scanner, a CR system, a camera, or another TWAIN 
compatible device as a source for images. 

 
When importing images from a TWAIN source for the first time, click the “TWAIN source” button and a dialog 
box will open and show the available drivers that are installed on the computer. Choose a driver and capture 
the image(s) you want. Click “Accept” and the image(s) will be loaded. After adding the patient / study data, 
click “Import to local imagebox”.  
 
Afterwards, when clicking the “TWAIN source” button, the TWAIN source that was used last will be opened 
automatically.  
 
If another TWAIN source needs to be chosen, right-click the “TWAIN source” button. The dialog box with all 
available drivers will open again and a new source can be selected. 
 
Create the images, select the ones to import and accept the selection to copy them into the “Import” dialog. 
If more images need to be imported, connect to the TWAIN source again, create the additional images and 
add them to the ones imported the first time. 
 

NOTE:  
If a device (e.g. scanner) needs to be connected to iQ-VIEW but there is no TWAIN driver available, a folder 

can be set up as a drop-box that iQ-VIEW will scan regularly. The device must be configured to store scanned 
images in that folder. As soon as iQ-VIEW recognizes the images, it will transfer them into the “Import” dialog, 
where they can be matched with patient data and converted into DICOM. For information on how to setup 

the drop-box, please read the appropriate section in the iQ-VIEW Administration Guide.  

 
 
4. Importing images with iQ-CAPTURE 
 
iQ-VIEW PRO (only!) has an integrated interface to the iQ-CAPTURE module.  
 

 

“iQ-CAPTURE module”: Click this button to open the capture interface with which the iQ-VIEW PRO 
user is able to capture single medical images or sequences from different video sources (VHS, S-
VHS, composite video, VGA, DVI, HDMI, RGB or analog gray video signals). Several 
acceptable sources include: cameras, microscopes or VCRs, as well as non-DICOM 
compatible medical devices such as ultrasound, MR and CT devices.  

 
iQ-CAPTURE uses a DirectShow® interface to digitize the signals from the video sources. These signals are 
imported into the iQ-VIEW PRO “Import” dialog, converted into DICOM images and then stored in the local iQ-
VIEW PRO imagebox. The use of footswitches for starting and stopping the capturing process is supported. 
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For further information on how to configure and use iQ-CAPTURE, please refer to the respective user manual 
can be accessed directly from the iQ-CAPTURE module.  
 
 
5. Importing images from iQ-CR ACE 
 
The interface to iQ-CR ACE is available both for iQ-VIEW and iQ-VIEW PRO, but it is strongly recommended that 
PRO is used since additional functions are available only there. These functions are explained in the following 
sections. 
 
After the setup and licensing of the iQ-CR ACE and the configuration of the connection to iQ-VIEW, the user 
can import CR images directly from the iQ-CR ACE reader into iQ-VIEW. 
 

NOTE:  
For instructions on how to connect the iQ-CR ACE and the included post-processing software to iQ-VIEW, 

please refer to the iQ-VIEW Administration Guide. 

 

 

“iQ-CR ACE interface”: Click the iQ-CR ACE button to connect directly to the acquisition software 
if the path to the post-processing software is already established in iQ-VIEW. (Otherwise, the 
correct path will need to be configured.) Images will be taken from the iQ-CR ACE, automatically 
processed and then put into the iQ-VIEW “Import” dialog. If necessary, further modifications can 
be made to the images and patient data added before converting them into DICOM. 

 
There are additional options that can be used for image acquisition from iQ-CR ACE. These options are 
available by right-clicking the “iQ-CR ACE interface” button: 
 

 
 
 “Post-process images”: This function is enabled by default. All images that are imported from iQ-CR ACE 

will be processed by the post-processing software before they are displayed in the “Import” dialog to 
receive the best quality possible. However, for quality inspection after installation, as well as for annual 
quality checks, it is necessary to import the original images without additional post-processing. For these 
quality checks, deactivate the post-processing option. 

 “Auto-invert images”: If activated, iQ-VIEW will automatically invert the images coming from the iQ-CR 
ACE after post-processing. This function is activated by default since the images usually are inverted when 
received from the iQ-CR ACE. 

 “Display histogram”: If activated, iQ-VIEW will display the image’s histogram after the import procedure.  
In general, the histogram acts as a graphical representation of the tonal distribution in a digital image. 
That means it plots the number of pixels for each tonal value. By looking at the histogram for a specific 
image the user will be able to judge the entire tonal distribution at a glance. The horizontal axis of the 
histogram graph represents the tonal variations, while the vertical axis represents the number of pixels in 
that particular tone. 
If the displayed histogram is closed, it can be opened again by deactivating and then reactivating the 
“Display histogram” function in the sub-menu. It can be shown for any image imported from iQ-CR ACE 
that is currently displayed in the preview area. 
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NOTE: 
The “Display histogram” option is only available when connecting to iQ-CR ACE. The histogram can be 

calculated and displayed only for images imported from there. Images imported from other sources (e.g. iQ-
CAPTURE or TWAIN) are excluded from this function. 

 
 
6. Configuration of iQ-CR ACE post-processing with iQ-VIEW PRO 
 
The following options are only available using the iQ-CR ACE scanner in combination with iQ-VIEW PRO. 
 
To achieve the best results when post-processing the images it might be necessary to use specific post-
processing settings for different kinds of images. Therefore, iQ-VIEW PRO offers the possibility to define different 
settings depending on the body part examined. The following parameters can be set: 
 
 “Sharpness” value 
 “Processing” mode 
 
As soon as an image is imported from iQ-CR ACE, a part of the “DICOM” mask changes to show the post-
processing functions: 
 

    
 

 
The switch button is used to switch between the two sections of the “DICOM” mask – to switch between 
the post-processing functions and the “kVP”, “mA” and “Dose” fields. 

 
If the default processing does not provide the desired quality, it is possible to change the processing 
parameters for this particular import and run the image through the post-processing software once again. 
 
Depending on the selected “Body part examined”, you can set the values for the “Processing” mode and the 
“Sharpness”.  
 

NOTE: 
Be sure to select the “Body part examined” first, before setting the other values. 

 
For second-time post-processing of the current image: 
 
If the settings will be used only for the current image, nothing else is required. Make the necessary adjustments 
and, after a moment, the post-processing is automatically started again. The result is displayed in the preview 
area. 
 
Images imported via iQ-CR ACE can be run through the post-processing as often as needed. 
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For changing the default processing settings for the current “body part examined”: 
 
If you wish to use the set parameters for all future images matching the same “Body part examined” then 
these settings can also be saved. The parameters are then written into a configuration file and are used the 
next time the appropriate body part is selected. 
 
To store the selected settings: 
 
 Right-click the “Body part examined” entry field. The “Save post-processing settings” button appears. 
 Click the button to store the current settings for the chosen body part. 
 

 
 

NOTE: 
The configured settings are stored in an INI file called “BodyPartSetup.ini” in the “CR ACE” sub-folder. 

 
The next time a “Body part examined” is selected for which post-processing parameters have been stored in 
the configuration file, these settings will automatically be applied to the processing of the imported images. 
 

NOTE: 
To apply settings made in the “BodyPartSetup.ini”, be sure to select the correct body part first from the “Body 
part examined” list in the “DICOM” mask of the “Import” dialog. Then, click the iQ-CR ACE button to start the 

import process. 

 
 
4.1.12.3 CREATION OF DICOM STUDIES 
 

 

After you have imported all image files, processed them and filled in the patient and study 
information fields, click “Import to local imagebox”. The conversion of the images into DICOM 
format will start. The created studies / series will then be registered into the iQ-VIEW database and 
stored in the local imagebox. 

 

 
Information dialog for the creation of DICOM images 

 
After the conversion is finished and the images are stored in the local imagebox, a dialog pops up allowing 
you to leave the “Import” dialog or: 
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 Create another study for the same patient (“Next study”)  
 Create another series for the same study currently created (“Next series”)  
 Transfer the currently created study / series to a remote station 
 
If you decide to create a new study or series, the appropriate patient and study information will then be kept 
to populate the “DICOM” mask of the “Import” dialog. Only the data for a new study or another series needs 
to be added to the fields. 
 

 

Clicking this button offers the option to send the created DICOM images directly to one of the 
DICOM archives configured in the DICOM settings. A sub-menu with all available archives will 
open. Select the archive to which you wish to send the previously created DICOM study / series. A 
note appears after the transfer has finished. 

 

NOTE:  
Please note that the “Transfer” function is unavailable if the option “Images belong to different studies” was 

selected in the “Import” dialog to create a separate study for each imported image. 

 
 
4.1.12.4 ADDING IMAGES TO ALREADY EXISTING STUDIES 
 
Sometimes it is necessary to add images to existing studies or to add additional studies for the same patient. 
This can be done by dragging a study from the study table onto the “Import” button. The “Import” dialog will 
open automatically and contain the patient and study data in the DICOM entry fields.  
 
This function is available both for locally stored studies (local imagebox) or studies stored on remote archives 
connected to iQ-VIEW. 
 
For studies stored in the local imagebox: 
 
 Select the study to which you wish to add images in the study table and drag it onto the “Import” button. 

The “Import” dialog opens and the patient information (patient name, patient ID, sex, date of birth, etc.) is 
shown. 

 Adjust the information, if necessary and add the study information for the new images. 
 Import the images from the appropriate source and process them as needed (windowing, rotation, 

flipping, filtering, etc.) 
 Determine if the images should belong to: 

- the original study and be stored in the same series 
- the original study with a new series created for each imported image 
- different studies (a new study is created for each imported image) 

 Click the “Import to local imagebox” button to convert the images into DICOM and store them in the local 
imagebox with the existing study. 

 
For studies stored on a connected remote archive: 
 
 Query the remote station where the study is stored. 
 Select the study to which you wish to add images in the study table and drag it onto the “Import” button. 

The “Import” dialog opens and the patient information (patient name, patient ID, sex, date of birth, etc.) is 
shown. During this process the study is not downloaded into the local imagebox. 
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 Adjust the information, if necessary and add the study information for the new images. 
 Import the images from the appropriate source and process them as needed (windowing, rotation, 

flipping, filtering, etc.) 
 Determine if the images should belong to: 

- the original study and be stored in the same series 
- the original study with a new series created for each imported image 
- different studies (a new study is created for each imported image) 

 Click the “Import to local imagebox” button to convert the images into DICOM and store them in the local 
imagebox. Only the new images will be available locally, as the original study was not downloaded.  

 Use the “Transfer” function offered during conversion to immediately send the new images to the remote 
archive where the original study is stored or send it later from the “Database” study table. When sending 
the images to the remote station, they will automatically be joined with the original study. 

 

NOTE:  
Note that the “Transfer” function is unavailable if the option “Images belong to different studies” was selected 

in the “Import” dialog to create a separate study for each imported image. 

 
 
4.1.13 JOBS (PROCESS MANAGER) 
 

 

Click the “Jobs” button in the Study Browser to open the Process manager. Two tables appear – 
one that gives information about the DICOM processes in the iQ-VIEW network (“Jobs table”) and 
one that logs all important activities performed in the application as well as the DICOM network 
communication (“Process log”).  

 

NOTE: 
All information about the process manager and the creation of log files can be found in the iQ-VIEW 

Administration Guide. 
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4.2 VIEWER 
 

 
iQ-VIEW viewer window 

 
 
4.2.1 THE SERIES PREVIEW BAR 
 
The series preview bar can be used to get an overview over the studies loaded into the viewer. It gives 
information about the series of the loaded studies, allows the navigation between studies and offers a function 
to query a remote archive for previous studies of the patient currently loaded into the viewer. 
 

 
 

WARNING: 
The series preview bar of iQ-VIEW can only display up to 99 series. It is not possible to correctly load studies that 
contain more than 99 series. In those very rare cases where such a study is provided on the medium, you may 

select a number of series in the study browser to load into the viewer instead of loading the entire study. 
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4.2.1.1 INFORMATION IN THE SERIES PREVIEW BAR 
 
The viewer will display either one or two series preview bars. On a single display system, just one preview bar 
will be displayed when only one study is loaded into the viewer. If several studies are loaded, at first only one 
preview bar will open with the series information of the first study, but it is possible to open a second one, 
displaying the next study. 
 

 

In the series preview bar, all available series of a study are displayed with 
one thumbnail representing each series. The series currently active in the 
image processing area will be shown with a yellow frame in the series 
preview bar for easier orientation. 

 
Each series thumbnail displays a number that corresponds to the number of images included in the series. In 
case of multi-frame images, the number of available frames will be displayed. 
 
 
4.2.1.2 FUNCTIONS OF THE SERIES PREVIEW BAR 
 
The series thumbnails in the preview bar can be used to populate the views in the image processing area – 
both on single and dual display systems – by: 
 
 Dragging a series from the preview bar to an available view of your choice 
 Double-clicking a series thumbnail to load it into the currently active view (blue frame)  
 
Below is a description of the various buttons that may be found in the series preview bar: 
 

 
Queries for previous studies of the currently active patient on a connected remote archive. For more 
information see section 4.2.15 Searching for previous studies of the same patient on remote archives. 

 
The following buttons are only visible, if more than one study is loaded into the viewer. 
 

 
Clicking the forward button will open the next study in the image processing area (on the primary 
display in dual display systems). 

 

 
Clicking the backwards button will open the previous study in the image processing area (on the 
primary display in dual display systems). 

 

 
Clicking the plus button, on single-monitor systems, opens a second series preview bar with the 
thumbnails of the second study loaded into the viewer. If more than two studies are loaded, a click on 
the plus button opens a sub-menu with all other available studies for selection. On dual display systems, 
the second preview bar is automatically shown on the second display. A click on the plus button can 
be used to open further loaded studies. 

 

 
For this button the second preview bar must additionally be open. It is used to close the second series 
preview bar on single display systems. It is not possible to close the second preview bar when working 
with dual displays. 
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4.2.1.3 SIZE OF SERIES PREVIEW BAR 
 
Depending upon the needs of the user, it is possible to configure the size of the series preview bar. More space 
can be given to the image processing area by reducing the size of the preview bar. On the other hand, better 
viewing of the images in the preview bar can be achieved by enlarging its size.  
 

 
 
To set the size of the series preview bar: 
 
 Click the “Additional settings” menu 
 Point to “Size of series preview bar” so that the additional side menu appears 
 Select the desired size of the series preview bar - “Small”, “Medium” or “Large” 
 
To either hide or show the series preview bar: 
 
 Click the “Additional settings” menu 
 Point to “Size of series preview bar” so that the additional side menu appears 
 Hide or show the series preview bar by selecting either “Hide” or “Show”. Alternatively, this can be done 

using the switch on the left border. 
 

 =  

The series preview bar can be hidden or shown using the switch on the left side of the bar. The 
color of the switch changes on a mouse-over. 

 
 
4.2.1.4 USING THE SERIES POP-UP LIST 
 
The series pop-up list can be used in place of the series preview bar (in the upper part of the screen) for 
selecting a new series for viewing. A good example is when the series preview bar is hidden to allow for more 
space in the image processing area. This pop-up list can be accessed by: 
 
 Clicking the “Tools” menu and selecting “Series pop-up list” 
 Using a pre-defined shortcut (default = F12 or user-defined) 
 Right-clicking in the series preview bar 
 



 

 

 

 iQ-VIEW 2 8 0 User Manual INT EN – 002R 61 

 
 
The series pop-up list opens a menu containing all loaded patient studies with their available series. There are 
two options for using the series pop-up list to populate the image processing area: 
 
 To load another series of the currently active study into the active view (blue frame), open the series pop-

up list and click the necessary series. 
 To switch to an entirely different study already loaded into the viewer, open the series pop-up list and click 

the entry for the desired study. The pop-up list will remain open for further selection of the series. 
 

 
Example of a series pop-up list 

 
 
4.2.2 THE STUDY TABS 
 
Between the series preview bar and the image processing area a tab bar is displayed that contains a study 
tab for each study currently loaded into the viewer.  
 

 
 
Each tab states information about the study to easily identify a study. It contains (if available): 
 
 Patient name 
 Patient date of birth 
 Kind of study (modality information) 
 Study description 
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 Study date 
 
The tab of the currently active study in the image processing area is highlighted in light-blue. 
 
Clicking another study tab will load the study into the image processing area (on dual display systems: image 
processing area of the primary display). If all study tabs do not fit on the screen, use the arrow buttons (  ) 
to navigate. 
 
By default, iQ-VIEW automatically sorts the studies loaded together into the viewer according to the study 
date and time, starting with the most current study and ending with the oldest. The study tabs are listed in the 
same order with the most current study shown on the primary display first.  
 

NOTE: 
For those who would prefer to see the oldest study first and move from the oldest to the newest, the 

application can be configured accordingly. Please consult the iQ-VIEW Administration Guide for detailed 
instructions. 

 
 
4.2.3 THE IMAGE PROCESSING AREA 
 
The image processing area is the main work area of the viewer window in which the loaded images are 
displayed and processed (refer to section 4.2 Viewer). Changes (e.g. windowing, zooming/panning, 
flipping/rotating, etc.) and additions (e.g. measurements and annotations) to images are made in the image 
processing area. 
 
When the viewer is opened with the selected data, the studies are loaded into the image processing area as 
follows: 
 
 One study is loaded on a single display setup  the study is displayed in the image processing area, unless 

the option “automatic loading” is not activated.  
 One study is loaded on a dual display setup  the study is displayed in the image processing area of the 

primary viewer display only (not spread across two displays), unless: 
- the option “automatic tiling” is deactivated and in the previous viewer session a manual tiling was set 

on the primary display that does not fit the number of series in the loaded study (in that case, the 
remaining series will be spread on the available tiling of the second display) 

- a specific hanging protocol is active spreading the series across the two available displays 
 Two or more studies are loaded on a single display setup  the first study is displayed in the image 

processing area; the others can be selected via their study tabs. 
 Two or more studies are loaded on a dual display setup  the first study is displayed on the primary 

display, the second study on the second display; the others can be selected via their study tabs. 
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4.2.3.1 RULER AND ORIENTATION INDICATORS 
 

 

The ruler on the right side of each view indicates the size of the displayed image (also available in 
the Print manager). The measurement is given in centimeters (cm), each segment comprising 1 
cm; the total length being 4 cm. 
 
The ruler is not shown if the “Pixel Spacing” attribute or Ultrasound region calibration information is 
missing in the DICOM header of the image. The ruler can also be deactivated. For instructions, see 
the iQ-VIEW Administration Guide (iQ-View.ini parameter list).  

 

 
Image with orientation indicators 

 
The yellow markers in the images are orientation indicators. These indicators help to determine the orientation 
of an image, e.g. right or left, top or bottom. The indicators will remain in the correct position even if an image 
is flipped or rotated.  Indicators will be denoted as follows: 
 
 R = right 
 L = left 
 H = head  
 F = foot  
 A = anterior 
 P = posterior  
 
Combinations of these indicators are also possible. 
 
 
4.2.3.2 SCREEN TILING OPTIONS 
 
When a study contains more than one series or a series includes several images, it can be helpful to divide the 
image processing areas into several views. Therefore, it is possible to see several series at once or to compare 
series with each other. In addition, a series can be split within one view to display all of its images or to show 
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the individual frames of a multi-frame image. These tiles can be individually selected by clicking them. A blue 
frame is displayed around the selected tile. 
 

 
Screen tiling with series view and tiling on the image level 

 
Screen tiling options are accessible by: 
 
 Using the screen tiling button in the bottom toolbar 
 Selecting the “Tiling” option in the “Tools” menu 
 

 

The screen-tiling function allows splitting the image processing area both on the series level and on 
the image level. On the series level, the image processing area will be divided into the selected 
number of views. On the image level, the active view itself will be divided into segments.  

 
The same tiling options are available on both the series and image levels:  
 
 1x1 
 2x1 
 3x1 
 4x1 

 1x2 
 2x2 
 3x2 
 1x3 

 2x3 
 3x3 
 4x3 
 3x4 

 4x4 
 5x5 

 
When accessing the screen tiling options via the “Tools” menu, the same sub-menu will open for the selection 
of the appropriate tiling. 
 

NOTE: 
When using tiling at the image level, browsing will occur from one image to the next, not from one page (of 
images) to the next page. For example, with a 2x2 image tiling, images 1 through 4 will appear first. When 

browsing forward, images 2 through 5 will appear next, instead of the next “page” of images with images 5 
through 8.  

 
 
4.2.3.3 AUTOMATIC TILING AND LOADING 
 
Automatic tiling and loading options are only configurable in the “Additional settings” menu or by defining 
shortcuts. The settings will be remembered for the next viewer session and with each start of the iQ-VIEW 
application. 
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 “Automatic tiling”: During the loading process of a study, the application counts the number of available 

series and automatically divides the image processing area into the appropriate tiling. To become 
effective, the current study must be reloaded by clicking its study tab; alternatively the viewer itself can be 
restarted. 

 
 “Automatic loading”: The viewer automatically loads the different series of one study into the preset tiling: 

e.g. the first series when working with a 1x1 tiling, two series with a 2x1 or 1x2 tiling. In combination with 
“Automatic tiling” all available series are loaded automatically in the appropriate view. If not activated, 
the image processing area will, at first, remain empty. You will have to load the series manually into the 
views from the series preview bar (by drag and drop or double-click). 

 
 
4.2.4 BOTTOM TOOLBAR 
 
The bottom toolbar offers the opportunity to easily access the most important image processing functions with 
just one click. It can be configured by the user to contain the tools that are needed the most. 
 
Moving the mouse to the bottom of the screen will display the bottom toolbar. The individual functions of the 
buttons are described in the respective sections of this user manual. Some buttons have settings that are 
accessible by right-clicking the button.  
 
When a tool is selected a yellow frame appears around the button to show that it is currently active. In some 
cases the yellow frame can also indicate that an image was modified using a particular function: 
 
 A yellow frame around “Color scheme” means that color scheme changes were made to an image (e.g. 

inverted). 
 A yellow frame around “Flip/Rotate” indicates that an image has been rotated or flipped. Additional 

indicators will be added to the text overlay of the affected image(s) denoting the modification. 
 A yellow frame around “Text overlay” is visible when the text overlay is active. This setting is on by default 

when a study is loaded into the viewer. 
  
 
4.2.4.1 FIXING THE BOTTOM TOOLBAR 
 
Usually the bottom toolbar is hidden to increase the space available for image display in the image 
processing area. It only appears when the mouse is moved to the bottom of the screen. 
 
However, it is also possible to fix the toolbar so that it is constantly visible and does not automatically hide.  
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To fix the bottom toolbar: 
 
 Click the “Additional settings” menu 
 Select “Fixed bottom toolbar” 
 
 
4.2.4.2 THE DEFAULT BOTTOM TOOLBAR 
 
iQ-VIEW comes with a default bottom toolbar containing twelve general image processing tools as well as the 
“Close viewer” button. 
 

 
iQ-VIEW default toolbar 

 
 
4.2.4.3 CONFIGURATION OF THE BOTTOM TOOLBAR 
 
The configuration of the bottom toolbar is possible in two ways: 
 
 Customizing a new default toolbar containing user defined tools that will then be used for each viewer 

session. 
 Configuring modality-dependent toolbars using general Hanging Protocols (only available in iQ-VIEW 

PRO). 
 
For a user-defined toolbar, twelve buttons are configurable at a maximum. It is also possible to delete buttons 
and use less than the maximum number of possible buttons. This might be useful if only a few tools are normally 
accessed by the user.  
 
The “Close viewer” button cannot be exchanged and will remain in the toolbar. 
 
The “Tools selection” screen can be accessed by:  
 
 Clicking the “Additional settings” menu and selecting “Tools selection” 
 Right-clicking an empty area of the bottom toolbar  
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The “Tools selection” dialog opens: 
 

 
Tools selection dialog 

 
In the upper part of the screen all available tools are listed with their respective buttons. In the lower part the 
current toolbar is shown. 
 

 

With this button, tools from the current toolbar can be removed. At least one tool must remain 
configured in the toolbar.  

 

 

With this button, tools from the “Tools selection” window can be added to the current toolbar. If 
less than twelve buttons exist in the current toolbar, the new tools will be added. If all twelve 
positions are already filled, the new selection will replace the button highlighted in red on the 
current toolbar. Be sure to first select the button to exchange on the toolbar before adding the 
new tool.  
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1. Configuring a new default toolbar 
 

 
To change the default toolbar, select the tools to be displayed in the toolbar and then click “Save as 
default”. The new tool bar is immediately applied and will be used each time the viewer is opened. 

 
 
2. Configuring a modality-specific toolbar (Hanging Protocols)  
 
This function is only available in iQ-VIEW PRO. 
 
For the creation of a modality-specific toolbar, first load a study from that modality (e.g. MR) into the viewer. 
Then open the “Tools selection” dialog and configure the tools that should be available in the bottom toolbar 
when a study from the selected modality is loaded into the viewer. After the selection is complete, simply 
close the tools selection window using the “x” in the upper right corner. The new toolbar will be shown. 
 
Next, open the “Hanging protocols” dialog – either from the toolbar (if the “HP” button is configured) or from 
the “Additional settings” menu – and click “Save” in the “General” section of the dialog. 
 

NOTE: 
A toolbar can only be stored for a general, modality-specific HP and not for a specific HP (based on series 

descriptions). When creating a specific hanging protocol in the “Hanging protocols” dialog (section 
“Specific”) while a different toolbar is selected, this new toolbar will be stored in the “General” section of the 

hanging protocol and the previously stored modality-specific toolbar will be overwritten. 

 
 
4.2.5 THE SIDE TOOLBAR 
 
The side toolbar contains additional functions that may be helpful to the user. The buttons in this toolbar are 
fixed and can neither be removed nor configured. To access the toolbar, move the mouse to the left side of 
the screen.  
 
 
4.2.5.1 FIXING THE SIDE TOOLBAR 
 
Usually the side toolbar is hidden to increase the space available for image display in the image processing 
area. It only appears when the mouse is moved to the left side of the screen. 
 
However, it is also possible to fix the toolbar so that it is constantly visible and does not automatically hide. 
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To fix the side toolbar: 
 
 Click the “Additional settings” menu 
 Select “Fixed side toolbar” 
 
 
By moving the mouse to the left border of the screen, the hidden side toolbar will open and offer the following 
functions:  
 
 
4.2.5.2 SYNC 
 

 

“Sync” synchronizes different series at the current position, even if the images of those series have 
a different slice thickness. Activating the button will synchronize all series displayed in the image 
processing area. 

 

All views are included in the synchronization; each view will show a small  icon in the upper right corner to 
indicate its status. To deactivate the function, click the “Off” button at the bottom of the side toolbar (refer to 
section 4.2.5.6 Off). 
 
Synchronizing only selected series: 
 
The synchronization of series is also possible by selecting multiple series in the image processing area. The 
activated (reference) series is the view with blue frame. To select additional series, hold the [CTRL] key down 
while left-clicking other series’ views. A second left-click on a view with the [CTRL] key pressed will deselect a 
series. 
 

The  icon will be displayed for those views included in the synchronization. The mouse wheel or [] and [] 
arrow keys can now be used to scroll through the series in a synchronized way. The currently selected tiling 
scheme determines how many series are allowed to synchronize with the reference series.  
 
It is possible to switch between the reference series and another or work within the images (e.g. adding 
measurements, adjusting the windowing) without losing synchronization. 
 

To exclude a view from being synchronized, either click the  icon within the respective view or left-click the 
view while pressing the [CTRL] key. To deactivate the synchronization entirely, click the “Off” button at the 
bottom of the side toolbar (refer to section 4.2.5.6 Off). 
 
 
4.2.5.3 BIND 
 

 

Using the “Bind” tool, all currently loaded series of one study will be virtually bound together in one 
view. This allows the user to scroll through all series without switching from one view to the next. The 
view will automatically switch to the next series when it reaches the last image in the current series. 
Two common examples would be to easily browse through brainstem and brain tissue as if they 
were one series or to browse through a whole MRI with a lot of sequences. 
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4.2.5.4 SCOPE 
 
The “Scope” (or viewport) function determines whether changes made to an image (e.g. windowing, 
zoom/pan, flip/rotate, etc.) are applied only to the current image or to all images in the series. 
 
The “Scope” sub-menu is accessible by right-clicking the “Scope” button or by hovering over the little black 
corner of the button with the mouse. Once the sub-menu is displayed, select “Series” to apply changes on the 
series level or “Image” to only change individual images. 
 

 
 

 

“Series scope”: Modifications made to the currently active image will be applied to that image as 
well as all other images in the series. This includes modifications such as windowing, zoom/pan, 
flip/rotate, color schemes and image filters. 

 

 

“Image scope”: Modifications made to the currently active image will only be applied to that 
particular image. This includes modifications such as windowing, zoom/pan, flip/rotate, color 
schemes and image filters.  

 

NOTE: 
The scope selected for one series will be used globally for all other series of the same study. If the scope 

selected for one series is changed while processing a different series, the scope-based changes of the first 
processed series will be reset. 

 
If tiling is done at the image level and “Image scope” is used, the image desired for modification may be 
selected by clicking the tile that displays that image. A blue frame will be shown around the selected tile. Now 
image processing functions such as filters or flip/rotate can be applied to the image: 
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4.2.5.5 LINES 
 

 

“Lines” is a scoutpilot function for easier orientation within a study. It is particularly helpful in multi-
slice studies taken from different section planes. When activated, the position of the current slice 
will be displayed in the other series and section planes. 

 

NOTE:  
The application offers additional orientation tools – the scoutpilot and the 3D position display. For information 

about these tools, see section 4.2.19 Orientation tools. 

 

 
Lines display 
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Sometimes the scoutline appears as a rectangle or parallelogram. This happens when the section planes are 
oblique. 
 
The following example shows this clearly: the third series is the reference series (blue frame). Scoutlines are 
applied to series 1 and 2. Since the section plane in series 3 is in a non–orthogonal, oblique relation to the 
other planes, the scoutlines displayed in series 1 and 2 cannot be shown in a line but need to include the 
obliqueness. They are therefore displayed as parallelograms. 
 

 
Lines display including obliqueness 

 
Under certain circumstances, the oblique lines display may complicate the orientation. In this case, it is 
recommended to use the 3D position display (hold the [ALT] key) for better orientation (see section 4.2.19.3 3D 
position display). Alternatively, you may use another scoutlines mode to additionally display the intersection 
lines or to only display the intersection lines and remove the display of the oblique plane projection (refer to 
section 4.2.19.3 3D position display). 
 
In other cases, a frame (sometimes incomplete) is shown around a series that seems to have been acquired in 
exactly the same section as the reference series. 
 
This happens when the field of view and the section alignment are different or if a non-orthogonal cross-
section was used. In this case the section plane is again slightly oblique, leading to this type of lines display. This 
may occur especially in manually planned MRI exams. 
 

 
Lines display with differences in viewport 

 
The application checks to see if the viewports (the field of view plus the section alignment) of the images are 
mostly identical (tolerance limit +/- 5 pixels). If the viewport is within this tolerance limit, no frame will be 
displayed. 
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NOTE: 
For configuration of the scoutlines display (projection mode and line weight), see section 4.2.19 Orientation 

tools. 

 
 
4.2.5.6 OFF 
 

 

The “Off” button turns off the side toolbar functions (Sync, Bind and Lines). 

 
 
4.2.6 THE MENU BAR 
 
The menu bar is divided into different sections: 
 

 
 
 File  
 Tools  
 Additional settings  
 Image filter  
 Image selection  
 Navigation  
 Help  
 
The main tools and functions listed in the menus are also available as toolbar buttons. However, since not all 
tools are available in the bottom toolbar, it may become necessary to use the respective menu item instead. 
Other functions are only accessible using the menus.  
 
The individual functions of menu items are described in the respective sections of this user manual. 
 
Most of the functions in the menus are configurable as viewer shortcuts. For information on how to create 
keyboard shortcuts, please refer to section 4.2.7 Creation of shortcuts for viewer actions. 
 
 
4.2.7 CREATION OF SHORTCUTS FOR VIEWER ACTIONS 
 
For easy access to viewer functions, it is possible to define keyboard shortcuts for specific actions such as 
activating a tool or accessing a dialog.  
 
The shortcuts creation dialog can be accessed by clicking the “Additional settings” menu and selecting 
“Shortcuts” or by pressing the [S] key (default shortcut).  
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The currently available shortcuts are shown on the right while the left side of the screen is used to define new 
shortcuts and modify existing ones.  
 

 
Dialog for adding and modifying shortcuts 

 
To configure a shortcut for a viewer function, first select the desired keyboard key on the left and whether or 
not to use an additional key (i.e. [CTRL] or [ALT]) just beneath it. Then, select the function that the keyboard 
combination should activate from the “Function” list. All functions for which shortcuts can be configured are 
list in the “Function” list. 
 

 

Use the arrow-to-the-right button to add a new shortcut to the list. 

 

 

Use the arrow-to-the-left button to remove an existing shortcut from the list. Before clicking this 
button, be sure to select the shortcut from the “Shortcuts” list on the right. 

 
When all shortcuts have been created, close the shortcuts creation dialog using the “x” in the corner. The 
defined shortcuts are immediately usable. Since shortcuts are stored in a configuration file, they will be 
available the next time iQ-VIEW is restarted. 
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NOTE: 
Every key combination can only be used once. If the same key combination is chosen again to access 

another function, the setting will not be added. In this case, please select another (free) key combination. 

 
 
4.2.8 CLOSING THE VIEWER AND RETURNING TO THE STUDY BROWSER 
 
4.2.8.1 CLOSING THE VIEWER 
 
The viewer window can be closed in three different ways: 
 
 Click the “x” button in the upper right corner of the window 
 Select the “Close viewer” button on the left side of the bottom toolbar 
 Click the “File” menu and select “Close viewer” 
 

 

“Close viewer”: Closes the viewer window and returns to the study browser (if placed on the same 
display).  
 

 
 
4.2.8.2 BRINGING THE STUDY BROWSER TO THE FRONT 
 
To return to the study browser it is not necessary to close the viewer. Both applications can run simultaneously 
and the study browser can be brought to the front without specifically closing the viewer.  
 
This is possible if the viewer and study browser are placed on different displays or if, on a single display, the 
study browser window is smaller than the viewer window (no full-screen). New studies can be selected from 
the study list and will automatically load into the viewer window. 
 

NOTE: 
For available options and instructions on how to configure the viewer and the study browser windows on 

different displays, please refer to the iQ-VIEW Administration Guide. 

 
Another method is to click the “File” menu and select “Bring Study Browser to front”. This moves the study 
browser from the background to the front and places the viewer into the background.  
 

 
 
Alternatively, the Windows task bar can be used to switch from the viewer window tab to the study browser 
tab and back again. 
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4.2.9 DISPLAY SETTINGS 
 
The viewer application can be run on a single or dual display system.  
 

 
 
 
4.2.9.1 SETTING UP THE VIEWER ACROSS TWO DISPLAYS 
 
By default, the viewer opens only on one display. If two displays are available and they are connected to the 
computer, the viewer can be set up to view across both displays. To configure the viewer to use dual monitors: 
 
 Make sure that the viewer window is not maximized (no full screen). 
 Click the “Additional settings” menu and select “Display setup”. 
 Select “Dual” from the sub-menu. 
 The viewer window will automatically resize to fit the two screens. In the rare case that this does not 

happen automatically, simply drag the window across the two screens by grabbing the window frame 
with the mouse. Adjust the position and the size of the viewer window, if necessary. 

 Afterwards close iQ-VIEW and restart the application. The placement of the viewer will be stored in iQ-
VIEW’s main configuration file and will be remembered when the application is restarted. 

 

 
Two studies loaded in a dual display setup 

 

NOTE: 
For available options and instructions on how to configure the viewer and the study browser windows on 

different displays, please refer to the iQ-VIEW Administration Guide. 
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4.2.9.2 SETTING UP THE VIEWER WITH IMAGE DISPLAYS 
 
While IMAGE DISPLAYS can be used with both iQ-VIEW and iQ-VIEW PRO, only using the PRO version in 
combination with IMAGE DISPLAYS PRO offers the possibility to display images in the true 12 bit grayscale 
mode.  
 
To open the IMAGE DISPLAYS configuration window, click the “Additional settings” menu, select “Display 
setup” and then “IMAGE DISPLAYS setup”. This option is only available if IMAGE DISPLAYS are connected to the 
system. 
 

NOTE: 
For details on how to correctly configure IMAGE DISPLAYS, please consult the IMAGE DISPLAYS user 

documentation which is provided with the display hardware. 

 
By default, iQ-VIEW will deactivate the IMAGE DISPLAYS if they are idle for a period of ten minutes. Idle, in this 
case, means that there is no mouse or keyboard activity in the viewer window. As soon as there is new activity 
in the window or new studies are loaded from the study browser into the viewer, the displays will be activated 
again.  
 
The time period after which the displays will be deactivated can be set individually in the iQ-VIEW main 
configuration file. For details, please see the iQ-VIEW Administration Guide. 
 
 
4.2.10 THE LIGHTBOX WINDOW 
 

In more and more imaging centers the traditional lightbox, where the radiologist is able to hang images on 
film, can no longer be found. However, there are still various instances where the radiologist is forced to look at 
images on film. This puts the radiologist in the position of needing a lightbox but not having one handy near his 
or her workstation.  

 

 

iQ-VIEW offers the “Lightbox window”  – a white screen that can be put anywhere on the avail-
able displays and can function as a replacement of the traditional lightbox. This way, the 
radiologist is able to more easily compare studies on film with those available as softcopy on the 
iQ-VIEW viewer. 

 

WARNING: 
Please note that the lightbox window function offered in iQ-VIEW does not correspond with a radiological film 

viewing box. It may, therefore, only be permitted for diagnostic use if all applicable legal requirements 
regarding diagnostic film viewing in your country are met. Please consult your authorized local distributor 

before using this function for diagnostic purposes. 

 
The lightbox function can be accessed by: 
 
 Clicking “Lightbox window” in the “Additional settings” menu 
 Using the “Lightbox window” toolbar button that can be found in the “Tools selection” dialog and can be 

placed into the bottom toolbar 
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 Using either the default shortcut [L] or an own customized shortcut (see section 4.2.7 Creation of shortcuts 
for viewer actions for further details) 

 

 
 

 
“Lightbox window” as full screen on second display 

 
While the lightbox window is open, the viewer is fully accessible and all image processing functions can be 
used. 
 
The size and position of the window can be configured freely:  
 
 Left-click into the white field to access the window status functions. 
 You can then set the window into full-screen mode, move it to another position on the display(s) (by 

clicking the title bar and dragging it with the mouse) and change the window size (by adjusting the 
window frame with the mouse). 

 

     
 
The size and position of the lightbox window will be remembered and used again the next time this function is 
used. 
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To close the lightbox window, use one of the following ways: 
 
 Right-click into the window 
 Use the default shortcut [L] or your own customized shortcut (see section 4.2.7 Creation of shortcuts for 

viewer actions for further details) 
 Use the [ESC] key (“escape”) 
 Left-click into the window and then use the “x” button in the title bar 
 
 
4.2.11 TREATMENT OF SINGLE-FRAME AND MULTI-FRAME IMAGES 
 
Multi-frame and single-frame DICOM images are treated equally. The stack and cine mode functions work for 
both; series of both can be shown in a sequence. It is also possible to display the individual frames of a multi-
frame image (sequence) in different tiles, to select specific frames and to export or print them. 
 
 
4.2.12 NAVIGATING BETWEEN IMAGES, SERIES, STUDIES AND HANGING 

PROTOCOLS 
 
The viewer offers a variety of ways to navigate between different images, series and studies loaded into the 
viewer. They can be accessed using the “Navigation” menu.  
 
In iQ-VIEW PRO it is also possible to switch between different available hanging protocols if more than one 
specific HP has been configured for a particular study (HP sequence). 
 
The most important navigation options are available both as a menu item and as a toolbar button. Some 
options, however, can only be accessed using the “Navigation” menu. Shortcuts can also be defined for 
navigation. 
 
 
4.2.12.1 THE “NAVIGATION” MENU 
 
The options in the “Navigation” menu may be used to navigate within a series, study or all studies loaded in 
the viewer and within a hanging protocol sequence. In addition, either the next or previous patient study from 
the current study list (in the study browser) can be loaded into the viewer. 
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Navigation within a series:  
 
 “Next image”: opens the next image in the series of the currently active tile. 
 “Previous image”: opens the previous image of the series in the currently active tile. 
 “Next multi-frame object in series”: used for series consisting of several multi-frame objects. Instead of 

switching from one frame to the next, “next multi-frame object in series” will jump to the next object in the 
series, independent of the number of frames in the current object. If single-frame objects (= images) are 
included in the series, they will be considered an object as well. 

 “Previous multi-frame object in series”: used for series consisting of several multi-frame objects. Instead of 
switching from one frame to the previous, “previous multi-frame object in series” will jump to the previous 
object in the series, independent of the number of frames in the current object. If single-frame objects (= 
images) are included in the series, they will be considered an object as well. 

 “First image in series”: opens the first image of a series in the currently active tile. 
 “Last image in series”: opens the last image of a series in the currently active tile. 
 
Navigation within a study:  
 
 “Next series”: opens the next series in a study in the currently active tile. 
 “Previous series”: opens the previous series in a study in the currently active tile. 
 “First series in study”: opens the first series in a study in the currently active tile. 
 “Last series in study”: opens the last series in a study in the currently active tile. 
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Navigation within studies:  
 
 “Next study”: opens the next study in the currently active tile (if more than one study is loaded into the 

viewer). 
 “Previous study”: opens the previous study in the currently active tile (if more than one study is loaded into 

the viewer). 
 “Next study in study list”: loads the next study from the current study list (in the study browser) into the 

viewer. 
 “Previous study in study list”: loads the previous study from the current study list (in the study browser) into 

the viewer. 
 
Navigation within a hanging protocol sequence:  
 
 “Next hanging protocol”: opens the next hanging protocol of a HP sequence. 
 “Previous hanging protocol”: opens the previous hanging protocol of a HP sequence. 
 
All these navigation options can be configured as viewer shortcuts. 
 
 
4.2.12.2 NAVIGATION WITH TOOL BUTTONS 
 
The following navigation options are available in the “Tools selection” and can be added to the bottom 
toolbar: 
 

 

“Next image”: opens the next image in the series in the currently active tile (blue frame). 

 

 

“Previous image”: opens the previous image in the series in the currently active tile. 

 

 

“Next series”: opens the next series in a study in the currently active tile. 

 

 

“Previous series”: opens the previous series in a study in the currently active tile. 

 

 

“Next study in study list”: loads the next study from the current study list (in the study browser) into 
the viewer. 

 

 

“Previous study in study list”: loads the previous study from the current study list (in the study 
browser) into the viewer. 
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If several specific hanging protocols have been defined, the button will show a little black corner. 
By hovering over the corner or by right-clicking the button, a sub-menu pops up and displays all 
available hanging protocols. The needed HP can then be accessed. 

 
 
4.2.13 SELECTING INDIVIDUAL SERIES FOR VIEWING 
 
In the viewer, individual series can be selected from the thumbnails in the series preview bar. Either double-
click a thumbnail to put the series into the currently active view (blue frame) or use drag and drop to transfer 
the series into an available view of the image processing area. By right-clicking a thumbnail, a list of all loaded 
series will pop up (series pop-up list), where the series can be selected by description. The series preview also 
indicates the number of images that are included in each of the series. 
 
For details, see section 4.2.1 The series preview bar and particularly 4.2.1.4 Using the series pop-up list. 
 
 
4.2.14 COMPARISON OF STUDIES 
 
When more than one study is loaded into the viewer, a switch can be made between the available studies by 
clicking another study tab. The images from the new study will load into the image processing area.  
 

 
 
If, however, comparisons are to be made between several series in different studies, it is necessary to keep the 
current series in the image processing area and only to add the desired series from another study.  
 

To accomplish this, select the  sign in the series preview bar to open the preview bar of the second study. If 
more than two studies are loaded, a sub-menu will pop up so the appropriate study can be selected. The 
second series preview bar will show the series thumbnails of the additional study. The series needed can now 
be dragged into the appropriate view in the image processing area. Alternatively, double-clicking the series 
will load it into the currently active view. This is an easy way to manage the comparison of studies. 
 

NOTE: 
On dual display systems with two studies loaded, one will open on the primary display while the other will 

automatically display on the second screen. This makes it even easier to compare different studies with each 
other. 

 
As an example, to compare two studies in a 2x1 mode, use the screen tiling function located either in the 
bottom toolbar or in the “Tools” menu and select the option 2x1 on the series level. (For more information, see 
section 4.2.3.2 Screen tiling options.) The views in the image processing area will display the first study. Place 
the series to compare into the left view. To add the second study to the right view, open the second series 

preview bar by using the  button in the series preview bar and select the correct study (if more than one is 
available). This will display the series thumbnails of the second study but does not change the display in the 
image processing area. Now drag and drop the desired series into the right view. 
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4.2.15 SEARCHING FOR PREVIOUS STUDIES OF THE SAME PATIENT ON REMOTE 
ARCHIVES 

 
Sometimes when viewing and evaluating a current study, it may be necessary to compare it to previous 
exams of the same patient, for example, to examine the course of a disease. These previous studies are usually 
not available locally and have to be retrieved from the central archive, the PACS. 
 
To query for previous studies of the same patient, click the magnifying glass button in the series preview bar. A 
sub-menu with all connected remote archives will open. Selecting one of the listed DICOM nodes will start a 
query for more examinations of the same patient loaded in the viewer. The search for existing studies is based 
on the patient ID and the resulting list will show all studies that match that ID.  
 

 
Querying a remote archive for previous studies of the loaded patient 

 
This is an easy and fast way to find previous studies. 
 
If there are studies available for this patient on the remote archive that are of a newer date than the one 
currently loaded in the viewer, those studies are marked in blue. 
 

NOTE: 
This function is only available in the first series preview bar. Therefore, the study used for searching for previous 

exams must be loaded in that bar (on the primary display for dual display systems). 

 

 

Alternatively, it is also possible to search for other studies of the 
same patient (with the same patient ID) in the local imagebox using 
the magnifying glass button in the series preview bar. This function 
must be activated in the main configuration file of iQ-VIEW. Please 
refer to the iQ-VIEW Administration Guide for further details. 
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4.2.16 SELECTION OF IMAGES, SERIES AND STUDIES 
 
When images, series or studies are to be exported to another image format (e.g. JPEG, BMP or TIFF), a video 
file (AVI) or a Windows® printer, it is sometimes necessary to first mark these images for export. This is the case 
when the following types of files are to be exported: 
 
 Only specific images (either from one or several series) 
 Several, but not all, series of a study 
 Data from different studies  

 
Individual images can be marked or unmarked by clicking the box in the upper right corner of each view. 
When an image is marked, the box will turn red. Further selection options are available in the “Image 
selection” menu: 
 

 

 
 
Using the “Image selection” menu it is possible to mark images on a series or study level. Options include: 
 
 Select a whole study or series 
 Select every second image of a study or series 
 Select every third image of a study or series 
 Select every fourth image of a study or series  
 
It is further possible to mark the currently active image (“Select active image”) and to “Clear current 
selection” to reset all selections.  
 
Shortcuts can also be used for the selection of images, series or studies. For information on how to create 
shortcuts, see section 4.2.7 Creation of shortcuts for viewer actions. 
 
 
4.2.17 MARKING STUDIES AS READ 
 
Studies can be marked as read, not only in the study browser, but also directly in the viewer. A “Marked as 
read” button is configurable for the bottom toolbar and can be found in the “Tools selection” dialog. See 
section 4.2.4.3 Configuration of the bottom toolbar for more information on how to add this button. 
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“Marked as read”: If activated, the currently displayed study is marked as read. The status is also 
shown in the study browser. To unmark the study, click the button a second time. If a yellow frame 
is displayed around the button, the study is marked. 

 
 
4.2.18 SORTING IMAGES 
 
In specific cases it can be helpful to change the order of the images in a series. An example of this would be if 
you want to compare two multi-slice series (CT or MRI) where one was started at the head and the other at 
the toe. For easier comparison, the image order of one series could be changed to fit the order of the second 
series. In the case of angiography images, it is sometimes better to arrange the images with reference to the 
image time instead of the image number.  
 
iQ-VIEW offers different image sorting options for temporarily changing the order in which the images of a 
series are displayed. This function is accessible by: 
 
 Clicking “Image sort order” in the “Additional settings” menu 
 Using the “Sorting images” toolbar button  
 

 
 

 

“Sorting images”: Sorting always works on the series level. Changing the sort order of one series 
does not affect the image order of another series or study. Images can be sorted in both 
ascending or descending order by: 
 
 Instance number (Instance number ascending is the iQ-VIEW default)  
 Instance time  
 Slice position  

 
When the viewer is reopened the series sort order will automatically return to “Instance number (ascending)” 
as the default setting.  
 
To make an image sort order permanent (set as default), select the desired sort order and click “Take over as 
default” available only in the “Additional settings” menu. 
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4.2.19 ORIENTATION TOOLS 
 
Especially in multi-slice studies, such as CT or MRI exams orientation within the different section planes can be 
difficult. This is where orientation tools such as scoutpilots and lines displays can be helpful. iQ-VIEW offers 
several orientation tools to aid the users. 
 
 
4.2.19.1 “LINES” MODE 
 
The “Lines” mode in the side bar (hidden on the left side of the screen) is essentially a scoutpilot function that 
simplifies the orientation in a study by displaying the position of the current slice (active frame) within the other 
series and section planes. It is particularly helpful in multi-slice studies taken from different section planes.  Lines 
can be activated easily without having additional windows open which may impede the view in the image 
processing area. 
 

NOTE: 
For further details, please refer to section 4.2.5.5 Lines. 

 
 
4.2.19.2 SCOUTPILOT 
 
The scoutpilot tool is a position indicator that provides the user with positional information about images. This 
function allows users to orient themselves within a series. 
 
The “Scoutpilot” function is found in the “Tools” menu. Alternatively, the scoutpilot may be accessed by a pre-
defined keyboard shortcut. For details on how to configure shortcuts, see section 4.2.7 Creation of shortcuts for 
viewer actions. 
 

 
Scoutpilot example 
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The scoutpilot window can be moved to another position so that it does not hide the necessary views of the 
image processing area. Simply drag and drop the window to the desired position. The size of this window, 
however, is fixed. 
 
When opened, the scoutpilot always shows the currently active image (blue frame). 
 
The image in the scoutpilot can be manipulated in the following ways: 
 
 Using the center mouse-button (or scroll wheel), it is possible to change the window level. 
 By pointing to the border of the image (the zoom zone), the mouse pointer turns into a magnifier and 

allows zooming within the image. While the mouse is a magnifier, hold the left mouse button down and 
move the mouse up and down to zoom in and out, respectively. 

 While pointing in the center of the image (the pan zone), the mouse pointer turns into a hand. Hold the left 
mouse button down and move the mouse to pan the image. 

 

 
“Refresh”: This button can be used to reset windowing, zoom and pan changes made in the image or 
to select a new image as the reference image. To select a new image as the reference image, start by 
scrolling the view in the image processing area down to the image you want to use as reference. It 
must be the active image (blue frame). Then, click the scoutpilot’s refresh button to update the 
reference image.  

 

 
“Close”: Closes the scoutpilot window. 

 
 
4.2.19.3 3D POSITION DISPLAY 
 
In multi-series CT and MRI with different section planes, it may be useful to see where a specific region in one 
series is located in the other series. This function can also be seen as an extension to the regular “Lines” mode.  
 

NOTE: 
For additional information on why and when it is recommended to use the 3D position display, see section 

4.2.5.5 Lines. 

 
To use the 3D position display, hold the [ALT] key while moving the mouse to the desired region in one series. 
The corresponding region in the other views will be denoted with a yellow cross while giving a distance 
indicator in millimeters. 
 
Alternatively, the “3D position display” button can be added to the bottom toolbar from the “Tool selection” 
dialog. See section 4.2.4.3 Configuration of the bottom toolbar for more information on how to add this button. 
 

 

“3D position display”: If activated, the 3D cursor is immediately visible. Moving the mouse over an 
image will mark the corresponding region in the other views. 

 

NOTE:  
While the “Additional settings” menu lists an option for “3D position display (press ALT key)”, the entry is for 

information purposes only. Selecting the entry in the menu will not activate the 3D position display.   
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3D position display 

 
 
4.2.19.4 SCOUTLINES CONFIGURATION 
 
By default, iQ-VIEW projects the section planes in its “Lines” and “Scoutpilot” display, leading to the display of 
rectangles or parallelograms – if the section planes are oblique. It is also possible to modify the display settings 
by: 
 
 Adapting the projection mode 
 Adapting the line weight 
 
The “Scoutlines configuration” is found in the “Additional settings” menu. Alternatively the options could be 
called up with pre-defined keyboard shortcuts. For details on how to configure shortcuts, see section 4.2.7 
Creation of shortcuts for viewer actions. 
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Different projection modes are available for both the “Lines” mode and the “Scoutpilot” window: 
 
 “Mode: plane projection”: This is the default setting. If activated, the scoutlines functions will display only 

the projection of the section planes. 
 “Mode: plane intersection”: If activated, the scoutlines functions will display only the lines where the 

section planes cut (intersect) each other. 
 “Mode: plane projection and intersection”: If activated, the scoutlines functions will display both the 

projection of the section planes and the intersection lines. 
 
The line weight may be changed to adapt to a higher or lower display resolution. For high-resolution displays it 
may be more comfortable to use bolder lines. The following options are available: 
 
 “Line weight 1 (light)” 
 “Line weight 2 (medium)”; this is the default setting 
 “Line weight 3 (strong)” 
 “Line weight 4 (bold)” 
 
Any settings change will be remembered for the next viewer session or restart of the application. Therefore, it is 
not necessary to apply the changes each time the scoutlines display is used. 
 
 
4.2.20 PRESENTATION STATES IN iQ-VIEW 
 
Presentation states (PR) are independent DICOM SOP instances containing information on how a particular 
image should be displayed. The presentation state may contain, for instance, windowing, zooming and 
panning values, information about rotation or flipping and other visual display elements defined in the DICOM 
standard. What presentation states do not contain is pixel data. Therefore, PR can only be used in 
combination with an existing DICOM image.  
 
When a presentation state is applied to an image, the image is then displayed with all the visual specifications 
defined in that presentation state. The advantage of using presentation states is that it is always possible to 
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revert back to the original image since the underlying pixel data of the image is not modified, but rather 
displayed differently.  
 
 
4.2.20.1 USE OF PRESENTATION STATES IN iQ-VIEW 
 
It is important to note that iQ-VIEW does only support its own presentation states. While studies retrieved from 
other DICOM stations may already contain their own presentation states, iQ-VIEW will not be able to make use 
of these presentation states. Due to iQ-VIEW displaying the original image pixel data, this may result in a 
different display of the images than on a station that supports these PR. 
 
When retrieving images with included PR objects from a remote station, iQ-VIEW will accept these PR files and 
store them locally. However, they will not be registered in the database and will neither be used when the 
study is loaded into the viewer nor be selected for export, e.g. to patient CD/DVD. 
 
iQ-VIEW is only able to display presentation states that were originally created with iQ-VIEW. 
 
Modifications made to an image (e.g. window level changes, zooming/panning, flipping/rotating and adding 
of measurements and annotations) will be treated as a presentation state. This makes it possible to switch 
between different series or studies in the viewer without losing the changes, to transfer images including these 
modifications to printers or to export them to other file formats. 
 
With iQ-VIEW PRO, it is also possible to store these presentation states as files and send them to a remote 
archive. This allows using the presentation states again when the images are loaded into the viewer anew. The 
loading can be done from the local imagebox or after retrieve from the remote archive where the images are 
stored together with the PR. 
 
In iQ-VIEW, however, the presentation states are only cached for the current viewer session. They are deleted 
when the viewer is closed and the images are loaded again. When reopened, the images will be displayed 
with their original pixel data. 
 

NOTE: 
Due to the use of presentation states in iQ-VIEW the handling of some image processing features, such as 
zooming and panning, have slightly changed compared to earlier iQ-VIEW versions (up to version 2.5.0c). 

These adaptations were necessary to adhere to the specifications laid down in the DICOM standard.  

 
 
4.2.20.2 STORING PRESENTATION STATES 
 
This feature is only available in iQ-VIEW PRO. 
 
Presentation states can be saved by clicking “Store presentation states” in the “Tools” menu or using the “Store 
presentation states” toolbar button. 
 

 

“Store presentation states”: It is possible to save all changes or only specific changes made to the 
images in the viewer. The following options are available: 
 
 “Store measurements only”: Saves only the drawn measurements and added annotations.  
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 “Store field of view only”: Saves only the zoom and pan changes.  
 “Store window only”: Stores only the window level changes (including color remapping).  
 “Store flip and rotation only”: Saves the flipping and rotation settings of images.  
 “Store all changes”: Saves all changes affecting a presentation state (measurements and 

annotations, windowing, zoom/pan, flipping/rotating, color remap).  
 
All respective changes made in the currently loaded study or studies are stored as presentation states and will 
be applied again when the studies are reopened in the viewer. 
 

 
 
If more than one type of presentation state should be saved for a study, the sub-menu entries for each state 
should be selected, one after the other (for example, storing measurements and storing windowing). 
 
The saved changes are then stored in presentation state files in the folder of the respective study. The changes 
will be applied the next time the study is loaded into the viewer.  
 
To change the stored presentation states, make the appropriate modifications in the images and then use 
“Store presentation states” to overwrite the previous settings. The presentation state files will automatically be 
updated. 
 
 
4.2.20.3 CLEARING PRESENTATION STATES 
 
It is possible to remove changes made to an image (e.g. windowing, zoom/pan, flip/rotate, etc.). These 
presentation states can be deleted using the “Reset” button in the bottom toolbar or by choosing “Reset 
current view” in the “Tools” menu as long as the presentation state has not been stored (PRO ONLY). 
Alternatively, “Clear presentation states” in the “Tools” menu can also be used.  
 
A reset will also delete measurements and annotations made in the images. Additionally, these can be 
deleted manually or by using the “Tools” menu. For more details on the treatment of measurements, please 
see section 4.2.25 Measurement, calibration and annotation tool. 
 
For stored presentation states (only iQ-VIEW PRO):  
 
If the presentation states have been stored, clearing the changes using the above methods will only result in a 
temporary deletion. The next time the study is opened the stored presentation states will be applied again. To 
permanently delete the changes stored in the presentation states, clear them and then “Store all changes” 
(see above).  
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4.2.20.4 SENDING AND RETRIEVING PRESENTATION STATES 
 
Presentation states created and stored in iQ-VIEW PRO can be sent to a PACS and retrieved when required. A 
prerequisite is that the PACS must support the presentation states SOP classes. 
 
Presentation state objects can be sent to a remote archive in two ways: 
 
 Automatically: If a study has been queried and loaded directly from a connected remote archive 

(“Network” table) into the viewer, the images contained in this study have been modified and all or some 
of these changes have been stored as presentation states, when the viewer is closed or switched to 
another study, a pop-up window will ask if the newly created and stored presentation state files should be 
sent back to the source remote archive. When the question is confirmed, the PR files will be sent via 
DICOM to the remote archive to be stored together with the original images. 

 

NOTE: 
If user-created DICOM objects, such as presentation states, should never be sent directly back to the remote 

archive, deactivate the pop-up question. For details, please consult the iQ-VIEW Administration Guide. 

 
 Manually: When  a locally available study (either from “Database” or “Filesystem”) has been loaded into 

the viewer, there is no remote archive that iQ-VIEW PRO can send the presentation files to automatically. 
Therefore, you will have to manually select where to send the user-created DICOM objects. 
 

 

To do that, first add the tool “Send to destination”, which can be found in the “Tools 
selection” window, to your bottom toolbar. If this will be a regularly used tool, add the tool 
button to the default toolbar (save the new tools selection with “Save as default”). For further 
details, see section 4.2.4.3 Configuration of the bottom toolbar. 

 
To send the created and stored presentation state files to a remote archive, click the “Send to 
destination” button and select “Send user-created objects” from the sub-menu. A list with all available 
remote archives pops up. Select the one where the presentation states should be sent. The transfer starts 
immediately. 
 

NOTE: 
Since presentation states do not contain pixel data and can only be used in combination with the image for 
which they were created, it does not make sense to send them to an archive where the original images do 

not exist. They can be stored there, but when retrieved, they are useless unless the images are also retrieved. 
If you are unsure if the images are already stored on the remote archive, it might be better to send the 

complete study to the remote archive. This can be done from the study browser (see section 4.1.10 Transfer). 
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4.2.21 OVERLAYS AND LOOK-UP TABLES 
 

 
 
 
4.2.21.1 TEXT OVERLAY 
 
The text overlay provides patient, study and series information necessary to identify images displayed in the 
image processing area. It is activated by default when images are loaded into the viewer. This is done to 
insure that important information, such as lossy image compression, is always recognized by the user. 
 
The text overlay can be activated and deactivated both from the button in the bottom toolbar and from the 
“Text overlay” entry in the “Tools” menu.  
 

 

“Text overlay”: Is used to hide the text overlay information that is activated by default. Clicking this 
button will toggle between activating and deactivating the text overlay. 

 

NOTE: 
If a general (modality-specific) hanging protocol (only available in iQ-VIEW PRO) that deactivates the text 

overlay was created and stored, studies from that modality will not show the text overlay when loaded into the 
viewer. In that case, be sure to verify that the images are available in diagnostic quality. 

 
If necessary, the text overlay for specific modalities can be modified, e.g. to add information that is not 
displayed by default, such as information about contrast agents that have been administered. For instructions 
regarding the modification of an overlay script, please consult the iQ-VIEW Administration Guide. 
 
 
4.2.21.2 DISPLAY OF LOSSY IMAGE COMPRESSION 
 
If an image displayed in the image processing area has been lossy compressed, this information will be shown 
in the text overlay, provided that the necessary details were correctly stored in the image information. 
Compression information will only display if the text overlay is activated.  
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Complete compression information of an image is shown in the DICOM header dump. See also section 4.2.38 
DICOM header information for more information. 
 

 
 

WARNING:  
Lossy compressed images may have no diagnostic quality!  

 
 
4.2.21.3 BITMAP OVERLAY 
 
By default, “Bitmap overlay” display is enabled. If activated, a potential bitmap overlay in an image is 
displayed. If the bitmap overlay is not needed, simply deactivate this function. It functions independently from 
the text overlay.  
 
This function can only be accessed by clicking “Bitmap overlay” in the “Tools” menu. 
 
 
4.2.21.4 LOOK-UP TABLES 
 
By default, “Look-up tables” display is enabled. iQ-VIEW is able to interpret potentially embedded look-up 
tables in order to display a DICOM image the way it is displayed on the source machine (another form of 
center/window information).  
 
This function can only be accessed by clicking “Look-up tables” in the “Tools” menu. 
 
 
4.2.21.5 DICOM-EMBEDDED SHUTTERS 
 
Shutters created with the viewer’s shutter tool are handled as presentation states. However, shutters can also 
be embedded within the DICOM header of an image and are, therefore, handled differently. This may be the 
case with shutters created in images in the iQ-VIEW “Import” dialog or with images to which shutters were 
already applied at the modality. 
 
By default, “Embedded shutters” display is enabled. iQ-VIEW is then able to interpret potentially embedded 
shutter sequences in order to hide a specific part of a DICOM image. If the function is disabled, the entire 
image will become visible again.  
 
This function can only be accessed by clicking “Embedded shutters” in the “Tools” menu. 
 
 
4.2.22 CINE AND STACK MODE 
 
Stack and cine mode make it possible to manually or automatically browse through all images of a series (or 
even the complete study when used in combination with the “Bind” mode; see section 4.2.5.3 Bind). 
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Both the stack and the cine modes are available by using the respective toolbar buttons in the bottom toolbar 
or the “Stack mode” and “Cine mode” entries in the “Tools” menu. 
 

 
 
 
4.2.22.1 STACK MODE 
 

 

“Stack mode” is always activated by default and can be used even if other processing functions 
are activated. Browsing images with stack mode is possible in different ways. 

 
With the following options, one image after another of the series will be displayed, which is useful when 
wanting to browse all the images of the series: 
 
 Use the mouse scroll-wheel to move through a series. (This function is not available if “scroll zoom” is 

activated.) 
 Use the up and down arrow keys on the keyboard to scroll to the next or previous images. 
 
With the following options, images of the series will be skipped to move faster from one position in the series to 
another. This can be useful if you wish to go to a particular area quickly: 
 
 Select the “Cine mode (stack)” button in the tool bar or the “Stack mode” function in the “Tools” menu. 

Then move the mouse up and down while keeping the left mouse button pressed to browse through a 
series. 

 Use the scrollbar to the right of every view to scroll through a series of images by pulling the controller up 
and down.  

 
For more navigation options see section 4.2.12 Navigating between images, series, studies and hanging 
protocols. 
 
 
4.2.22.2 CINE MODE 
 

 

With DICOM multi-frame images (e.g. angiographic or ultrasound images) as well as single-frame 
images (e.g. CT, MR), the series can be run automatically as a sequence. Either right-click the 
“Cine mode” button in the bottom toolbar or select “Cine mode” from the “Tools” menu to access 
the cine mode sub-menu. 

 

 
“Start autoplay”: Cine mode will begin playing automatically. A separate cine mode player (cine 
control) opens to control the cine playing. 
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“Pause autoplay”: The pause button temporarily suspends the cine play. A second click restarts the cine 
play from where it was paused. 

 

 
“Stop autoplay”: The stop button stops the cine play and closes the cine control. 

 

 
 

NOTE: 
iQ-VIEW can display up to 50 frames per second. The actual speed that can be reached when displaying 

images in a cine loop depends on the system resources. If the “Frm/s” display turns red, the requested speed 
cannot be reached due to system limitations. A limited text overlay will be shown during the cine run to save 

resources. 

 
The “Cine control” can be moved to a different part of the screen by clicking anywhere in the gray area of 
the control and dragging it to another position.  
 
Further settings: 
 
 “Direction”: The cine can either be played “Forwards” or “Backwards”. Select the respective entry from 

the sub-menu or move the controller in the cine control either to the right (including the correct frame 
rate) for forwards playing or to the left (including the correct frame rate) for backwards playing. 

 “Frame rate”: Using the entry in the cine mode sub-menu several pre-defined frame rates can be selected 
for the cine run (6, 12, 24, 32 fps = frames per second).  The default frame rate is defined in the DICOM 
header for multi-frame images or is 25 fps for single-frame images.  

 
The direction and the frame rate can also be adjusted in the cine control itself by moving the indicator bar 
while the cine is running. 
 
 
4.2.23 WINDOWING TOOLS 
 
In many cases, the brightness and contrast for the DICOM images are already well-set when the images are 
created at the modalities. Sometimes, however, it might be necessary to change the window level of images, 
e.g. when the series is too dark or the contrast is not good enough to see specific tissues. 
 
iQ-VIEW offers four ways of changing the center/window level of DICOM images: 
 
 Dynamic windowing 
 Static windowing 
 The use of window presets 
 A fine-tuning windowing mode 
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NOTE:  
It is possible to configure an inverse mouse windowing by making the appropriate change in the iQ-VIEW main 

configuration file. Please consult the iQ-VIEW Administration Guide for further information. 

 
 
4.2.23.1 APPLYING WINDOW CHANGES 
 
Using the “Scope” function, described in section 4.2.5.4 Scope, it is possible to apply window changes to a 
whole series or to an individual image only: 
 
 Select “Image scope” to only change the center/window values of a particular image. 
 Select “Series scope” to apply windowing changes made in one image to all images of the same series. 
 

NOTE: 
Window changes made will be reset when the scope is changed (from series to image or from image to 

series). Windowing can then be applied again according to the newly selected scope. 

 
 
4.2.23.2 DYNAMIC WINDOWING 
 
Dynamic windowing is the default form of window leveling in iQ-VIEW. When windowing within a series, 
dynamic windowing calculates the changes in the center/window values based on the original 
center/window values as they are stated in the DICOM information of each image. As a consequence, all 
images of a particular series may have different center/window values. This most often occurs in MR series 
where the contrast and brightness vary from image to image.  
 
Example: One image has original W/C values of 700/300 and a second has original values of 730/310.  If the 
window value of the first image is increased by 15 and the center value is decreased by 15 (new: 715/285), 
then the values of the second image will also be increased (window) and decreased (center) by 15 (new: 
745/295). 
 

 

Since dynamic windowing is on by default in iQ-VIEW, this function is easily accessed in different 
ways: 
 
 While pointing to an image, click the center mouse-button (scroll-wheel) and move the mouse 

up/down and left/right. This option is also available if other tools are currently selected. 
 Select the “Windowing (dynamic)” button in the bottom toolbar. While pointing to the image, 

click the left mouse button and move the mouse up/down and left/right. 
 Click the “Tools” menu and select “Windowing.” While pointing to the image, click the left 

mouse button and move the mouse up/down and left/right. 
 
When the windowing function is activated using the toolbar button or the menu item, the shape of the mouse 
pointer will change to indicate the use of windowing. 
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4.2.23.3 STATIC WINDOWING 
 
Static windowing is another form of window leveling offered in iQ-VIEW. With static windowing, the 
center/window values set in one image are set exactly the same in all other images of the same series.  
 
Example: One image has original W/C values of 700/300 and a second has original values of 730/310. If the 
window value of the first image is increased by 15 and the center value is decreased by 15 (new: 715/285), the 
values of the second image will also be 715/285, independent of their original center/window values. 
 

NOTE: 
Be careful as this may reduce the viewing quality of an image for which the center/window values of another 

image may not be advantageous.  

 

 

Static windowing can only be accessed by placing the “Windowing (static)” toolbar button into 
the bottom toolbar. The windowing itself is then done by moving the mouse up/down and 
left/right while keeping the left mouse button pressed. 

 
 
4.2.23.4 USING WINDOW PRESETS 
 
A third possible form of applying center/window changes to images is to use pre-defined window presets.  
 
iQ-VIEW comes with a number of window presets as well as auto-contrast functions and a ROI window.  
 
The window presets pop-up menu can be accessed by right-clicking the “Windowing (dynamic)” or 
“Windowing (static)”button on the bottom toolbar or by selecting “Window presets” in the “Tools” menu: 
 
 

 
 
Several standard window settings (presets) may be selected: 
 
 Brain – base 
 Brain 

 Skull 
 Lung 

 Mediastinum 
 Abdomen 

 Bones 
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“Custom settings”:  
Select “Custom settings“ to change the existing presets or to add others. A configuration window will open 
displaying the current presets. From here, presets can be added (“Add”), deleted or modified (“Clear” and 
“Change”). Once the necessary changes have been made, click “Save and exit” to save any changes and 
close the custom settings window.   
 

 
Default window presets 

 
“ROI window”:  
ROI windowing applies an auto contrast to a selected area. It is mostly used for CR and RF images to generate 
an optimal contrast in the region of interest. Select this option and then mark the ROI area by drawing a 
rectangle onto the image with the mouse. The ROI window will then be calculated automatically. 
 
“Auto contrast”:  
Auto contrast applies an auto-contrast on the current image (with “Image scope”) or on a whole series (with 
“Series scope”) only. The other series remain unaffected.  
 
In addition, there is an auto-contrast function available for applying an auto-contrast to all loaded studies.  
Once applied, the auto-contrast will remain in effect until being deactivated again.  
 
 Click the “Additional settings” menu 
 Select “Auto-contrast every image” 
 All images of the currently selected study will be displayed with an auto-contrast.  
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NOTE: 
The window presets can also be used in combination with tiling on the image level (several images in one 

view). This is possible with scope on the series and image levels as well. 

 
 
4.2.23.5 FINE-TUNING WINDOW MODE 
 
In most cases, the regular dynamic and static windowing is sufficient for setting the brightness and contrast of 
an image to its best visual quality. However, iQ-VIEW also offers a mode with which it is possible to change the 
center/window values in one-step intervals. This makes it possible to fine-tune the windowing. 
 
To use fine-tuning: 
 
 Select “Windowing (dynamic)” or “Windowing (static)” as described in the previous sections. 
 Press the [CTRL] key while moving the mouse at the same time to change the contrast and brightness. 
 
 
4.2.24 COLOR REMAPPING 
 
Color remapping assigns a color to each gray tone of an image, therefore rendering any grayscale image  
(MONOCHROME1 and MONOCHROME2) in color. Using colors, areas with low contrast can be better 
displayed. Color remapping is particularly useful in nuclear medicine and it is for this reason that iQ-VIEW also 
provides a number of nuclear medical color schemes. 
 
Using the “Scope” function, described in section 4.2.5.4 Scope, it is possible to apply color schemes either to a 
whole series or to an individual image only: 
 
 Select “Image scope” to apply a color scheme only to a particular image. 
 Select “Series scope” to apply a color scheme to all images of the same series. 
 

NOTE: 
Color remapping will be reset when the scope is changed (from series to image or from image to series). It can 

then be applied again according to the newly selected scope. 
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Color remapping options can be accessed in one of the following ways:  
 
 Select the “Color scheme” button in the bottom toolbar 
 Click the “Tools” menu and select “color scheme” 
 Create shortcuts for the different “color scheme” options and use the respective key combinations to 

apply them to the images (for shortcut creation see section 4.2.7 Creation of shortcuts for viewer actions) 
 

 

“Color scheme” offers several general options: normal grayscale output (“B/w”), inverted 
grayscale output (“B/w negative”), color remapping (“Color remap”) and inverted color 
remapping (“Negative color remap”). In addition, these nuclear color schemes are available:  

 
 Hotiron 
 Rainramp 
 GE_Color 

 Gold 
 NIH 
 NIH_Ice 

 Bone 
 Cardiac 
 Spektrum 

 Blackbody 

 
 
4.2.25 MEASUREMENT, CALIBRATION AND ANNOTATION TOOLS 
 
iQ-VIEW offers a variety of measurement and annotation tools that make it possible to easily add markings to 
images (distances, angles, ROI, etc.). These tools are available both as toolbar buttons and menu entries.  
 
The measurement and annotation tools can be accessed in the following ways: 
 
 Click the “Tools” menu and select “Measurement tools” to access the sub-menu displaying all functions. 
 Select the “Measurement tools” button on the bottom toolbar. A right-click on the button (or hovering 

over the little black corner) opens a sub-menu all measurement and annotation functions can be found.  
 Individual measurement, calibration and annotation tools can be added from the “Tools selection” into 

the bottom toolbar. This is beneficial when only one or two measurement tools are regularly used. 
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NOTE:  
Measurements and annotations can be applied to rotated and mirrored images. Only images with square 

and circular ROI measurements that were rotated at a custom angle are excluded. If ROI measurements are 
made in an image before it is rotated, these measurements will no longer be visible after the rotation. 

However, the measurements will not be deleted and will become visible again when the image is rotated 
using a standard rotation. The same behavior applies to drawn shutters. 

For density measurements in images rotated at a custom angle, the “Polygonal ROI” tool may be used (in PRO 
version only). 

 
 
4.2.25.1 DISTANCE MEASUREMENTS 
 

 

“Distance”: The distance tool is used to measure a distance. To use the tool, point to the position 
where the measurement should begin and hold the left mouse button down while dragging the 
mouse to the end point. Releasing the mouse button will show the results in millimeters. 

 
During the drawing of the distance line, the current measurement value is displayed and constantly updated. 
In addition, a center marker is displayed in every distance line, indicating half of the measured distance. 
 

NOTE: 
If the result is not given in millimeters but in pixels (pxl), the pixel spacing is missing in the affected image (or US 

Region Calibration for ultrasound images). The pixel spacing or region calibration values are needed by iQ-LITE 
to know how big a pixel is in the image. This information is needed to calculate distance. 
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4.2.25.2 RATIO MEASUREMENTS 
 

 

“Ratio”: The ratio tool is used to measure a ratio between two distances. To use the tool, draw the 
first distance (A) and then the second (B). The result is given as a percent (%) of A/B. The length of 
the two distances is also shown. 

 

NOTE: 
If the length of the lines is not given in millimeters but in pixels (pxl), the pixel spacing is missing in the affected 

image (or US Region Calibration for ultrasound images). The pixel spacing or region calibration values are 
needed by iQ-VIEW to know how big a pixel is in the image. This information is needed to calculate the length 

of the two lines. 

 
 
4.2.25.3 PERPENDICULAR DISTANCE MEASUREMENTS 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Perpendicular distance”: The perpendicular distance tool is used to measure the short and long 
axis of tumors in 2D. Two distance lines are drawn at a right angle towards each other. Draw the 
first distance (A). When the second (B) is drawn, it is automatically set at a right angle to the first 
line on the basis of its starting point.  

 
Use the “Modify” function (see section 4.2.25.15 Modifying measurements and annotations) to adjust the 
measurements as needed. Besides the possibility of moving the entire construction, the length of each 
distance as well as its position can be changed. The entire perpendicular measurement can also be rotated 
while holding the [SHIFT] key.  
 

NOTE: 
If the length of the lines is not given in millimeters but in pixels (pxl), the pixel spacing is missing in the affected 

image (or US Region Calibration for ultrasound images). The pixel spacing or region calibration values are 
needed by iQ-VIEW to know how big a pixel is in the image. This information is needed to calculate the length 

of the two lines. 

 
 
4.2.25.4 POINT-TO-LINE DISTANCE MEASUREMENTS 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Point-to-line distance”: The point-to-line distance tool is used to measure the distance between a 
defined point and a drawn line in an orthogonal angle. This tool can be used, for example, for 
evaluating a spinal rotation scoliosis. 

 
First draw the line. Afterwards select the point from where the shortest distance to the previously drawn line 
shall be measured by simply clicking into the view. iQ-VIEW automatically adds a subsidiary line for better 
visualization. 
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NOTE: 
If the length of the distance is not given in millimeters but in pixels (pxl), the pixel spacing is missing in the 

affected image (or US Region Calibration for ultrasound images). The pixel spacing or region calibration values 
are needed by iQ-VIEW to know how big a pixel is in the image. This information is needed to calculate the 

distance from the defined point to the line. 

 
 
4.2.25.5 ANGLE MEASUREMENTS 
 

 

“Angle”: The angle tool is used to measure an angle. To measure angles, draw the first line as if 
drawing a distance measuring line. The second line does not necessarily have to intersect the first 
line. The resulting measurement values represent the acute and obtuse angle. 

 
As soon as the second ray of the angle measurement is started, iQ-VIEW displays the current measurement 
value. While the line is drawn the value is constantly updated.  
 
 
4.2.25.6 COBB’S ANGLE MEASUREMENTS 
 
Cobb’s angle is a method of measuring the degree angle of the spinal curve. The technique to measure the 
scoliosis curve consists of four lines constructing a geometric figure. 
 

 

“Cobb’s angle”: To use this tool, first draw a line along the superior edge of the vertebra and 
extend the line into the margin of the X-ray (line A). iQ-VIEW will automatically add the 
perpendicular line from line A downward. The next step is to draw another line along the inferior 
vertebra. Again extend it into the margin of the X-ray (line B) until the perpendicular line upwards 
from line B meets the one from line A. The angle that is formed by the two meeting perpendicular 
lines is the Cobb’s angle. 
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Cobb’s angle measurement 

 
 
4.2.25.7 INTERIOR ANGLE MEASUREMENTS 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Interior angle”: The interior angle tool is used to measure an interior angle in a right-angled 
triangle, i.e. an acute angle adjacent to the hypotenuse. This tool can, for example, be used for 
the measurement of joint angles of the wrist.  

 
The measurement is applied like the regular angle tool. Draw the first line (A) and then add the second ray (B). 
A subsidiary line is automatically drawn in an orthogonal angle from the end of the second ray to the first ray. 
The angle created by the second ray crossing the subsidiary line is measured. 
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Interior angle measurement 

 
 
4.2.25.8 SQUARE ROI MEASUREMENTS 
 

 

“Square ROI”: With the square ROI tool it is possible to measure the density in a selected 
rectangular area (ROI). To use this tool, place the mouse at the upper left corner of the area to 
measure; hold the left mouse button down; and drag diagonally until the appropriate area is 
selected. When the mouse button is released, a rectangle will be drawn over the specified area 
and the mean, maximum and minimum density values will be given. For CT images the results are 
displayed in Hounsfield Units (HU). In addition, the results will state the standard deviation. 

 
 
4.2.25.9 CIRCULAR ROI MEASUREMENTS 
 

 

“Circular ROI”: Measuring density in a selected elliptical/circular area (ROI) is possible using the 
circular ROI tool. To use this tool, place the mouse in the center of the area to be selected; hold 
the left mouse button down; and drag the mouse outward from the center to create an 
ellipse/circle around the desired area. When the mouse button is released, the mean, maximum 
and minimum density values will be given. For CT images the results are automatically displayed in 
Hounsfield Units (HU). In addition, the results will state the standard deviation. 

 

NOTE:  
A perfect circle (not an ellipse) can be achieved by holding the [SHIFT] key while drawing the ROI area with 

the mouse. 
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4.2.25.10 POLYGONAL ROI MEASUREMENTS 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Polygonal ROI”: Using the polygonal ROI tool, it is possible to measure both the density and size of 
a selected freehand area. To measure the density and the size of a certain area, click into the 
image where you would like to start drawing your shape. A line is drawn to the next point that you 
select by mouse-click. Continue until your shape is completed. The last mouse-click must be made 
close to the starting point to close the shape. iQ-VIEW PRO automatically switches into the 
“Modify” mode to allow adaptations in the polygon. As result the mean, maximum and minimum 
density value is given as well as the standard deviation and the area size in square millimeters 
(mm²). For CT images the density results are automatically displayed in Hounsfield Units (HU).  

 

NOTE: 
If the area result is not given in mm² but in pxl², it means that the pixel spacing is missing in the affected image 
(or US Region Calibration for ultrasound images). The pixel spacing or region calibration values are needed by 

iQ-VIEW PRO to know how big a pixel is in the image. This information is needed to calculate the size of an 
area. 

 
 
4.2.25.11 SHUTTERS 
 

 

“Shutter”: The shutter tool makes it possible to select a specific rectangular area of an image while 
blackening out the rest of the image. The blackened-out areas are not deleted from the image. 
They are only hidden. To use this tool, place the mouse at the upper left corner of the area to 
view, hold the left mouse button down and drag diagonally until the appropriate area is selected. 
When the mouse button is released, only the selected area will be visible. 

 

NOTE: 
The shutter cannot be used in combination with a user-defined rotation (“Adjust angle”, “Enter custom 

angle”). 

 
 
4.2.25.12 ANNOTATIONS 
 

 

“Annotation”: The annotation tool allows the user to make annotations on images. To use this tool, 
point the mouse at the area where the annotation should begin. Longer annotations should start 
farther to the left. While holding the left mouse button down, drag the mouse to draw a line on the 
image to the area to be annotated. When the mouse button is released, an arrow will be 
displayed and the annotation dialog will open. 
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Annotation dialog 

 
Enter text and click “OK”. Annotations are displayed only to the border of the image. The longer the 
annotation, the farther the arrow should start on the left side. The annotation text will begin at the starting 
point of the arrow. 
 

 
Example of an annotation 

 

NOTE:  
If no text is entered on the annotation screen, the arrow will remain anyway. This is implemented by design to 

allow for adding arrows that denote specific areas in the image. 
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4.2.25.13 OVERLAPPING OF MEASUREMENT VALUES 
 
In some cases, especially when creating measurements and annotations within small structures, measurements 
may end up very close to each other and the calculated values may overlap. Since this makes values difficult 
to read, iQ-VIEW will automatically move the values to avoid an overlap. 
 
To insure that each value can still be matched to the measurement where it belongs, a red frame is put 
around any value that was moved and a line connects the value to the corresponding measurement. 
 

 
 
 
4.2.25.14 ERASING MEASUREMENTS AND ANNOTATIONS 
 

 

“Clear”: The clear tool can be used to erase individual measurements or annotations made in an 
image. To use this tool, select the “Clear” function, then click the measurement or annotation to 
be erased. After it turns red, click again the item to remove the measurement or annotation. 

 
Other deleting functions are available in the “Tools” menu: 
 
 “Clear all measurements”: All measurements made in all studies loaded into the viewer are removed with 

one click. 
  “Clear last measurement”: The last measurement made in an image is removed. 
 

NOTE: 
All measurements and annotations made in a series (one view) can be deleted by using the “Reset” button or 
by selecting “Clear presentation states” from the “Tools” menu. However, both tools will reset ALL changes in 

the active series, not only the measurements and annotations. 

 
 
4.2.25.15 MODIFYING MEASUREMENTS AND ANNOTATIONS 
 

 

“Modify”: The modify tool allows current measurements and annotations to be modified. To use 
this tool, select the measurement or annotation to be modified. The markers displayed on each 
measurement or annotation can then be used to drag and drop the measurement/ annotation 
into the correct position. 
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The “Modify” function works as follows:  
 
 Distance measurements: Grab the center marker with the mouse to move the whole line into a new 

position or use the start and end markers of the line to change the length and position of the starting and 
ending points. 

 Ratio measurements: Use the start and end markers of the two lines to change the length and position of 
the starting and ending points. 

 Perpendicular distances: Use the starting and ending points of each distance line to change the length 
and position of the line. The right angle will be maintained. To rotate the perpendicular distance 
measurement, hold the [SHIFT] key while grabbing one of the line markers with the mouse and move it into 
the desired position. (iQ-VIEW PRO only) 

 Point-to-line distances: Grab the point marker to drag the defined point to another position. The subsidiary 
line is adapted accordingly and the shortest distance to the point will be recalculated accordingly. (iQ-
VIEW PRO only) 

 Angle measurements: Grab the center marker to change the position of where the two lines cross or use 
the start and end markers of each line to move the lines into the correct position. 

 Cobb’s angle: Use the markers at the end of each line to correct the line positions. The perpendicular lines 
will be adapted automatically by iQ-VIEW. 

 Interior angle: Use the markers at the ends of the second ray to correct the line position and length; the 
subsidiary line is attached to the end that was grabbed and will be adapted accordingly. The angle is re-
calculated. (iQ-VIEW PRO only) 

 Square and circular ROI: Grab the center marker to move the whole area (rectangular or 
elliptical/circular) or use the line markers to change the size of the area. 

 Polygonal ROI: Grab either of the corner markers to change its position and therefore the size and form of 
the polygonal area. (iQ-VIEW PRO only) 

 Shutter: Grab the center marker to move the whole shutter or use the markers in the upper left and lower 
right corners to change the shutter’s size. 

 Annotations: Grab the center marker to move the annotation and arrow to a new location or use the 
marker at the arrow tip to change the length and tip position. The annotation text field will open after 
each move to allow the text to be changed. 

 
 
4.2.25.16 COPYING MEASUREMENTS AND ANNOTATIONS 
 
This function is only available in iQ-VIEW PRO. 
 

NOTE: 
The option to copy measurements from one image to others can be risky if used improperly. Please read the 

warning below very carefully and keep it in mind when using this function! 

 

 

“Copy”: The copy tool will copy measurements and annotations made in one image to other 
images, either in the same or a different series. This function may be particularly helpful in multi-
slice studies. 

 
There are different ways to copy measurements and/or annotations. The available options can be found in 
the “Copy” submenu: 
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 “Copy to selected slice(s) of series”: First select the slices to where the measurements/ annotations will be 

copied by marking the little checkbox in the upper right corner of the view (also see section 4.2.16 
Selection of images, series and studies). Then select the slice whose measurements should be copied (a 
different slice of the same

 “Copy to all images of series”: Select the slice whose measurements are to be copied to all other images 
of the 

 series). Select “Copy to selected slice(s) of series” from the submenu. All 
measurements/annotations are copied to the selected slice(s) of the same series. 

same

 “Copy to clipboard”: Select the slice whose measurements are to be copied. Use the “copy to clipboard” 
function to place the information into the clipboard temporarily (the Windows clipboard is not used, but 
iQ-VIEW’s own). Then use the “Insert from clipboard” function to place the measurements/ annotations 
into another image, even in a different series. 

 series. Select “Copy to all images of series” from the submenu. All measurements/ annotations 
are copied to all slices of the same series. 

 “Insert from clipboard”: This function will only work if measurements/ annotations were copied to the 
clipboard beforehand (see function “copy to clipboard”). Select the image to which the measurements/ 
annotations currently stored in the clipboard should be copied. Click the “Insert from clipboard” entry in 
the submenu. They will be copied into that image. 

 
The “Undo” function is a reset function for the copy actions. By clicking “Undo,” iQ-VIEW goes back a step and 
removes the previously copied measurements/ annotations. 
 
Alternatively, shortcuts can be created for all available copy and insert functions. It is then possible to use the 
respective key combination to apply the function in question (for shortcut creation see section 4.2.7 Creation 
of shortcuts for viewer actions). 
 

WARNING: 
When using the function of copying measurements from one image to another, you will have to pay special 

attention to the following information and limitations:  
1. This function will only copy a measurement from one image to another. The measurement and its 

measurement result are NOT adjusted to the image into which the measurement is copied. 
2. Therefore, use this function very carefully. The measurement result shown may NOT be correct for this image. 

Only when the pixel spacing and the field of view of this image corresponds fully with those of the original 
image, the measurement result will still be true. 

3. Also be very careful with storing copied measurements as secondary capture or Presentation State. As the 
stated measurement results may not be correct in the image to which they were copied, another person 

(radiologist or referring physician) reading this study may believe these measurement results to be true and 
therefore evaluate them incorrectly, leading to wrong diagnostic information. 

4. A measurement will always be copied to the same position in the view of the image processing area. The 
anatomic structure of the image positioned in this view is not considered when placing the copied 
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measurement. For positioning, iQ-VIEW will check the top and left position of the measurement in the original 
view and copy it in the same top and left position of the target view. 

 
 
4.2.25.17 CALIBRATION OF MEASUREMENTS (SCALING OVERSIZE)  
 

 

“Calibrate”: The calibrate function calibrates measurements for CR images while considering the 
oversize in the images. If a marker of a known length was put onto the image, the length or 
diameter can be drawn like a distance measurement and the distance can be given in millimeters 
(mm).  

 
During the drawing of the calibration line, iQ-VIEW will automatically draw a surrounding circle, spanning from 
the point where the calibration line is started. This makes it easier to calibrate spherical markers. 
 

 
 

NOTE: 
A calibration made in an image will only affect that particular image. The calibration does not extend to other 

images of the same series, as the magnification could differ from image to image. 

 

 

The calibration line is displayed in red to show the difference to a regular distance measurement.  
 
In addition, the ruler in the image (if displayed) turns red to indicate that the image contains 
calibrations. In the original images the ruler will remain yellow. 

 
After a calibration has been made, all following distance measurements in that image are calculated on the 
basis of the calibration. Earlier distance measurements are adjusted according to the calibration. 
 
If a second calibration is made in the same image, the previous calibration will be overridden. All distance 
measurements in this image will be adjusted to the new calibration.  
 
A calibration can be deleted using the “Clear” function of the measurement tool. The image will return to its 
original scaling. All distance measurements are adjusted accordingly. Modifying a calibration line, however, is 
not possible. If you need to change the calibration, simply draw a new line. The old one will be overwritten 
automatically and removed. 
 

NOTE:  
A calibration is only possible in the currently active view (displayed with a blue frame). If “Calibrate” is 

selected, but an inactive frame is used, then only a regular distance measurement will be drawn. Therefore, 
first activate the correct view and then select the “Calibrate” function. 
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4.2.25.18 STORING MEASUREMENTS 
 
Several ways exist to permanently store measurements and annotations made in individual images. Some of 
these functions are only available in iQ-VIEW PRO. 
 
One way (available in both the BASIC and PRO versions) is to create a secondary capture image that will be 
appended to the current study. For details on how to create secondary capture images, see section 4.2.32 
Creating secondary capture images. 
 
iQ-VIEW PRO also offers the opportunity to store presentation states as files in the local imagebox and to send 
them to a remote archive to be retrieved when needed. Measurements, calibrations and annotations are part 
of the presentation states and can be stored in the same way. For details check section 4.2.20.2 Storing 
presentation states. 
 

NOTE:  
Measurements and annotations stored in the presentation states can be modified or individually deleted using 

the “Modify” and “Clear” function. 

 
It is also possible to delete the measurements and annotations from the presentation states. You may delete 
individual measurements/ annotations or all of them: 
 
 To delete individual measurements: Click the image with the measurement to be deleted. Open the 

measurements submenu and select “Clear”. Then select the measurement to be deleted by clicking it. 
Click again to delete it. Afterwards store the changes made in the presentation states. The selected 
measurement will be deleted. Other stored measurements are not affected. 
 

 To delete all stored measurements in all loaded studies: Open the “Tools” menu and select “Clear all 
measurements”. Then store the changes made in the presentation states. All previously stored 
measurements in all series of the loaded study or studies are deleted the next time the study is loaded from 
the Study Browser. 

 

WARNING: 
As these actions include all loaded studies, make sure that you really wish to clear all measurements and 
annotations in all these studies. Select only those studies from where this information should be removed. 

Saving the changes as presentation states will save them in all loaded studies. 
 

 
4.2.26 MAGNIFYING TOOLS 
 
Integrated into the application are several magnifying tools. The regular “Magnifier” is available in iQ-VIEW 
and iQ-VIEW PRO and a special “Magnifier window” is only functional in the PRO version of the software.  
 
The use of the “Magnifier window” excludes the additional use of the regular “Magnifier”, i.e. if the “Magnifier 
window” is active, the regular “Magnifier” cannot be selected.  
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4.2.26.1 THE REGULAR MAGNIFIER 
 
The regular magnifier function can be accessed by clicking the “Magnifier” button in the bottom toolbar or by 
selecting “Magnifier” from the “Tools” menu.  
 

 

“Magnifier”: After selecting the magnifying function, the mouse pointer turns into a magnifying 
glass. By holding down the left mouse button while moving over an image, the image area is 
magnified at twice its current size at the position of the mouse. 

 

NOTE: 
Measurements and annotations made in an image are still visible using the magnifier. 

 
 
4.2.26.2 THE MAGNIFIER WINDOW 
 
The magnifier window, integrated into the iQ-VIEW PRO version, is specifically meant for use on high-resolution 
monitors and is especially beneficial when evaluating mammography and radiography images. 
 
It is accessible by selecting the “Magnifier window” button from the “Tools selection” and adding it to the 
bottom toolbar or by clicking “Magnifier Window” in the “Tools” menu. The creation of a shortcut is also 
possible. 
 

 

“Magnifier window”: When activated, a separate window will open. This window can not only be 
moved to another position but can also be adjusted in size. The zoom factor is seamlessly 
configurable between 10% and 1000%. Position, size and zoom factor are remembered. 

 
After opening the magnifier window and making the necessary adjustments, move over the image to magnify 
while holding the left mouse-button. 
 

 
Original “fit-in” series with activated “Magnifier window” 
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NOTE: 
Measurements and annotations made in an image will not be displayed in the magnifier window to avoid 

obstructing the view on regions of interest. 

 
 
4.2.27 ZOOMING AND PANNING TOOLS 
 
Sometimes individual images or entire series need to be enlarged to improve the visibility of diagnostically 
relevant tissues and structures. Moving images around in their views (panning) may also be necessary – for 
example, to adjust them for easier comparison to another series. 
 
Using the “Scope” function, described in section 4.2.5.4 Scope, it is possible to apply zoom and pan changes 
to a whole series or to an individual image only: 
 
 Select “Image scope” to only change the zoom factor or position (pan) of a particular image. 
 Select “Series scope” to apply changes in the zoom factor or position (pan) for one image to all images of 

the same series. 
 

NOTE: 
Any zoom and pan changes made will be reset when the scope is changed (from series to image or from 

image to series).Zoom/pan can then be applied again according to the newly selected scope. 

 
 
4.2.27.1 ZOOM/PAN HANDLING WITH PRESENTATION STATES 
 
It is important to note that the zoom and pan features in iQ-VIEW have changed in comparison to earlier 
software versions (up to iQ-VIEW 2.5.0c).  
 
Due to the presentation states (PR) now used to display and cache changes in DICOM images, the zoom/pan 
feature has been modified to adhere to the specifications established in the DICOM standard.  
 
Therefore, zoom out will only scale down to a “fit-in” size and not smaller since this is not defined in the DICOM 
standard. It is, however, possible to view an image smaller than its “fit-in” size by applying a 1:1 zoom. 
 
Panning images can still be done even if the images are not zoomed but are scaled to fit the screen. This 
allows for the adjusting of images to the same height in case one is displayed lower than the other.  
 
 
4.2.27.2 THE ZOOM/PAN FUNCTION 
 
To zoom (adjust the size) or pan (move) images, either click the “Zoom/Pan” button on the bottom toolbar or 
select “Zoom/Pan” from the “Tools” menu. 
 

 

“Zoom/Pan”: When activated, the zoom/pan function can be used to dynamically zoom and pan 
images using the mouse. The middle area of the image acts as the “pan zone”. The mouse pointer 
turns into a hand icon when pointing there. By clicking in the middle of the image and moving the 
mouse up/down or right/left, the image will be moved. The periphery of the image acts as the 
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“zoom zone”. The mouse pointer turns into a magnifier icon when pointing there. By clicking on the 
periphery and moving the mouse up and down, the image can be easily zoomed. 

 
In addition, a sub-menu is available with different zooming presets. The sub-menu is accessed by right-clicking 
the “Zoom/Pan” toolbar button or by right-clicking directly on the image processing area (after having 
selected the function): 
 

 
 
 “Fit in”: This is the default setting. Images are scaled to fit into the available view. The higher the tiling, the 

smaller the images will be displayed. 
 “1x (original)”: The images are displayed in their original size. 
 “1.5x”: The images will be zoomed to one and a half times their size. 
 “2x”: The images will be zoomed to two times their size. 
 “2.5”: The images will be zoomed to two and a half times their size. 
 “3x”: The images will be zoomed to three times their size. 
 
Alternatively, shortcuts can be created for the available zooming presets. It is then possible to use the 
respective key combination to apply the desired preset (for shortcut creation see section 4.2.7 Creation of 
shortcuts for viewer actions). 
 
 
4.2.27.3 THE SCROLL ZOOM 
 
The “Scroll zoom” function is available in the “Tools” menu or by adding the “Scroll zoom” button to the 
bottom toolbar using “Tools selection”. Once the feature is activated, the scroll-wheel of the mouse can be 
used to dynamically zoom the currently active image. 
 

 

“Scroll zoom”: Click the “Scroll zoom” function, and then use the scroll-wheel of the mouse to 
dynamically zoom the currently active image. 

 

When moving the scroll-wheel of the mouse 
upwards, the image is enlarged. When moving the scroll-wheel of the mouse downwards, the 
image is made smaller. This behavior is similar to the general zoom function. 

 
4.2.28 FLIPPING AND ROTATION TOOLS 
 
Images loaded into the viewer can either be flipped or rotated or both.  
 
Using the “Scope” function, described in section 4.2.5.4 Scope, it is possible to apply flip and rotation changes 
to a whole series or to an individual image only: 
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 Select “Image scope” to flip or rotate only a particular image. 
 Select “Series scope” to apply the flip or rotation changes made in one image to all images of the same 

series. 
 

NOTE: 
Flips and rotations made will be reset when the scope is changed (from series to image or from image to 

series). The modifications can then be applied again according to the newly selected scope. 

 
 
4.2.28.1 THE FLIP/ROTATE FUNCTION 
 
The flipping and rotation options are accessible by clicking the “Flip/Rotate” button in the bottom toolbar or 
by selecting “Flip/Rotate” in the “Tools” menu. 
 

 
 

 

“Flip/rotate”: Activating the Flip/Rotate function opens a sub-menu containing all flipping and 
rotation options: 
 
 “Flip vertically”: Flips the image vertically. A specific marker is added to the text overlay to 

indicate the flipping. * 
 “Flip horizontally”: Flips the image horizontally. A specific marker is added to the text overlay to 

indicate the flipping. 
 “90° rotation clockwise”: Rotates the image in a 90 degree angle to the right. 
 “180° rotation”: Rotates the image in a 180 degree angle. 
 “90° rotation counter-clockwise”: Rotates the image in a 90 degree angle to the left. 

 
Alternatively, shortcuts can be created for all flipping and rotation options. It is then possible to use the 
respective key combination to apply the desired function (for shortcut creation see section 4.2.7 Creation of 
shortcuts for viewer actions). 
 

*NOTE: 
To correctly read the markers given in the overlay, it is important to understand that for presentation states only 
horizontal flipping is defined. Therefore, when using vertical flipping (as the option is called in iQ-VIEW for better 
understanding), the marker stated in the text overlay will include a horizontal flip and a 180° rotation, which is 

exactly the same as a vertical flip. The marker states: “Flipped hor. Rotation: 180°”. 
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Click “Reset current view” from the sub-menu to reset the flipping and rotation changes. The images will return 
to their original position. Alternatively, the general “Reset” button on the bottom toolbar or the menu item 
“Reset current view” found in the “Tools” menu can be used to reset the modifications. Note, however, that 
the latter options also remove all other modifications made to the image(s). 
 

NOTE: 
When rotating or flipping zoomed images, any zoom or pan changes will be reset. This also applies to the 

“Reset current view” function within the flip/rotate context menu. However, it is possible to re-apply the zoom 
after the image has been rotated. 

 
 
4.2.28.2 USING CUSTOM ROTATION 
 
In cases where the rotation presets are not sufficient or the images only need to be adjusted slightly, e.g. to 
turn them upright, a customized rotation can be helpful. iQ-VIEW offers two ways to rotate images in a user-
defined way: 
 
 Using the “Enter custom angle” option in the “Flip/Rotate” sub-menu. 
 Using the separate “Adjust angle” function that is provided as an individual toolbar button and would 

have to be pulled into the bottom toolbar from the “Tools selection” window. 
 

 

“Flip/Rotate”: To rotate the image to a specific angle, select “Enter custom angle” from the sub-
menu. A dialog box opens where the desired angle can be entered. Either type the angle in the 
text box or use the up and down arrows to choose the correct angle, then click “Accept”. The 
image (and all images of the same series if series scope is chosen) will be rotated accordingly. The 
image is rotated clockwise. 

 

 
 
The “Enter rotation angle” dialog can also be called up using a shortcut. This shortcut would have to be 
configured first. For details concerning the creation of shortcuts see section 4.2.7 Creation of shortcuts for 
viewer actions. 
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Example of a 45° custom angle 

 

 

“Adjusting angle”: This function is used to slightly adjust the rotation of an image to bring it into an 
upright position. Draw a line in the image (similar to distance measurement) that indicates at 
which angle the image should be adjusted. iQ-VIEW uses the end of the line closest to an upright 
position (12 o’clock) and calculates the rotation accordingly. The images below show the 
procedure. The yellow line is the line drawn by the user. The red (imaginary) line indicates the 
upright position. The green (imaginary) line indicates the angle between the two, which is the 
rotation angle that will be used. The right image shows the result after the adjustment. 

 

   
Left: original with yellow adjusting line (drawn by user) and red reference line 

Right: image after angle adjustment 
 

NOTE: 
Please note that it is not possible to use the square and circular ROI measurements tools in images that have 

been rotated to a custom angle. If ROI measurements were made in an image before it is rotated, the 
measurements will no longer be visible. However, they are not deleted and will be displayed again when the 

image is rotated using a standard rotation setting. The same behavior applies to drawn shutters. 
For density measurements in images rotated in a custom angle, you may use the “Polygonal ROI” tool (PRO 

version only). 
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4.2.29 IMAGE FILTER 
 
For the post-processing and quality improvement of images, a number of image filters are available in the 
viewer.  
 
Using the “Scope” function, described in section 4.2.5.4 Scope, it is possible to apply image filters either to a 
whole series or to an individual image only: 
 
 Select “Image scope” to apply image filters only to a particular image. 
 Select “Series scope” to apply image filters to all images of the same series. 
 

NOTE: 
Image filters will be reset when the scope is changed (from series to image or from image to series). The 

modifications can then be applied again according to the newly selected scope. 

 
The available options can be accessed by clicking the “Image filter” button in the bottom toolbar or from the 
“Image filter” menu.  
 

 

“Image filter”:  Upon activation, a sub-menu opens with the following options:  
 
 Sharpen 
 Edge enhance 
 Noise reduction 
 Blur 
 Low pass 
 High pass 

 
The “Reset” option removes all applied filters and returns the image(s) to their original state. 
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4.2.30 RESETTING CHANGES IN IMAGES 
 
4.2.30.1 RESET 
 
If modifications made in an image are no longer needed or need to be changed, it is possible to reset the 
changes and start anew. The reset function is available both in the bottom toolbar (“Reset” button) and also 
by selecting “Reset current view” in the “Tools” menu. 
 

 

“Reset”: Selecting the reset function removes all changes made to an image and restores the 
original image (e.g. if the image was windowed, zoomed, rotated). In addition, all measurements, 
annotations and shutters are removed. Modifications can also be deleted separately. Please see 
section 4.2.25.14 Erasing measurements and annotations for further information. 

 
 
4.2.30.2 CLEAR CURRENT VIEW 
 
“Clear current view” is used to not only remove changes made in an image, but to empty an entire view in 
the image processing area.  To access this option: 
 
 Click the “Tools” menu 
 Select “Clear current view” 
 The view will be emptied and is left blank. It can then be filled with a new series. 
 
 
4.2.31 REPORTING TOOLS 
 
When patient studies are evaluated in iQ-VIEW for diagnostic purposes, the results of that evaluation are 
usually recorded both to be sent to the referring physician and for documentation and accounting purposes.  
 
For this reason, the application offers a structured reporting module where the radiologist orthopedist, 
cardiologist, etc. can type in or use speech recognition software to enter their findings. For different workflow 
scenarios where the doctor may record the findings to be transcribed later by a medical data assistant or a 
special transcription service, iQ-VIEW also provides a direct interface to the NCH Express Dictate software.  
 
 
4.2.31.1 STRUCTURED REPORTING 
 
The structured reporting window can be opened using the “Structured reporting” button in the bottom toolbar 
or by using the corresponding entry in the “Tools” menu. 
 

 

“Structured reporting”: When selecting the structured reporting function, a report window is 
opened that contains different text fields, different configuration and exporting options and the 
opportunity to create text macros for easier completion of the reports. 

 
When creating a structured report for a study, select a view displaying a series of the study (an empty view 
can also be selected). To reopen a structured report created with iQ-VIEW (e.g. for modification), activate the 
view in which the structured report is displayed (blue frame) and then use the “Structured reporting” tool 
button or menu entry to open the report editor.  If the structured report is not currently in the image processing 
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area, select the report in the preview area and drag it into one of the views.  For more information about 
adding a report to the image processing area, see section 4.2.13 Selecting individual series for viewing. 
 
To add a second structured report to a study, select one of the views in the image processing area that 
displays a series of that study. Do NOT use the view with the first SR. A new report form will be opened when the 
“Structured reporting” function is activated. 
 

NOTE: 
Only structured reports that were created with iQ-VIEW can be modified. Structured reports coming from other 

stations can only be viewed (read-only) and exported (e.g. to printers or to patient CD/DVD). 

 
 
1. The structured reporting window 
 

 
Structured reporting form 

 
The reporting form contains three text fields: 
 
 Technique 
 Observation 
 Summary 
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The “Status” of the report can be set using the drop-down menu. Possible values are:  
 
 UNVERIFIED, INCOMPLETE 
 UNVERIFIED, COMPLETE 
 VERIFIED, INCOMPLETE  
 VERIFIED, COMPLETE 
 
The structured report object will read “PARTIAL” instead of “INCOMPLETE” as this is the officially used DICOM 
term. “INCOMPLETE” is used in the application for easier understanding.  
 
If the report is set as one of the first three statuses, it can still be modified. Selecting the view in the image 
processing area where the structured report is located will re-open the report form for editing. Here, text can 
be changed or new information added. After the status is set to “VERIFIED, COMPLETE”, the structured report is 
closed and can no longer be edited.  
 

NOTE: 
As long as the report status is not set to “VERIFIED, COMPLETE”, it is impossible to send the report automatically 

to a remote station. This is a security mechanism designed to insure that only finished reports will be stored 
remotely. However, it is still possible to send reports manually. For more information see section 4.2.33.1 

Specifics of sending Structured Reports. 

 
Specific text fields are used in the report to identify the report creator and verifier of the content: 
 
 “Observer”: Text field used for the creator of the report. 
 “Verifying radiologist”: Used for the name of the radiologist that verifies the report. If a report is set to a 

verified status this field must be completed. 
 “Institution”: Used for the name of the institution. If a report is set to a verified status this field must be 

completed. 
 

NOTE: 
Entering the observer’s name is required, regardless of the status of the Structured Report. An SR cannot be 

attached to a study or be printed if the “Observer” field is empty. 
If the status of the SR is set to “VERIFIED, INCOMPLETE” or “VERIFIED, COMPLETE”, the fields “Verifying 

radiologist” and “Institution” must be completed. A verified SR cannot be attached to a study or be printed if 
those fields are empty. 

 
 If the name needed is not yet available in the drop-down list, enter it into the text field. 
 If a name has already been added to the list, use the drop-down box to select it. 
 

 
 

 
Use the “+” button to add a new name to the drop-down list. 
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Use the “–” button to delete the currently displayed name from the drop-down list. 

 
For better readability, a “Font size” can be set within the report module:  
 
 “Font size”: Set the desired font size by typing a number in the box or by using the up and down arrows. 
 
Do note, however, that the selected font size will not be used in the created structured report file since the 
layout and structure of that file is defined by the DICOM standard. 
 
The text displayed in the different text fields will automatically update when the font size is changed. If macros 
have been created (see below), their font size will also update. 
 
 
2. Function buttons 
 

 

“Copy to clipboard”: The content of all text fields, including the information about the patient and 
study for which the report was created, is copied to the clipboard. From there it can be used in 
other applications, e.g. to create a doctor’s letter to be sent out to the referrer.  

 

 

“Append to study”: This function adds the structured report as a separate series to the study for 
which it was created. The SR is registered into the iQ-VIEW database and stored in the local 
imagebox. 

 

 

“Print report”: Click the print button to open the structured report in the print manager. From there 
it can be sent to any Windows printer connected to the system or DICOM printer configured in the 
iQ-VIEW DICOM settings. 

 

 

“Close report form”: Closes the report form. A confirmation dialog asks if the form is to be closed 
without saving or printing the report first. If confirmed, iQ-VIEW returns to the viewer window. 

 
 
3. Manually creating a structured report 
 
To manually create a structured report, type the patient’s history, technical information, any diagnostic 
findings and all other pertinent information into the appropriate text fields. 
 
The [TAB] key can be used to easily jump from one text field to the next. 
 
Add the “Observer” and “Status” (and, if verified, also the “Verifying radiologist” and the “Institution”) of the 
report before appending it to the study or printing it. If the necessary “Observer”, “Verifying radiologist” or 
“Institution” fields are not filled in, it will be impossible to append or print the report. The missing fields will turn 
orange when trying to perform those tasks. Fill in the appropriate information to continue. 
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NOTE: 
It is also possible to use the structured reporting form in combination with speech recognition software installed 

on the system. In this case, the text would not have to be entered manually but could be dictated into the 
fields. Be sure to select the appropriate fields before speaking the text. 

 
 
4. Managing macros and text modules 
 
It is possible to specify macros and text modules that are frequently used when creating diagnostic reports. 
These macros and text modules can be stored in the report module and used whenever a report must be 
written. 
 
Setting up new macro categories (e.g. regarding specific body parts like liver, kidney, spleen or pancreas) 
and their respective text modules can be done as follows:  
 

 
Click the “Macro editor” button to access the menu for creating and adding macro categories and 
text modules. 

 

 
 
 “New macro category”: Select this entry to create a new macro category. The following entry field will be 

opened at the bottom of the macro panel: 
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Click the “+” sign to add the new category to the panel above. The [ENTER] key can also be used for 
this. 

 
As many macro categories as are needed can be configured. Each macro category can have text modules 
defined for it. It is possible to: 
 
 Create new text modules for a category (“New text module”) 
 Edit existing macros and text modules (“Edit text data”) 
 Delete an existing macro or text module (“Delete macro”) 
 
To create new text modules under a specific category, first select the category under which the macro will be 
added. Then select the “Macro editor” button and select “New text module”. An alternative is to right-click 
the category and select the respective menu entry. 
 

 
Adding text modules 

 
The text module window opens. Enter the title of the macro into the “Macro title” field. Be sure that the macro 
title clearly references the text since only this title will be shown in the list. 
 

 
Example for creating a new text module 
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When completed, click “Accept” to add the text module to the macro category. A new entry will appear 
under the respective category: 
 

 
Example of an added text module 

 

NOTE: 
Text modules can be created under existing text modules (on a third level), so that an entire tree structure can 

be developed. 

 
A similar procedure can be used to modify an already existing macro category or text module. Begin by 
selecting the macro / text module to modify. Then use the “Macro editor” button or right-click the entry to 
display the menu options. Select “Edit text data” and the macro / text module window will open again where 
the text can be changed: 
 

 
Editing a text module 

 
To delete an existing macro category or text module, select the macro to be deleted, right-click it and then 
select “Delete macro”. The “Macro editor” menu can also be used to delete the macro. The macro will 
immediately be removed.  
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5. Using macros and text modules in reports 
 
Macros can be added to any of the text fields in the report using drag and drop. This method was 
implemented for flexibility and ease of use:  
 
 To use a macro category in the report, select the category, drag it into the desired text field and drop it 

there. 
 To use a text module in the report, click the “+” in front of the correct macro category to open it and show 

the corresponding text module level. Then select the text module, drag it into the appropriate text field of 
the report and drop it there. 

 
The macro text is always added where the cursor is currently placed in a particular text field. When reopening 
an already available structured report for further modification, a dragged-in macro will be added in a new 
line to the existing text.  
 
 
4.2.31.2 USING “NCH EXPRESS DICTATE” FOR DICTATION 
 
iQ-VIEW offers a direct interface to the dictation software “NCH Express Dictate” for dictating diagnostic 
findings into a sound file for later transcription. This is third-party software that must be purchased and installed 
separately. 
 
This interface can be activated using the “NCH Express Dictate” button from the “Tools selection”. For 
information on how to add this button to the bottom toolbar, see section 4.2.4.3 Configuration of the bottom 
toolbar: 
 

 

“NCH Express Dictate”: Click the button to access the NCH dictation software directly out of the 
iQ-VIEW viewer window. Then dictate the report into a sound file. 

 

NOTE: 
For details regarding the connection of NCH Express Dictate to iQ-VIEW, please consult the iQ-VIEW 

Administration Guide. 

 
 
4.2.32 CREATING SECONDARY CAPTURE IMAGES 
 
A secondary capture image can be created in order to permanently store an image with changes such as 
measurements or annotations. 
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 In the “Tools” menu, select “Create secondary capture image” and then “Append to existing secondary 

capture series” to create a secondary capture image of the current image and append it to a study. An 
alternative is to use the shortcut [CTRL]+[SPACE]. If a secondary capture sequence exists already, this new 
image is incorporated into the sequence. 

 In the “Tools” menu select “Create secondary capture image” and then “Create new secondary capture 
series” to create a secondary capture image that will then be put into a new secondary capture 
sequence. An alternative is to use the shortcut [SHIFT]+[SPACE]. If another secondary capture sequence 
already exists, the new image will not be incorporated into this one, but instead will create a new 
sequence. 

 

 

The “Create secondary capture images” button can be added to the bottom toolbar using the 
method described in section 4.2.4.3 Configuration of the bottom toolbar. This function is limited to 
creating the first secondary capture sequence and then adding further secondary capture 
images to the same series with each new click. Using this button, it is not possible to create 
additional secondary capture sequences. It corresponds with the function “Append to existing 
secondary capture series” (shortcut [CTRL]+[SPACE]) from the menu.  

 
By default, iQ-VIEW will use the value “Secondary Capture Sequence” as the series description of a secondary 
capture sequence. To add different series descriptions for the secondary capture images, the function will 
need to be activated in the iQ-VIEW main configuration file. See the iQ-VIEW Administration Guide for 
instructions. 
 

NOTE: 
If a secondary capture image is created out of a MONOCHROME, i.e. gray-scale, image the resulting 

secondary capture image will also be stored as a MONOCHROME image, unless a color remapping was 
applied. In that case, the image will be stored as RGB. If measurements and annotations had been added to 

the original image, they will appear in a gray-scale tone (no longer in yellow). 

 
 
4.2.33 SENDING USER-CREATED DICOM OBJECTS 
 
When new DICOM objects, such as Structured Reports (SR), secondary capture images or Presentation States 
(PR), are created for an existing study and are appended and stored as additional objects to that study, these 
objects should be transferred to the central PACS where all studies are archived and can be accessed again. 
 
Sending structured reports and secondary capture images is available both in iQ-VIEW and iQ-VIEW PRO. 
Transferring presentation states, however, is only possible with iQ-VIEW PRO, due to the fact that storing PRs is 
limited to the PRO version and previous storage is prerequisite for sending them to a remote DICOM station.  
 

NOTE: 
To successfully send PR files to a remote archive, the station must support presentation states SOP classes. 
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There are two ways to send user-created DICOM objects to a remote archive: 
 
 Automatically: If the study was queried and loaded directly from a connected remote archive (“Network” 

table) into the viewer and structured reports or secondary capture sequences were then added and/or 
presentation states were created and stored (only PRO), a pop-up window will ask if the newly created 
and stored DICOM objects should be sent back to the initial remote archive when the viewer is closed or 
another study is accessed. When confirmed, all new files will be sent via DICOM to the remote archive to 
be stored with the original images. 
 

NOTE: 
To choose to never send user-created DICOM objects directly back to the remote archive, it is possible to 

deactivate the pop-up question. For details, please consult the iQ-VIEW Administration Guide. 

 
If Move and Store AE titles are different: 
In the case where the Move AE title is not the same as the Store AE title, i.e. where created objects cannot 
be sent back to the same AE title from where the study was retrieved, a pop-up box will appear where the 
correct DICOM node can be selected. 

 

NOTE: 
Be sure to correctly configure the different AE titles of such PACS systems. It is important to set the Move AE title 

for query/retrieve as “Gateway” and the Store AE title for sending objects as “Workstation.” If an AE is set as 
“Server,” iQ-VIEW will assume that studies can be both retrieved from and sent to the AE title and will try to do 

so. If the AE is unable to support these DICOM actions, an error will occur. 

 
 Manually: When a locally available study (either from “Database” or “Filesystem”) is loaded into the 

viewer, there is no remote archive that iQ-VIEW can send the DICOM objects to automatically. Therefore, it 
must be selected manually where the user-created DICOM objects will be sent. 
 

 

The “Send to destination” button can be added to the bottom toolbar using the method 
described in section 4.2.4.3 Configuration of the bottom toolbar.  

 
To send the stored structured reports, secondary capture images and/or presentation states (only PRO) to 
a remote archive, click the “Send to destination” button and select “Send user-created objects” from the 
sub-menu. A list with all available remote archives pops up. Select the one where the object should be 
sent. The transfer will start immediately. 
 
If no DICOM objects that were added to the original study are to be sent, e.g. to transfer only the 
structured report but not a secondary capture sequence, it is possible to send only a selection of the 
objects. Mark the objects by clicking the small checkbox in the upper right corner of each view. The box 
will turn red when the object is selected. Next, select “Send selected objects” from the “Send to 
destination” sub-menu and choose the DICOM archive where the objects should be sent. The transfer will 
start immediately. 
 

NOTE: 
If there is a question as to whether the original images are already stored on the remote archive or not, it may 

be better to send the complete study, including the new objects, to the remote archive. This is especially true if 
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the images have been opened from the “Filesystem” or have been imported via the “Import” dialog. This can 
be done from the study browser (see section 4.1.10 Transfer). 

 
 
4.2.33.1 SPECIFICS OF SENDING STRUCTURED REPORTS 
 
When structured reports are created, it is possible to set their completion and verification status: 
 
 UNVERIFIED/INCOMPLETE 
 UNVERIFIED/COMPLETE 
 VERIFIED/INCOMPLETE 
 VERIFIED/COMPLETE 
 
A structured report can be saved in different statuses before it is set to “VERIFIED/COMPLETE”. Each time the 
report is saved, it will keep its instance UID and the previous version will be overwritten. 
 
This means that when sending an unverified and/or incomplete structured report to a remote archive, it may 
not be possible to send an updated version later. This is true if the remote archive does not accept objects 
with the same instance UID again. The consequence would be that once the report is finally verified and 
completed, it could not be stored on the archive. 
 
To avoid or rather limit, the issues that may arise from this behavior, iQ-VIEW will do the following: 
 
 Structured reports will only be sent automatically when the status is set to “VERFIED/COMPLETE”. Otherwise, 

they will just be stored locally. 
 If a Structured report is selected in the viewer and the option “Send selected DICOM objects” is activated, 

a warning will appear before sending. The user can choose whether or not to transfer the report. 
 

WARNING: 
If a structured report, or a study with a structured report, is selected to be transferred to a remote archive from 

the study list of the Study Browser, no warning will be displayed if the SR was not yet set to 
“VERIFIED/COMPLETE”. All selected objects will be sent immediately. If the receiving station does not accept a 
DICOM object with the same UID, the verified and complete version of the Structured Report will not be stored 

in place of the incomplete/unverified SR. In that case, it may be necessary to delete the 
incomplete/unverified structured report on the remote archive before the updated report (verified and 

complete) can be sent. 

 
 
4.2.34 CONFIGURATION AND USE OF HANGING PROTOCOLS 
 
The hanging protocols function, including the ability to create hanging protocol sequences, is only available in 
iQ-VIEW PRO. 
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4.2.34.1 WHAT IS A HANGING PROTOCOL? 
 
A hanging protocol (HP) defines how a study is displayed on a workstation. An HP is, therefore, a series of 
actions that is performed to arrange the series and images of a study for optimal viewing. 
 
The term originally referred to the way physical films were arranged on a light box. Nowadays, the term also 
includes the concept of displaying softcopy (digital) images on a PACS workstation. In either case, the goal of 
a hanging protocol is to present specific types of studies in a consistent manner and to reduce the necessity of 
manual image ordering and processing performed by the radiologist. 
 
Hanging protocols may also include the presentation and display of relevant prior studies together with the 
current studies. This feature is currently not implemented in iQ-VIEW PRO. The use of hanging protocols is limited 
to an individual study and does not include priors.  
 
Hanging protocols usually vary a lot, depending not only on study information, such as modality or body part, 
but also on personal preferences or even training. While one radiologist may prefer looking at a chest image 
series with the PA view on the left, another would want the PA view on the right. Therefore, PACS workstations, 
such as iQ-VIEW PRO, allow hanging protocols to be created and customized by the user. 
 
 
4.2.34.2 HOW ARE HANGING PROTOCOLS APPLIED? 
 
Hanging protocols that are created appropriately are automatically applied based on different 
characteristics of the study being loaded into the viewer. Information such as modality, number of series or 
series descriptions must be available, not only for the creation of such HPs but also to ensure the proper 
selection of an HP when a study is loaded. If necessary information is missing, it will become impossible to 
organize the images properly on the screen(s).  
 
 
4.2.34.3 CREATION OF HANGING PROTOCOLS WITH iQ-VIEW PRO 
 
With iQ-VIEW PRO, it is possible to create different kinds of hanging protocols:  
 
 Modality-specific hanging protocols (with defined displays for specific modalities, e.g. MR hanging 

protocol) 
 Specific hanging protocols based on series descriptions (for different display definitions within the same 

modality, e.g. for different kinds of MR studies)  
 
 
1. Modality-specific hanging protocols 
 
In the modality-specific hanging protocol, the sole focus is on the modality information of a particular study, 
such as a specific modality or a combination of modalities. All studies matching this modality information will 
use the modality-specific hanging protocol. Other study information, such as the number of series or the series 
description, is not considered for this type of hanging protocol. 
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NOTE: 
When creating a hanging protocol, the modality information will be shown on top of the HP dialog for easy 

recognition of the included modalities. 

 
A modality-specific hanging protocol can be created for: 
 
 One specific modality, e.g. an MR hanging protocol 
 A combination of modalities, e.g. an MR hanging protocol including a structured report (SR) 
 
A hanging protocol created for an individual modality (e.g. MR) will not be applied if the study that is loaded 
also includes other modalities. The reverse is also true. An HP created for a combination of different modalities 
(e.g. MR and SR) will not be used if the loaded study does not include data from each defined modality. 
 
The only exception to this rule is the existence of presentation state objects (PR). Presentation states are not 
image objects and contain no pixel information. They simply describe the way in which an image should be 
presented on the screen. However, they are listed separately in the modality information. Since both HP and 
PR are means to define the presentation of images on the screen, they need to function at the same time. The 
“PR” modality information is, therefore, ignored when hanging protocols are applied. 
 
General, modality-specific HPs define the general layout of a study and the mode in which it is presented. 
They also allow the definition of default tools, windowing and zoom. In addition, a modality-specific toolbar 
can be created for an HP. For details see section 4.2.4.3 Configuration of the bottom toolbar. 
 
Example:  
 
MR SPINE study with three series, two sagittal section planes and one transversal section plane 
 

Display of MR SPINE study without hanging protocol 
 
A hanging protocol will be created resulting in the following presentation of this type of study: 
 
 Study spread across two displays with a 2x1 tiling on each 
 Orientation lines displayed in the different section planes 
 The distance measurement tool will already be activated on loading (default tool) 
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Example of the creation of an MR modality-specific HP in the “General” section 

 

 
Display of MR modality-specific HP (2x1 tiling on each display, lines mode, distance measurement tool) 

 
 
2. Specific hanging protocols 
 
Specific hanging protocols are more comprehensive and, therefore, consider not only the modality 
information of a study, but also the number of available series and the series descriptions. 
 
Specific hanging protocols combine settings of a general HP (layout, presentation mode, tools) with a 
configuration of position, tiling, windowing, zoom and rotation for each individual series of a study. 
 
In order to create and apply a specific hanging protocol, it is important that the necessary information be 
given in any of the studies. Since the creation of specific HPs in iQ-VIEW PRO is based on the series and their 
series descriptions, the following prerequisites must be met for the appropriate creation and use of these HPs: 
 
 Each series of this type of study must contain a series description. 
 Each series must have a different series description. If the same series description is used for more than one 

series of the study, a specific HP cannot be created and applied properly. 
 Each study for which a specific HP is to be applied must have the same number of series. 
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 The series description must be the same (or at least similar) from one study to the next, as the settings are 
based on the series description and they will not be used for the same type of series when the series 
descriptions do not match. 

 

NOTE: 
If the series descriptions differ just slightly from one study to the next, it is possible to define substrings to be used 

instead of the entire series descriptions. For details see section 4.2.34.7 “Setup”.  

 
Each specific HP also includes a general part. The general layout and tool settings for a specific HP are made 
in the “General” section in the same way a general, modality-specific HP is configured. Therefore, to create a 
specific hanging protocol  the appropriate settings in both the “General” section as well as the “Specific” 
section must be selected. 
 

NOTE: 
Toolbars cannot be set up for specific hanging protocols. The configuration of toolbars for hanging protocols is 

limited to general, modality-specific protocols. They will always be used if a study with the appropriate 
modality information is loaded, regardless of the existence of a specific HP. If a new toolbar is configured in 
the process of creating a specific protocol, this new toolbar will overwrite and replace any already existing 

modality-specific toolbar. 

 
Example:  
 
CR BREAST study with four series (R-CC, L-CC, R-MLO, L-MLO) 
 

 
Display of CR BREAST study without hanging protocol 

 
A hanging protocol will be created resulting in the following presentation of this kind of study: 
 
 Study spread across two displays with a 2x1 tiling on each 
 The CC images will be placed on the right display and will be zoomed a bit 
 The MLO images will be placed on the left display 
 The bitmap overlays will be deactivated for unhindered viewing of the images 
 The magnifier will be the default tool to be used after loading 
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Settings in “General” section of a specific HP (with layout, presentation mode and tool settings) 

 

    
Settings in the “Specific” section of a specific HP (with position indication and zoom settings for CC series) 
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Settings in the “Specific” section of a specific HP (with position indication for MLO series) 

 

 
Display of CR BREAST specific HP (2x1 tiling on each display, individual placement of series across both 

displays, zoomed CC images, active magnifier tool) 
 
 
3. Using hanging protocol sequences 
 
In some cases, it might be necessary to set up more than just one specific hanging protocol for the same type 
of study, either because the radiologists would like to present the entire study in different ways and switch 
between them or because the radiologist would like to view different series of a study one after the other. This 
is possible using iQ-VIEW PRO. 
 
A sequence of hanging protocols for the same study can be set up. If a specific hanging protocol already 
exists for the study, after going back into the HP dialog to create another one, a dialog will ask whether to 
overwrite the existing protocol or to append this as a new HP when trying to save the settings. Select to 
append the newly made configuration as an additional hanging protocol. Continue to create the specific HPs 
until all the necessary protocols have been completed. 
 
Using the navigation options (see section 4.2.12 Navigating between images, series, studies and hanging 
protocols) it is possible to switch between the existing specific HPs when a matching study is loaded into the 
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viewer. It is also possible to add the HP button to the bottom toolbar, to save it and then use it for navigating 
between the different hanging protocols (see section 4.2.4.3 Configuration of the bottom toolbar). 
 
Example:  
 
A doctor regularly views mammography studies that contain six series, the R-CC, L-CC, R-MLO, L-MLO, R-ML 
and L-ML images. He would like to first display the R-CC and L-CC images on the two available displays, then 
switch to the display of the R-MLO and L-MLO images and last to the R-ML and L-ML images. To do this, he will 
use a hanging protocol sequence consisting of three specific HPs: 
 
 First, a mammography study is loaded that contains those six images, each placed in a separate series (R-

CC and L-CC, R-MLO and L-MLO and R-ML and L-ML). 
 For each of the two viewer displays a 1x1 tiling is applied and the R-CC and L-CC images are placed into 

each of them. Afterwards this configuration is stored as a specific HP in the hanging protocol dialog (with 
further adjustments in the presentation, if necessary). 

 Next, the R-MLO and L-MLO images are loaded into the views. The hanging protocol dialog must be 
opened again to save this configuration. A pop-up will appear asking if the new protocol should be 
appended to the existing one or if the existing one should be overwritten. Append the new one to keep 
the first one that was stored. 

 Afterwards, the same must be done for the R-ML and L-ML images. They need to be placed into the 
respective view and then those settings must be stored as a third hanging protocol. 

 Now, when loading this type of study, the doctor will always see the R-CC and L-CC images first. It is then 
easy for him to navigate to the other protocols by selecting “Next hanging protocol” in the “Navigation” 
menu. In addition, a shortcut can be created for the navigation. It is also possible to configure the hanging 
protocol (HP) button for the bottom toolbar (in the form of a general HP, in this case for MG or as default 
toolbar button). 

 
 
4. Hanging protocols including previous studies 
 
This option is currently not available in iQ-VIEW PRO.  
 
All hanging protocols created with and for iQ-VIEW PRO are always based on one individual study. Previous 
studies are not considered. An HP across several studies is not (yet) possible. 
 
 
4.2.34.4 THE HANGING PROTOCOLS DIALOG 
 
The hanging protocols dialog is accessible by: 
 
 Selecting “Hanging protocols” from the “Additional settings” menu  
 Clicking the “Hanging protocols” button in the in the bottom toolbar. See section 4.2.4.3 Configuration of 

the bottom toolbar for more information on how to add this button to the bottom toolbar. 
 Using a shortcut (default = [CTRL] + [H]) 
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NOTE: 
Using the “Hanging protocols” button is recommended especially when using specific protocols and protocol 
sequences since the yellow frame around this button indicates that a specific protocol is loaded. The button 

can also be used to navigate between the different available protocols of a sequence. 

 
For the creation of modality-specific and specific hanging protocols, the hanging protocols dialog is divided 
into three sections: “General”, “Specific” and “Setup.” The modality for which the current hanging protocol is 
defined is always stated on the top (read-only field “Modality”). 
 

NOTE: 
If the study in which the structured report is created contains series from different modalities (e.g. MR, OT, SR), 
the “Modality” field will state all modalities (e.g. “MROTSR”) and the hanging protocol will only be used in this 

combination of modalities. 

 
 
4.2.34.5 “GENERAL” SECTION  
 
The “General” section is used for the configuration of general, modality-specific hanging protocols. All settings 
stored in the general part of each hanging protocol are included in the “General” section – whether they are 
for a general HP only or general layout, presentation mode and default tool information for a specific hanging 
protocol. 
 

NOTE: 
This also includes the configuration of a modality-specific toolbar. A toolbar is always part of a particular 

modality-specific (= general) HP. If a new toolbar is created while setting up a specific HP, it will still be stored 
in the “General” section of the HP configuration file. If a second specific HP is created with a different toolbar, 

this new toolbar configuration will replace the previous toolbar already stored in the HP configuration file. 

 
The “General” section is subdivided into two sections: 
 
 Layout 
 Tools 
 
The “General” section is used to set up not only the layout that will be used when studies from the selected 
modality are loaded into the viewer, but also the presentation mode (i.e. the active tool of the left sidebar), 
the tools that should be activated by default and a specific bottom toolbar, if desired. 
 
The settings made in the “General” section will be stored in the corresponding part of the hanging protocol 
file, when clicking “Save”. Now, if a study is found with the same “Modalities in Study” attribute (e.g. MR or CT 
or something such as MR and SR) and no specific hanging protocol is found, then the settings from the 
“General” section will be loaded and applied. 
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1. Layout 
 

 
Hanging protocols dialog: General section with layout and presentation mode options 

 
In the “Layout” section the following settings can be altered: 
 
 “Auto layout”: iQ-VIEW will use automatic tiling during the loading process of a study matching the 

modality. The application counts the number of available series and automatically divides the image 
processing area into the appropriate tiling. 

 “Fixed layout”: Sets up a fixed screen tiling, either on one monitor or using a dual monitor system. Select 
the number of columns and rows desired for each display. 

 “Presentation mode”: Determines how the study will be displayed in the viewer. It refers to the various 
functions available in the side toolbar: 
- “Synchronize all series” = “Sync”: Scrolling through one series will automatically synchronize all other 

series of that study. 
- “Bind series” = “Bind”: All loaded series of the study will be virtually bound together in one view. 
- “Tile images of series”: Uses tiling on the image level for the study. The first series will be displayed in tiles 

when an appropriate study is loaded into the viewer. 
- “Show orientation lines” = “Lines”: The scoutlines are activated for easier orientation within a study.  
- “Default: Tile series of study”: This is the default setting used. The series in the study are automatically 

placed into the available views. 
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 “Scope” (viewport): Determines whether changes made in the images (windowing, zoom/pan, flip/rotate, 
color schemes and image filters) should be applied only to the current image or the whole series. 

 
 
2. Tools 
 

 
Hanging protocols dialog: General section with tools options 

 
In the “Tools” section the following configurations are possible: 
 
 “Default tool”: Selects the default tool that will automatically be activated when a study matching this 

hanging protocol is loaded. Possible tools are: 
- “Stack through series”: for easy browsing through a series. 
- “Window (brightness/contrast)”: for changes in the window level. 
- “Measure distance”: for making distance measurements. 
- “Measure ratio”: for measuring the ratio of two distances. 
- “Measure perpendicular distance”: for measuring the short and long axis of tumors in 2D. Two distance 

lines are drawn at a right angle towards each other. (iQ-VIEW PRO only) 
- “Measure point-to-line distance”: to measure the shortest distance from a defined point to a drawn 

line. (iQ-VIEW PRO only) 
- “Measure angle”: for making angle measurements. 
- “Measure Cobb’s angle”: for measuring a Cobb’s angle. 
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- “Measure interior angle”: for measuring the interior angle of a right-angled triangle. (iQ-VIEW PRO 
only) 

- “Measure square ROI”: for measuring the density of certain square areas (regions of interest). 
- “Measure circular ROI”: for measuring the density of certain circular areas (regions of interest). 
- “Measure polygonal ROI”: for measuring the density of certain polygonal areas (regions of interest). 

(iQ-VIEW PRO only) 
- “Annotate”: for adding text annotations to images. 
- “Draw shutter”: for drawing shutters and blanking out parts of an image. 
- “Magnifier”: for using the regular magnifier and enlarging regions of interest in images. 
- “Zoom/Pan”: for zooming and panning images. 
- “Scroll zoom”: for using the scroll-wheel of the mouse to dynamically zoom images. 

 “Show text overlay”: Select whether or not to display the text overlays of images.  
 

WARNING: 
If the text overlay is deactivated, information about lossy compressed images will not be shown in the viewer. 

Make sure that the images being evaluated have diagnostic quality. If necessary, turn on the text overlay 
again or check the DICOM header information. 

 
 “Show bitmap overlays”: Select whether or not to display the bitmap overlays that may be included in the 

images. 
 “Delayed interpolation”: Select whether or not to use a delayed interpolation to improve the performance 

of large images (e.g. radiographies, mammographies) on high-resolution monitors, particularly with 
functions like stack mode or synchronized scrolling of several series. If activated, the delayed interpolation 
will be used even if it is not used normally. If delayed interpolation is activated for normal use in the viewer 
but deactivated here, it will not be used when a study matching the hanging protocol is loaded. 

 

NOTE: 
Delayed interpolation means that the images will first be scaled using a lower interpolation, e.g. when scrolling 

through a series, to improve the performance (especially on high-resolution monitors). After only 300 ms the 
images are focused again. 

 
 “Default windowing”: Used for the selecting the standard form of windowing used for the images. 

Available options are:  
- Prefer VOI look-up table if existent  
- Linear (recommended values) 
- Auto contrast 

 “Default zoom”: Used to select the standard zoom used for the images. Possible options are: 
- “Optimal (fit in)”: the images are scaled to fit the size of the view in which they are placed. 
- “Original (1:1)”: the images are displayed in their original size. 
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4.2.34.6 “SPECIFIC” SECTION  
 
Using the “Specific” section it is possible to define hanging protocols for specific kinds of studies based on the 
series descriptions of the series included. This makes it possible to define particular layouts and functions for 
certain kinds of studies, e.g. from different body regions. 
 
A prerequisite for the proper use of specific hanging protocols is that the same kinds of studies must have the 
same number of series and more or less corresponding series descriptions. If, for instance, the series 
descriptions vary, iQ-VIEW will not be able to match a newly loaded study with the stored hanging protocol. 
For the definition of substrings that help match similar, but different, series descriptions, see below 4.2.34.7 
“Setup”. 
 
The proper use of hanging protocols is not possible if series descriptions were not added when the study was 
taken or if the same series description is used for more than one series. 
 

NOTE: 
For specific hanging protocols the layout and active tools will be configured in the “General” section. In other 

words, every specific protocol has its own “General” section. 

 

 
Hanging protocols dialog: Specific section 
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In the “Specific” section the settings for each individual series, such as the position, zooming and windowing 
values, must be set separately to complete the entire specific protocol. 
 
At the top of the “Specific” section, a drop-down menu (“Series descriptions”) lists all available series of the 
study in the order in which they are available (the order of the thumbnails in the viewer). Select the series in 
which the necessary settings should be made.  
 
The “Hanging description” field will usually list the series descriptions of each series one after another, divided 
by a comma. However, if substrings are used to define series, it will only show the defined strings. For more 
information, see below in section 4.2.34.7 “Setup”. 
 
After selecting the first series, define the following settings: 
 
 “Position”: Select the view into which this series is to be placed from the drop-down menu. 
 “Tiling”: Select a specific tiling on the image level from the drop-down menu.  
 “On display number”: Select the display onto which the series is to be placed (the respective view on that 

display will be used). 
 “Rotation”: Specify if a series should be displayed with one of the standard rotation options (0°, 90° 

clockwise, 180° or 90° counter-clockwise). 
 “Zoom”: For setting the zoom, several options are available: 

- “Best fit”: The default, where the image size is adjusted to fit directly into the view. 
- “Original (1:1)”: Displays the images in their original size. 
- “Custom in %”: Enter a user-defined zoom factor in a percentage. Either enter the value manually or 

use the up/down buttons to increase/decrease the percentage. 
 “Window”: Defines the form of window leveling used for the series. Several options are available: 

- “Default”: The center/window values stated in the DICOM header of each image will be used. 
- “Auto”: An auto-contrast will be added to the images by iQ-VIEW. 
- “Custom (W/C)”: Enter fixed center/window values into the respective fields. 

 

NOTE: 
iQ-VIEW will use dynamic windowing when the option “Custom (W/C)” is used in the “Window” section. In 

case of different center/window values throughout the series, the established values will only be applied to the 
first image. The values of all other images are calculated on the basis of their original center/window values. 

For details, see section 4.2.23.2 Dynamic windowing. 

 
At the bottom, the protocol may be given a specific name in the “Protocol name” field for easier recognition. 
By default, a combination of all series descriptions is used as the protocol name, which can lead to rather long 
protocol names. 
 
Proceed with the other series and make sure that for each series a new view is selected. Configuring the same 
positions for more than one series will lead to problems using the hanging protocol correctly. 
 

NOTE:  
Since all the configurable settings in the “Specific” section will automatically populate from the current 

presentation of the series in the viewer, configuration time can be saved by setting up the study in the viewer 
the way that it should always be displayed. Only open the “Hanging protocols” dialog AFTER completing the 
presentation. At that point, the settings only need to be checked and saved. No other configuration will be 

necessary. 
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After finishing the configuration, save the settings by clicking the “Save” button. Click “Cancel” to ignore any 
changes made in the configuration dialog. 
 
If a specific hanging protocol already exists in the currently active study and the hanging protocol dialog is 
opened, the hanging protocol can be deleted by clicking the “Delete” button. Please note that only the 
“specific” part of the HP will be deleted. The general, modality-specific protocol will still exist and will be used. 
 
 
4.2.34.7 “SETUP” SECTION  
 
As stated before, the “Hanging description” field will usually list the series descriptions of each series one after 
another, divided by a comma. However, a “Hanging description” (found in the “Specific” section) may also 
consist only of strings or parts of the original series descriptions. This is the case if substrings that can be found in 
the series descriptions have been defined in the “Setup” section. If, for instance, the substring “t2.tse.tra” was 
defined, this string will be found as a part of the entire series description (e.g. “t2_tse_tra_384_4mm_neu”) and 
the hanging description will be shortened to the substring “t2.tse.tra”. 
 

NOTE:  
The reason for the definition of substrings is that some modalities, such as MRI, append specific parameters to 
the series descriptions. Example “t2_tse_tra_384_4mm_neu”. These may, however, change from study to study. 
If a hanging protocol is needed that finds all transversal T2-TSE sequences without considering other settings, 
the substring “t2.tse.tra” will need to be defined. Otherwise, the hanging protocol will only work with studies 

that match the entire series description. 
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Hanging protocols dialog: Setup section 

 
In the “Setup” section, the following options may be configured: 
 
 “Substrings”: Define substrings to display series with similar, but slightly different, series descriptions in the 

same way. 
 

 
Click the “+” button to add substrings to the list in the drop-down menu. This way an existing 
substring can be selected from the list instead of having to type it manually. 

 

 
Use the “–” button to delete the currently displayed substring from the drop-down list. 

 
 “Available protocols”: Used to delete existing hanging protocols. 
 

 
Click the “–” button to delete the currently displayed hanging protocol from the configuration. It 
can no longer be used. 

 

NOTE:  
Only protocols that are found for the same modality, e.g. MRI specific protocols, will be displayed. 
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After customizing the configuration, click the “Save” button to save any changes to the HP. Click “Cancel” to 
ignore any changes made.  
 
 
4.2.34.8 THE EASIEST WAY TO CREATE A HANGING PROTOCOL 
 
The easiest way to create a hanging protocol is to configure the opened study with the tiling, windowing, 
tools, etc. in the way it and similar studies in the future, should be presented. Next, open the “Hanging 
protocols” dialog and verify that all the settings made in the viewer window are correct. Then click “Save” to 
store one of the following: 
 
 A general protocol for this modality (e.g. a CT in a 2x2 tiling with “Lines” mode and active “Cine mode 

(stack)” tool) in the “General” section 
 A specific protocol for studies with the same series description (and number of series) in the “Specific” 

section (with the automatic saving of settings made in the “General” section for this HP) 
 
To synchronize series descriptions that only differ slightly, use substrings. 
 
 
4.2.35 EXPORTING DICOM IMAGES TO OTHER IMAGE FORMATS 
 
DICOM images loaded into the viewer can be exported to other image formats – JPEG, BMP and TIFF – as well 
to an AVI video format for use in a case presentation. iQ-VIEW will export the images as well as the 
modifications applied to them (measurements and annotations, windowing, zoom/pan, flip/rotate, color 
remap, etc.).  
 

WARNING: 
Please keep in mind that the export of DICOM images to other file formats will result in lossy image quality, 
which means that the images will no longer have diagnostic quality. Therefore, they should not be used for 

diagnostic purposes. 

 
Export options are only available as a menu entry. To export images, click the “File” menu and select “Export 
image(s)”. A sub-menu offers the following possibilities: 
 
 “Current image”: exports only the currently active image (blue frame) 
 “Whole series”: exports the entire series where the current image belongs 
 “Whole study”: exports the complete study currently active in the viewer 
 “All studies loaded”: exports all studies currently available in the viewer 
 “Current selection”: exports a selection of images, series or studies. A selection must be made before using 

this export function. 
 “Export to AVI”: allows the exporting of either the current series or a previously made selection of images 

into an AVI video file 
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Exporting images to an AVI file:  
 
“Export as AVI” can be used to export a sequence of images, e.g. an ultrasound series, as a video file in the 
AVI format. Select “Export as AVI” from the sub-menu and the “Save as video file” dialog will open. 
 

 
 
Adjust any settings as necessary: 
 
 Select between “Current series” or “Current selection” for exporting. Current series is the default selection. 
 

NOTE:  
The images will be converted into AVI in the order in which they were selected in the viewer. 

 
 Set the size of the video frame (X and Y for width and height). When changing one value, the other will 

change accordingly to maintain the proportions of the images.  
 Set the “interframe delay” in milliseconds. The interframe delay defines the time that passes between two 

frames. The lower the value, the faster the individual frames will be shown. 
 Select “Compression” if the video file should be compressed. By choosing a compression setting, the file 

will become smaller and more suitable for inclusion in presentations. 
 

NOTE:  
The available options for compressing AVI files are dependent on the codecs installed on the workstation. As a 

result, the list of compression options may differ from station to station. The manufacturer cannot guarantee 
the correct functioning of the various codecs and, therefore, recommends using the Windows default codec 
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“cvid Cinepak Codec”. The use of a corrupted, incompletely/incorrectly installed or incompatible codec may 
lead to undesired effects in iQ-VIEW. 

 

 

After all options have been set, click the “Save as AVI” button to give the file a name and start 
exporting the selected data as an AVI file. 

 

WARNING: 
The creation of an AVI file can take a while depending on the number of images selected to be converted. A 

progress bar will indicate when the process will be finished. The dialog will close automatically when the AVI 
file is complete. Please do not interact with the program at this time, such as clicking the close button (“x”), as 

this may lead to undesired results. 

 
 
4.2.36 EXPORTING DICOM IMAGES TO PRINTERS 
 
All images that have been loaded into the viewer, including secondary captures and structured reports, can 
be sent to the Print manager where they can be printed on a connected Windows® printer or DICOM imager. 
Images will be printed with all of their changes in presentation states (measurements and annotations, 
windowing, zoom/pan, flip/rotate, color remap, etc.). 
 
For more information about printing DICOM images on printers and film imagers, please read chapter 4.3 
Windows Print and DICOM Print. 
 
The print manager can be accessed in one of the following ways: 
 
 Click the “File” menu and select “Print manager”. The entire study currently active in the viewer is 

transferred. Alternatively, specific images can be selected in the viewer to be transferred. 
 Click the “Print manager” button available in the bottom tool bar (if configured) to transfer the current 

study or a selection to the print manager. 
 Use the default shortcut [P] for accessing the print manager window. 
 

NOTE: 
For instructions on how to select images, series and studies in the viewer, see section 4.2.16 Selection of 

images, series and studies. 

 
 
4.2.37 TRANSFERRING DICOM IMAGES TO POST-PROCESSING TOOLS 
 
Several post-processing modules can be connected to iQ-VIEW. A few of them are installed during the iQ-
VIEW installation (iQ-3D and iQ-STITCH), while others come in separate installation packages (iQ-NUC, 
OrthoView™). 
 

NOTE: 
All details regarding the installation and connection of these post-processing modules to iQ-VIEW are given in 

the iQ-VIEW Administration Guide and in the respective user documentation of the software.  
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The available post-processing modules can be accessed by: 
 
 Using the post-processing button in the bottom toolbar. By default this shows the 3D tool, but will change 

to the icon of the last post-processing module selected.  
 Selecting “Post-processing” from the “File” menu. A sub-menu with all available modules will open. 
 
When using the post-processing button, a left click will access the currently displayed post-processing module, 
while a right-click (or hovering over the little black corner) will open a sub-menu with all available modules for 
image post-processing. 
 
Example: 
 

 
 

 

“iQ-3D (MPR/VRT/MIP/SSD)”: The iQ-3D post-processing module will be recognized automatically 
since it is a part of the iQ-VIEW installation package. Select a multi-slice series for post-processing 
and then select the iQ-3D entry from the sub-menu. The series will be transferred for 3D post-
processing. MPR and 3D volumes created in iQ-3D can also be sent back to the local iQ-VIEW 
imagebox to be stored together with the original study. 

 
To stop an image volume from being loaded into the iQ-3D post-processing module, simply click the “x” 
button in the progress bar pop-up: 
 

 
 

 

“iQ-STITCH”: This tool is used to merge individual CR images into one and is a part of the iQ-VIEW 
installation. It will be recognized by iQ-VIEW and is automatically added to the list of post-
processing modules. To use iQ-STITCH, first select the images to be stitched in the viewer by clicking 
the checkbox in the corner of each image. Then click the “iQ-STITCH” button to transfer the 
images to the stitching module. The stitched results can then be returned to iQ-VIEW and stored in 
the local imagebox with the original study. 

 

 

“iQ-NUC”: When iQ-NUC is installed on the same machine as iQ-VIEW, nuclear medicine studies 
can be handed over to this evaluation software for nuclear image reconstruction. Select the series 
and then click the “iQ-NUC” button. Result screens can be returned to iQ-VIEW and stored with the 
original study. 
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“OrthoView™ (orthopedic planning)”: If iQ-VIEW has been upgraded with the OrthoView™ 
module for orthopedic planning and the necessary files exist on the same PC where iQ-VIEW is 
installed, this button is shown. Clicking the button opens the OrthoView™ module and transfers the 
selected series for post-processing. The templating results and reports can then be sent back to 
the iQ-VIEW imagebox. 

 
“Configure external tools”: This option allows external third-party applications to be set up and connected to 
iQ-VIEW. The interfacing between iQ-VIEW and the external application is done by an interface application 
that is not part of the regular iQ-VIEW setup and needs to be installed separately. Contact your local distributor 
for details on how to obtain the interface application. 
 

NOTE: 
For detailed information on how to use the configuration tool for interfacing with an external application, 

please consult the iQ-VIEW Administration Guide. 

 

 

Connected tools are displayed in the list of available post-processing modules with a respective 
menu entry and this icon. 

 

 
Sample of an external tool configuration 

 
 
4.2.38 DICOM HEADER INFORMATION 
 
The DICOM header of an image shows all DICOM related information about the current image in the image 
processing area (blue frame), such as patient information, study, series and image information. Additional 
information includes meta tags and other values defining the structure and display of the image.  
 
The DICOM header can be accessed by selecting “DICOM header dump” in the “Tools” menu or by using the 
default shortcut [H] in the viewer.  
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Three different tables are available in the “DICOM header viewer”: the “List view”, the “Tree view” and the 
“Summary”. 
 
 
4.2.38.1 “LIST VIEW”  
 
“List view” gives an overview of all available DICOM tags (attributes) and their values.  
 
It is possible to change every single tag in the DICOM header dump of an individual image. A modification 
made in one image does not extend to any other images of the series or study. To make changes, open the 
DICOM header dump (see above) and select the tag to be changed from the list. 
 

 
Editing tags in DICOM header dump 
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After selecting the tag, right-click it. The “Edit value” option will appear. Click the option and the “Change 
DICOM header information” dialog opens where a new value can be entered. Click “OK” to confirm the 
change or “Cancel” to abort it.  
 

 
 

WARNING:  
Changing header information might lead to image corruption! It should only be done if absolutely necessary 

and only by knowledgeable personnel. 

 
 
4.2.38.2 “TREE VIEW”  
 
The tree view table gives a more structured overview of the DICOM tags and values of an image. The tags are 
collected into their respective attribute groups. Groups can then be opened to reveal the individual tags and 
values or closed if not needed. By default, the various levels are closed.  
 

 
Tree view in DICOM header dump 
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In “Tree view” it is not possible to modify individual attribute values. For modifications, please use the “List 
view.”  
 

 
Click the “+” to open a level with its underlying sections and display all corresponding attributes with 
their respective values. 

 

 
Click the “–” to close an open level.  

 
In addition, the DICOM header data, as displayed in the “Tree view”, can be saved as an XML file to a 
directory of your choice (“Save as XML”). This file may then also be printed with the print functions provided by 
Windows printers.  
 
 
4.2.38.3 “SUMMARY”  
 
In the “Summary” table, it is possible to select an assortment of DICOM tags (up to 6) whose values can be 
available at a glance. Do note that since settings cannot be stored permanently on a medium, any settings 
changed from the default will not be remembered for the next start of the application. 
 
As an example, the text fields or text overlay displays for certain tags, like “Study comments”, may not be long 
enough to show all of the information contained in the field. Another use would be to view private tags or 
Worklist procedure tags. In both cases, the “Summary” view offers an easy solution. 
 

 
Example of DICOM tag selection in “Summary” view of DICOM header dump 
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To change the settings, select the desired attributes from the different drop-down boxes. After completing the 
selections, click “Save changes” to store these settings. Note that the window will not close after clicking 
“Save changes”.  
 
The DICOM header dump dialog box will always reopen to the last screen that was active upon closing. For 
example, if it is closed while the summary table is active, it will reopen again on that same view. Using the 
default shortcut [H] to access the DICOM header dump can offer a very quick way of getting to the most 
important information. 
 
 
4.2.39 ACCESSING LOG INFORMATION 
 
Certain actions started from the viewer are logged in the process logs of iQ-VIEW, such as the check for and 
use of hanging protocols, the transfer of DICOM data into post-processing tools, the query for and retrieval of 
previous exams or the sending of user-created DICOM objects directly from the viewer to a remote archive. 
The higher the log level is set, the more detailed the log information is.  
 

 

Particularly in case of failures, it may be helpful to use the “Jobs and logs” button directly from the 
viewer. This way, it is not necessary to close the viewer and return to the study browser to get the 
needed information. 

 
To access the process log from the viewer: 
 
 Open the “Tools selection” dialog. For more information on how to do this, see section 4.2.4.3 

Configuration of the bottom toolbar. 
 Select the button “Jobs and logs” and add it to the toolbar. 
 Click “Save as default” to add the button to the toolbar permanently. If it is not added to the default 

toolbar, the button will only be active temporarily for the current study in the viewer session. 
 Close the “Tools selection” dialog and click the “Jobs and logs” button in the toolbar to open the window. 
 
Alternatively, the default shortcut [CTRL] + [J] can be used to access the log information. 
 

NOTE: 
A complete description of the functions and use of the ”Jobs and logs” dialog can be found in the iQ-VIEW 

Administration Guide. Detailed information is also given on the creation and use of the different log files. These 
functions are primarily meant to help troubleshoot failing actions or other technical issues. 

 
 
4.2.40 HELP OPTIONS 
 
The help options are found under the “Help” menu: 
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 “User manual”: Opens the iQ-VIEW user manual.  
 

NOTE:  
Acrobat Reader or another PDF reader must be installed on the system to open and view the iQ-VIEW user 

manual, which is included as a PDF file directly in the iQ-VIEW installation folder (manual.pdf). 

 
 “About”: Opens a window where version information about the iQ-VIEW software as well as contact 

information for questions or bug reports is displayed. Clicking the window opens a support email form that 
can be used to contact a local reseller for bug reports, technical advice, etc.  

 

NOTE:  
Please note that a standard email client (Outlook, Outlook Express, etc.) must be installed and configured to 

automatically open an email form. 
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4.3 WINDOWS PRINT AND DICOM PRINT 
 
4.3.1 THE PRINT MANAGER  
 
With iQ-VIEW, DICOM image data can be printed on paper or film, using either a Windows® printer or a DICOM 
imager. To output individual images, series or studies, the studies must first be loaded into the viewer.  
 
Once loaded, the Print manager can be accessed by selecting “Print manager” from the “File” menu of the 
viewer. The print manager window can also be accessed using the default shortcut [P] or by using the “Print 
Manager” button on the bottom toolbar. All methods lead to the print manager opening and transferring the 
selected images into the preview: 
 

 
Print manager 

 
Changes made in images during their processing in the viewer are transferred into the print manager as well. 
This allows the images to be printed with their modifications, e.g. added measurements and annotations, 
window level changes, flipping/rotation, zoom/pan. 
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4.3.2 PRINTER, PAPER FORMAT AND ORIENTATION SELECTION  
 
The printer, paper format and orientation must be selected from the drop-down menus in the upper part of 
the print manager screen before printing: 
 
 “Printer”: Select the appropriate printer for printing the images. Any local or networked Windows® printer 

can be chosen.  
 

NOTE:  
Please note that, in general, printouts of DICOM images, particularly paper printouts, may not be of a 

diagnostic quality and should, therefore, not be used to provide diagnostic findings.  
For higher quality printouts, the use of PostScript printers is recommended. 

 

 

Clicking the “Printer settings” button after selecting a specific printer brings up the respective 
printer/imager configuration. When a Windows® printer is selected, the typical Windows® printer 
properties are opened. For DICOM printers the iQ-VIEW “DICOM settings” dialog will open so that 
the DICOM configuration settings can be checked.  

 

NOTE:  
Please refer to the iQ-VIEW Administration Guide on how to correctly configure a DICOM imager. 

 
 “Paper format”: This option is only available for DICOM print. Select the appropriate paper format for 

printing. 
 

NOTE:  
A paper format that is supported by the DICOM print server or film imager must be selected. An improper  
paper format will result in a failed association. If unsure, check the DICOM Conformance Statement of the 

printer / film imager. 

 
 “Orientation”: Choose between portrait or landscape orientation for printing. The print manager preview is 

changed accordingly. 
 
 
4.3.3 IMAGE OUTPUT AND LAYOUT SELECTION  
 
On the right side of the Print manager screen, several options are available regarding the output and layout: 
 
 “Image output”: Select what to print: 

- Current image: the one in the active view of the viewer window (blue frame) 
- Current series: the series in the active view of the viewer window 
- Current study: the active study  
- Selection: a selection made previously in the viewer by marking images. With this option, it is possible 

to print several complete studies or parts of different studies. See section 4.2.16 Selection of images, 
series and studies for more information on how to make selections. 

 
 “Layout”: The layout determines how many images will print on a single page. The desired layout can be 

selected from the drop-down box: 
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iQ-VIEW already provides a number of layouts to choose from. It is also possible to type a new layout into 
the “Layout” field. 
 

 
 
The print preview will be adjusted accordingly. It is also possible to configure the layout options to your 
own liking and store them for later use. Add new layouts or delete layouts you do not wish to use. The rows 
and columns number is limited to “7” (49 images per page maximum).  

 

 
Use the “+” button to add a print layout to the drop-down list.  

 

 
Use the “–” button to delete the currently displayed print layout from the drop-down list.  

 

NOTE: 
When using the DICOM real-size print (1:1 printing), the layout will automatically switch to a 1x1 format, printing 

out only one image per page. The layout options will be disabled in the real-size print mode. 

 
 “Page controller”: The page controller gives information about how many pages will be needed for 

printing the selected images. If more than one page will print, the slider bar can be used to navigate 
between viewing the different pages. Drag the slider to the desired page or click in the page controller 
bar to the left or right of the indicator to move one page at a time in the respective direction.  

 
 “Print text overlay”: The text overlay for the images will be printed if checked. If the text overlay appears 

either too small or too large on the print-outs, the font size can be changed in iQ-VIEW’s main 
configuration file. See the iQ-VIEW Administration Guide for more information.  

 
 “Print page header”: The page headers with the patient information will be printed if checked. On the 

page header it is also possible to include the institution name. This must be specifically configured. See the 
iQ-VIEW Administration Guide for more information. 

 

NOTES:  
1. If the DICOM real-size print option is selected, the page header will automatically be disabled: it will not be 
possible to print the page header. Please use the text overlay to include the patient and study information. 
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2. If images from more than one study/patient are selected for print, the page header will only print the details 
of the first study. To avoid confusion, be sure to keep the “Print text overlay” activated and deactivate the 

“Print page header.” 

 
 “Text background”: Activating the “Text background” option will put a black bar behind all elements of 

the text overlay so that the white text overlay will always be readable, even if the images are very bright. 
 
 “Reduce print job size”: In the standard Windows® print mode, print jobs from iQ-VIEW can sometimes 

become very large (up 100 MB). This may lead to longer transmission times to a Windows® printer or buffer 
overflow errors if the printer does not have enough memory. Checking the “Reduce print job size” may 
prevent these issues by transmitting less data to the printer.  

 

NOTE:  
A reduction of the print job size is achieved by reducing the resolution and may lead to lower quality printouts 

on some printers. 

 
 “Real-size print”: Using this option, it is possible to print images on a DICOM printer in real size (1:1 print). The 

images are scaled automatically to be displayed and printed in actual size. The pan function (see below) 
can be used to move the image within the preview to show the desired region of interest. The layout is 
automatically set to a 1x1 tiling and the tiling options are grayed-out. The page header is automatically 
deactivated. 

  

NOTE:  
For more options on how to improve the quality of printouts, please consult the appropriate sections of the iQ-

VIEW Administration Guide. 

 
 
4.3.4 EDITING IMAGES FOR PRINTING  
 
The editing of images in Print manager can be done on the image or series level (except for drag/drop and 
the deletion of images). The selection is made using the “Scope” buttons at the top of the screen: 
 

 

“Image scope”: Select scope on the image level if modification (window or zoom/pan) should 
only happen to a single image.  

 

 

“Series scope”: Select scope on the series level if the entire series should be modified (window or 
zoom/pan).  

 
Various tools can be used to edit the images shown in the preview windows. The active tool is displayed with a 
yellow frame. 
 

 

“Zoom/Pan”: An image can be moved by pointing to the middle of it (pan zone) and pressing the 
left mouse button while moving the mouse. The mouse pointer turns into a hand when pointing to 
the middle of the image. To enlarge the image, point to the periphery of the image (zoom zone) 
and hold the left mouse button down while moving the mouse up (to enlarge) and down (to 
minimize). The mouse pointer becomes a magnifier symbol when pointing to the edge of the 
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image. The zoom/pan will affect only the selected image or the entire series, depending on the 
scope selected (image or series). 

 

NOTE: 
Please note that due to the presentation states (PR) now used to display and cache changes in DICOM 

images, the handling of zoom/pan has changed to adhere to the specifications laid down in the DICOM 
standard. Therefore, zoom out will only scale down to a "fit-in" size and not smaller since this is not defined in 

the DICOM standard. Panning continues to work even if the images were not zoomed first.   

 
Images can also be printed in their original size, using the “Real-size print” function (see above). This may be 
useful for x-ray or mammography images. This functionality is only available for DICOM print. By activating the 
“Real-size print” function, the images will automatically be scaled, displayed and printed in their original size. 
 

 

“Windowing”: The brightness and contrast of an image can be manually adjusted by pressing the 
left mouse button and moving the mouse up/down or left/right while hovering over the image. The 
mouse pointer turns into a circle with a white and black side when the tool is activated. 
Windowing changes will affect only the selected image or the entire series, depending on the 
scope selected (image or series). 

 

 

“Drag/Drop”: With drag/drop, images can be moved into another position (tile) if a layout is 
chosen that contains more than one image per page. Note, however, that images can only be 
moved within the filled tiles. For example, in a 3x3 tiling with only 6 tiles filled, images can only be 
switched in the first six tiles. The last three tiles cannot be used.   
 
To move an image, point to it and hold the left mouse button down while dragging the image to 
the new tile.  When the mouse button is released, the image will move into the new location and 
the following images will slide to the right/down to make room. 

 

 

“Delete”: The delete function removes either single images or entire series, independently of the 
set scope (image or series). Upon activation, the mouse pointer will change into an eraser symbol 
when hovering over an image. The following options are available: 
 
 No deletion is possible if “Image output” is set to “Current image”. 
 If “Image output” is set to “Current series,” only individual images can be deleted, not the 

whole series. 
 If “Image output” is set to “Current study”, the option to “Remove individual images” or to 

“Remove entire series” appears when the tool is selected. 
 If “Image output” is set to “Selection”, the entire selection of images is treated as if they are 

from one series. The two options, “Remove individual images” and “Remove entire series” will 
appear when the tool is selected.  However, “Remove entire series” will remove all but the first 
image from the preview since at least one image must remain in the Print Manager. 
 

Once the delete tool is activated, click the individual image or one that is part of the series to be 
deleted.  This only removes the image(s) from the Print Manager and does not affect what is 
displayed in the viewer. 

 

NOTE:  
One image must always remain in the preview to avoid blank printed pages. 
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4.3.5 STARTING A PRINT JOB 
 

 

After selecting the various print options discussed above, click the “Print” button to send the print 
job to the selected Windows® printer or DICOM imager. 

 

NOTE:  
The (real) DICOM print image output of iQ-VIEW is always 1x1. If more than one image is to be printed on one 
page, iQ-VIEW will divide the page to fit the selected number of images and prepare it as one single image. 

The image is then sent to the imager. This feature helps avoid compatibility problems with several DICOM 
imagers. 

Please note that iQ-VIEW only supports gray-scale output for DICOM print jobs. For color printing, a color 
Windows printer, preferably with PostScript, must be used. 
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4.4 DICOM MODALITY WORKLIST CLIENT 
 
This feature is only available in the iQ-VIEW PRO version. 
 

NOTE: 
For information on how to configure a DICOM Modality Worklist to be used with iQ-VIEW PRO, please refer to 

the iQ-VIEW Administration Guide.  

 
The iQ-VIEW PRO DICOM Modality Worklist client can be used in two instances: 
 
 To modify the original DICOM tags in patient studies on the study level (4.1.9 Modify)  
 To query for patient data matched with images imported into the “Import” dialog (4.1.12 Import) 
 
For this reason, the DICOM Modality Worklist dialog can be accessed from both the “Modify” and the “Import” 
dialogs. 
 

 
In both dialogs, the DICOM Modality Worklist window can be opened by clicking the “DICOM 
Modality Worklist” button. 

 
Enter the search criteria into the worklist form to narrow down the search. Start the query to the connected 
DICOM Modality Worklist by clicking “Search”:  
 

 
Worklist dialog 

 
The list will return the results of the query. Click the appropriate patient dataset and click “Accept”.  
 
The values that are defined in the DICOM Modality Worklist configuration will then be applied and will be used 
when patient data from a worklist is transferred into the “Modify” or “Import” dialog. Tags that are not 
configured to be used from a worklist query will either remain as in the original study (when modifying studies) 
or must be entered manually (when importing images and applying patient and study information).  
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The next time, the “DICOM Modality Worklist” button is clicked, a query to the connected Worklist will be 
performed automatically. For this search, the previously set search filters are handled as follows: 
 
 a modality filter will be maintained and used for the automatic query 
 a time (period) filter will be maintained and used for the automatic query 
 filters set for patient name, patient ID and accession number will be deleted before the query 
 
This assures that you will always see an updated worklist whenever you access the “DICOM Modality Worklist” 
dialog is accessed. Of course, you can run another query with patient name, patient ID and/or accession 
number to further narrow down the search. 
 
Adapting the modality filters: 
 
The modality filter drop-down box can be adapted to your own needs. iQ-VIEW already provides a number of 
modality filters to choose from. The most common modalities are already covered:  
 

 
 
However, you may also type in a new modality filter into the “Modality” field: 
 

 
 
It is further possible to configure the modality filters to your own liking and store them for later use. Add new 
modalities or delete modalities you do not wish to use.  
 

 
Use the “+” button to add a modality filter to the drop-down list.  

 

 
Use the “–” button to delete the currently displayed modality filter from the drop-down list.  

 

WARNING: 
The list of values that iQ-VIEW provides as “Modality” filters has been compiled according to the DICOM 

Standard. If modifying the modality filter list be sure to only use DICOM compliant modality markers. If 
incompliant modality markers are used your DICOM Modality Worklist queries may not give back the results 

needed. Studies to which a DICOM incompliant modality marker is applied may later not be found in queries 
or be handled correctly in combination with Hanging Protocols. 
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5 LIST OF ABBREVIATIONS  
 
J2k  – JPEG 2000 
AET   – Application Entity Title 
C-ECHO – DICOM command for verifying the DICOM connection to another device  
C-FIND  – DICOM command for searching studies 
C-MOVE – DICOM command for moving studies 
CR   – Computed Radiography 
CT   – Computed Tomography 
DICOM   – Digital Imaging and Communication in Medicine 
DNS   – Domain Name System 
DX   – Direct X-Ray Systems, e.g. Angiography or Fluoroscopy 
GUI   – Graphical User Interface 
HU   – Hounsfield Units  
IP   – Internet Protocol 
LUT   – Look-up Table 
MG  – Mammography  
MOVE SCU  – C-Move as Service Class User 
MR   – Magnetic Resonance Imaging 
NM   – Nuclear Medicine  
OT   – Other Title (other DICOM storage class) 
Q/R SCU  – Query/Retrieve as Service Class User 
RF   – Radiographic Fluoroscopy 
ROI   – Region of Interest  
STORE SCP  – DICOM store as Service Class Provider 
STORE SCU  – DICOM store as Service Class User  
US   – Ultrasound  
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6 LIST OF SHORTCUTS  
 
Many functions in the viewer of iQ-VIEW can be activated by using a keyboard shortcut. For details on how to 
define shortcuts for viewer actions please read section 4.2.7 Creation of shortcuts for viewer actions.  
 
iQ-VIEW already contains a number of default (pre-defined) shortcuts for specific functions. These pre-defined 
shortcuts are stated in the following list. This list can be extended by adding or editing shortcuts. 
 
Default shortcuts of iQ-VIEW include: 
 

ADDITIONAL KEY + KEY FUNCTION 

[ESC] Reset current view 

Arrow key [UP] Previous image 

Arrow key [DOWN] Next image 

[HOME] First image in a series 

[END] Last image in a series 

[INSERT] Select active image 

[DELETE] Clear last measurement 

[S] Shortcuts 

Arrow key [LEFT] Previous series 

Arrow key [RIGHT] Next series 

[P] Print manager 

[CTRL] + [P] Post-processing 

[M] Modify (of measurements) 

[T] Measurement tools 

[H] DICOM header dump 

[L] Lightbox window 

[CTRL] + [H] Hanging protocols 

[CTRL] + [F1] Auto Contrast 

[CTRL] + [F2] Brain – base (window setting) 

[CTRL] + [F3] Brain (window setting) 

[CTRL] + [F4] Lung (window setting) 

[CTRL] + [F5] Abdomen (window setting) 

[CTRL] + [F6] - 

[F1] 1x1 (tiling) 

[F2] 2x1 (tiling) 

[F3] 1x2 (tiling) 

[F4] 2x2 (tiling) 
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[F5] 3x1 (tiling) 

[F6] 1x3 (tiling) 

[F7] 3x2 (tiling) 

[F8] 2x3 (tiling) 

[F9] 3x3 (tiling) 

[F10] 4x1 (tiling) 

[F11] 4x4 (tiling) 

[F12] Series pop-up list 

[ALT] Activation of 3D localizer (3D position display) 

[CTRL] When used in combination with a mouse-click in un-activated viewer 
tile(s) of different series, will mark the tile(s). Can be used to 
synchronize different series. 

[CTRL]+[SPACE] Creates a secondary capture image and appends it to an already 
existing secondary capture sequence 

[SHIFT]+[SPACE] Creates a secondary capture image and stores it in a new secondary 
capture sequence 

[CTRL]+[S] Marking/Unmarking of a whole study 

[CTRL]+[J] Opens the “Jobs” dialog and access the log information 
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DICOM email attachments (import of) ................... 27 
DICOM email decryption........................................... 25 
DICOM email encryption ........................................... 25 
DICOM email mode ................................................... 22 
DICOM email retrieval ................................................ 26 
DICOM email send form ............................................ 35 
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